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Preface

Welcome to the FACTS System software that automates your business operations! The FACTS System is
composed of 22 highly integrated modules. Each module has a manual dedicated its use and functionality.
For ease of use, the manuals are formatted similarly. All of the FACTS manuals contain the following
sections: system overview, program descriptions, references, glossary of terms, and sample reports.

System Overview

This section discusses the function and process flow for each module. Each System Overview section
contains:

e Anoverview of each module and its interaction with other modules

e  Flow charts of the module’s system

e Anoverview of the modules posting to the General Ledger. This section should be reviewed even
if the General Ledger Module is not being used

e  Procedures and close-out checklists for daily, weekly, periodic (monthly) and yearly processing

Program Descriptions

These chapters detail each program in the module. Each program description includes the functions, user
inputs, and a screen print. The programs are listed in the order that they appear on the menu. There is an
overview preceding each menu that explains the interaction of the programs within the menu.

References

Throughout the documentation the phrase (ref. #) is used. This is referring to the appendix called
“References.”

References are used to prevent the same information from being repeated one program to the next. They are
located at inputs where a user might want further information. References are always numbered. For

example, F2 allows a search (ref.5): this indicates that pressing F2 will allow a search on the input, and more
information on searches can be found in the Reference Appendix under reference #5.

Glossary of Terms

The glossary provides a definition of terms used in the manual and related terms from other modules.

Sample Reports

This section provides a sample printout of most of the reports and prints in the module. A directory is
included that lists each report and the page number in the section.

Copyright © 1984-2005 Infor, Inc. v
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DISTRIBUTION SOLUTIONS

CHAPTER 1

System Overview

The FACTS Accounts Payable module is a system that will maintain accurate
file information, provide complete audit trails and will optionally post to
general ledger. Interaction with General Ledger is automatic and great
flexibility is available through the use of the GL posting tables.

The system has been designed so that all transactions will produce a printed
audit trail. This allows users the secure feeling that all information is traceable
throughout the system. Instructional prompts, default values and the
capability to back up to previous inputs promote both operator efficiency and
comfort in using the system.

Accounts Payable is broken down into the following menus:
e Document Entry

e Recurring Documents

e Payment & Hold Selection

e  Checks, Inquiries, Reports & Prints

e End of Period

¢ File Maintenances

¢ Infrequent File Maintenances

File maintenance programs allow the user to enter, change and delete data.
These programs are used to enter the initial data required to set up the system.
The user can add, change and delete the records in a file. Some file
maintenance programs will be used often (example, vendors) where others will
be used infrequently. These infrequent file maintenances (found on the
Infrequent File Maintenances menu) are used mostly during the installation of
the system.

Always check with you Affiliate before you change settings in Infrequent
File Maintenances.

Vendors are entered through the Vendor F/M program setting parameters
which determine how the system is to process transactions for each vendor.

Copyright © 1984-2005 Infor, Inc. 1-1
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Vendor information is stored and is available to be printed on a report or to be
displayed on the screen by an inquiry.

Following are just a few of the flags set for each vendor: active/inactive -
determines whether any transactions may take place for this vendor, i.e.,
documents entered or checks written, on hold - determines whether any
purchase orders may be entered for the vendor and whether any open
documents owed to the vendor may be paid, permanent/temporary -
determines whether the vendor should automatically be removed by the
system at the end of each period if the vendor balance is zero, and ledgercards -
determines whether to store ledgercards (each transaction affecting a vendor's
account). Vendors are also assigned a terms code (determines document due
dates, etc.), GL posting table (for distributing transactions to general ledger)
and vendor class (for reporting purposes).

Vendor information stored is available for display through the Vendor Inquiry
program that displays general information, payment history, ledgercards and
account information. Account information includes open documents, activity,
and paid documents. Vendor notes may also be entered in the inquiry
program. The Vendor Inquiry provides users with all the vendor information
at their fingertips and makes AP management an organized and efficient
process.

Throughout the Accounts Payable system, whenever the vendor's number must
be entered, the user has the ability to search for the customer through an alpha
lookup, a keyword search or a contact name search. The search capability
relieves the user of having to remember vendor numbers.

Documents (invoices) may be entered into the system for payment either
through the AP Document Entry program or through the Purchase Orders
system when a document is tied with a purchase order placed into the system.
When a document is entered it must be assigned to a branch. Most AP reports
may then list documents by profit center (branch). When entering an accounts
payable document, the user must also expense the full amount of the document
to the appropriate GL account numbers. If job cost is used, each document may
be automatically posted to a specific job number in the Job Cost module.

The Recurring Document system is available if the user pays documents that
are repetitive on a regular basis (i.e., rent or loan payments). Users set up a
document in an entry program specifying the amount of the document to post
to the open payables file, the dates to post the invoice, and a predetermined
cutoff. Users then run a posting program which automatically posts the
invoices into the document entry file, ready to post to the open payables file.
The Recurring Documents system relieves the user of entering the same
document information on a regular basis and remembering when to enter the
documents.

At the time when the user is ready to make payments against open documents,
the Payment & Hold Selection menu is used. Making payments is a very
flexible process which can adapt to any office environment. Individual
documents may be placed on hold to indicate they may not be paid.
Documents may be selected for payment manually, allowing the user to enter

Accounts Payable—7.50
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partial payments and to override the discount amounts and dates. Documents
may also be selected for payment automatically by the system, allowing the
user to select the basis on which payments are made, i.e., discount or due date,
check date, etc. Payments selected for payment may be reviewed using the
Payment Selection List program. At any time prior to printing checks,
payments may be corrected or deleted. Payment selection may be made based
on the branch assigned to each document. This allows multiple profit centers
(branches) to make payment selection and pay only the documents expensed to
that profit center.

Once the Payment Selection List is verified, checks may be created and printed
by the system through the Checks menu. There are four types of checks in the
Accounts Payable system. Each type of check must be updated by the Check
Register program. The Check Register provides an audit trail of all checks and
updates all appropriate files. The four types of checks are the following: 1)
Printed checks - the Check Print program is used to print checks which were
generated for the Payment Selection List; 2) Manual checks - the Manual
Check Entry program is used to enter and record manual checks (written
manually by the user) paying invoices in the open payables file; 3) Noninvoice
checks - the Noninvoice Check Entry program is used to pay a document not in
the open payables file, i.e., entering the document(s), expensing the
document(s) and recording payment of the document(s) at the same time
(example, a C.O.D. document); and 4) Void checks - the Void Check Entry
program is used to void out a printed or manual check already updated by the
Check Register and documents are posted back into the open payables file.

All Accounts Payable reports have the option of printing in vendor number,
alpha, or vendor class order. In addition to the order, the user may choose the
range to be printed. For example, the Aged Payables Report may be printed by
vendor class. There is a wide variety of reports which print all available
information stored in the Accounts Payable system. The following are the
Accounts Payable reports:

1. The Cash Requirements Report prints up to six time periods of cash
requirements for invoice payment. The periods of time are
determined by the user as well as whether the documents are to print
based on due date or discount date. The report may be printed in
summary (total amount due to each vendor within the specified time
periods) or detail (information on each document due to each vendor
within the specified time periods).

2. The Open Payables Report prints a list of open payables, zero balance
documents or both. The options are to print in summary (vendors and
their balances), detail (vendors and information on each document
due) or detail with transactions (vendors, and all transactions against
each document).

3. The Aged Payables Report prints a report of open payables in aging
columns as of a specified aging date. The user may also specify how
many days past due an invoice must be before appearing on the report
and whether to include contact information and purchase information.

Copyright © 1984-2005 Infor, Inc. 1-3
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The report may be printed in summary (vendor and balance) or detail
(vendor and information on each invoice due to the vendor).

4. The Inactive Vendor Listing prints a list of all vendors who have been
inactive as of a specified cutoff. Purchase history figures may be
included in the report. This report will not update any files but may
be useful in allowing the user to delete inactive vendors.

5. The Vendor Listing prints a report of either general or historical
information on vendors. The vendor's address, phone number,
and/or contact may print on either report.

6. The Vendor Ledgercards Report prints a list of the transaction types
chosen that have affected the vendor's balance.

7. The Vendor Label Print program prints up to 99 labels per vendor and
may be sorted by zip code.

8. The Rolodex Vendor Card Print program prints up to 99 rolodex cards
per vendor and may be sorted alphabetically.

9. The Purchase History Report prints various purchase history
information from the vendor's history. The user may select month-to-
date, year-to-date or prior year information and determine the
minimum purchases to print. The user has the option to select specific
document groups to print.

10. The Payment History Report prints total payments made to vendors for
up to 6 periods.

11. The 1099 Print prints the nonemployee compensation statements. The
user chooses the beginning and ending vendor and the document
group(s) to print. The forms used are the standard 1099 forms
distributed by the IRS.

12. The Vendor Balancing Register is run only when the vendor's balance
does not agree with the invoices for that vendor (i.e., very unlikely - if
there is a power failure in the middle of an update, etc.). The register
prints all out-of-balance vendors. The optional update will correct
each vendor balance and the total AP balance.

13. The Vendor Notes Print program prints the notes for any vendors in the
vendor file.

14. The AP Code List prints a listing of the various AP codes: vendor
classes, terms codes and GL posting tables.

The Accounts Payable system provides an End-of-Period menu. This menu
contains programs that should be run to close the module correctly at the end
of each period. There is an end-of-period checklist provided later in this section
instructing the user on the procedures used to close the AP module. Some
programs are optional (Period Check Register) where others are required
(Register History Report). The end-of-period menu programs provide the user
with a complete audit trail of the AP balance.
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Accounts Payable Flow Charts

The following pages present flow charts that illustrate the flow of information
from Accounts Payable to the other modules in the FACTS System. They also

illustrate the flow of information within Accounts Payable.

Note that not all files and programs are shown. The flow charts simply present

how information flows through the system.

The following symbols represent the types of information shown on the flow

charts.

Program

Report

FACTS Module

Register or report with

optional update

File
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Accounts Payable Interaction
with Other FACTS Modules

PO
Purchase
Orders

A

AP
Accounts
Payable

/

GL
General Ledger
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Open Payables

Recurring Recurring
Document Document
Entry Review

Recurring
Document
File
(APRECR)

Recurring
Documents
Listing

A

Post Recurring

Documents Document
Entry

A

Document Document
File < Adjustment
(APDOCM) \ Entry

\/\

]

Document PO Invoice
Entry Register
Register M

Vendor
Ledgercard

Open
Payables

Vendor
Master File
(APVEND)

File
(APLEDG)

File
(APOPEN)

Expense Document

Distribution Transaction GL Journal

File
(GLJRNL)

File File
(APDISE) (APTRAN)
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Select Payments

Open
Payables
File
(APOPEN)

Hold
Selection

Payment Individual
Selection by Payment
Selection

Unselect
Payments
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Print Checks
Payment Individual Unselect
Selection by Payment Pavments
Date Selection y
Payment
File
(APPYMT)
Non-Invoice
Manual Check C;r?r?tk
Entry
Manual Check
Entry
Non-Invoice Re Manual &
gular )
chanuel Check File void Check
eck rre APCKRG
(APCKMI) ( ) (APCKMV)
Void Check
Entry
AP Check
Register
Open Doc Period . .
Payables Vendorl Transaction Check Reg. Per.|od D.'Sb/
File Master File File File Dist. File
(APOPEN) (APVEND) (APTRAN) (APCHKP) (APDISD)
Payment Vendor GL Journal Bank Check
History File Ledger File File Ledger File Recon. File
(APHIST) (APLEDG) (GLJRNL) (SMLEDG) (SMCHKR)
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Posting to General Ledger

You can set up the Accounts Payable system to automatically post to General
Ledger. To do this, set the GL distribution flag in the AP Static Control F/M to
one of the following: 0-indicating no GL distribution is printed or posted; 1-
indicating the GL distribution is printed (printing is in detail format) but not
posted to GL; 2-indicating the GL distribution is printed (printing is in detail
format) and posted to GL in summary (posting includes the total amount
posted to each account number); or 3-indicating the GL distribution is printed
(printing is in detail format) and posted to GL in detail (posting includes each
item contributing to the amount for each account number).

Two other flags control automatic posting from AP to GL. The GL expense
journal and GL disbursements journal flags, also located in the AP Static
Control F/M program, allow you to direct transactions posted from the
Document Entry Register and Check Register to specific GL Journals.

The Accounts Payable transactions that may print a GL distribution and post to
GL are the transactions from the Document Entry Register and the Check
Register.

The GL distributions are built and posted through the use of GL posting tables.

Users establish their own set of valid GL posting tables to be assigned to each
vendor. For example, all invoices from freight companies may be expensed to
the same GL account number. The user should assign one GL posting table to
all freight vendors. Posting tables may be alphabetic or numeric and should be
easily recognized. During Document Entry, the user must enter the vendor
number. The GL posting table code assigned to that vendor is displayed and
may be overridden on the invoice. The GL account numbers stored with the
GL posting tables become the default value for the expense account number
entered in Document Entry. Document Entry also allows a search to display all
G/L numbers set up in a posting table.

In Document Entry, the user may expense an invoice to up to 999 expense
accounts. The GL posting table allows the user to set up to five default expense
accounts to make entry of AP documents easier.

The GL posting table also contains the Accounts Payable G/L number to post
and the Discounts G/L number to post when a discount is taken.
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Example: Southern bell is a vendor set up in the vendor file and for GL posting
purposes is considered a telephone vendor. Therefore, the user sets up a GL
posting table TEL-telephone. When posting most phone bills from Southern
Bell, the user normally expenses to the telephone GL expense account.
However, occasionally the user advertises in the yellow pages and when those
bills are entered, they are expensed to the advertising GL expense account. The
user sets up the GL posting table as follows:

GL Table  TEL
Description Telephone

G/L # Description

Expense1 735-00-00 Telephone

2 710-00-00 Advertising

3

4

5
Accounts Payable 310-00-00 Accounts
Payable
Discounts 490-00-00 Discounts Taken

In Document Entry, if the GL posting table is TEL for the invoice being entered,
the system automatically defaults to 735-00-00 for the first GL number to be
expensed. The user also may perform a search to display all of the GL expense
numbers set up in the TEL GL posting table. In the example given, 735-00-00
telephone and 710-00-00 advertising are displayed.

Therefore, when a regular telephone bill is entered, the user may allow the
system to default to 735-00-00 telephone. However, when an occasional
advertising bill is entered, the user may search to see the other possible expense
GL numbers to use.

If the Post by Branch flag is set to Y in the AP static control record, the
Document Entry program automatically inserts the branch in the proper
position in the GL number when displaying the expense numbers of the GL
posting table.

Within each GL posting table there is also an account number for accounts
payable. This number is posted when entering an accounts payable document
or writing a check and paying it off. The discounts number is posted when a
discount is taken, i.e., when the payment is made and the check is written.
Discounts are not posted upon initial entry of the document, but when the
discount is entered when payment is made (i.e., when the discount is taken).
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If the user enters two bills for Southern Bell - a telephone bill for $350 and an
advertising bill for $150, the summary Document Entry Register GL
distribution using the GL posting table listed above would be as follows:

Debit Credit
310-00-00 Accounts payable -500.00
730-00-00 Telephone 350.00
710-00-00 Advertising 150.00

If the user pays the two bills and takes a 2% discount on the advertising bill, the
summary Check Register GL distribution using the GL posting table listed
above would be as follows:

Debit Credit

*100-00-00 Cash in Bank -497.00
310-00-00 Accounts Payable 500.00

490-00-00 Discounts Taken -3.00

* The cash G/L number comes from the Bank G/L number set up in the
Bank F/M in the banking and check system in system management.

If the Post by branch flag is set to Y in the AP static control record, the
Document Entry & Adjustments Register and Check Register automatically
insert the branch (assigned to each document) in the AP and discounts GL
numbers when posting to general ledger.

When setting up the GL Posting Tables, because they are user-defined, there is
no limit to the number set up. Any of the expense numbers may be entered as
defaults in the AP Document Entry. The AP and Discount G/L numbers are
mandatory numbers and may not be overridden during entry of current
payment selection or check writing.

If a loan is to be entered and the balance posts to Notes Payable rather than an
accounts payable account, when setting up GL posting tables, one may be set
up as follows:

GL Table LN

Loans

G/L# Description

* Expense 1
* 2
* 3
* 4
* 5
Accounts Payable 320-00-00 Notes Payable
Discounts 490-00-00 Discounts Taken

* If a GL posting table is set up with no expense accounts, the user has no
default expense numbers in Document Entry.
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The Document Entry program, Document Entry & Adj. Register and Check
Register programs use information stored in these records.
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Posting to Job Cost from Accounts Payable

During the Document Entry program the user may post any part of an invoice
(bill) to a job number, to post to Job Cost. If job cost information is entered the
default GL expense account number is no longer the number as set in the GL
posting table. The default GL expense account number comes from one of two
places. If the Post work-in-process flag is set to Y in the JC to GL Posting F/M
program, the default expense GL number is a work-in-process account number.
Depending on the Basis flag set in this record for work-in-process, the default
number is used or the work-in-process account number is assigned to the cost
type for the GL posting table assigned to the job. If the Post work-in-process
flag is set to N, the default expense GL number is the expense number assigned
to the cost code entered for the job.

The Document Entry & Adj. Register GL distribution posts to GL as follows:

Debit Credit
Work in-Process GL # Accounts Payable
or
Expense GL #

The work-in-process or expense GL number also posts into the JC Job Posting
Entry file. The Job Posting Register is then run which updates the WIP or
expense GL number to the Job Cost transaction file. This transaction file is used
for billing purposes.

Once billing takes place, the JC Invoice Register is printed along with the
Invoice Register GL distribution.

The GL distribution posts as follows:

Debit Credit
Accounts Receivable Sales
Tax
Freight
Cost of Sales Work in Process
or
Expense GL #

The WIP or expense GL number was originally debited in Accounts Payable
and in Job Cost is credited. This means the WIP or Expense number is a wash
account with the amount posting to the Cost of Sales GL account number.
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Standard Procedures

The standard procedures may vary depending on how your company's
business is conducted. The following three sections of standard procedures are
provided as a guideline:

1) Recommended Operating Procedures. An outline is provided of routine
procedures on a daily, weekly, period (month, if 12 periods are used) and
yearly basis.

2) End-of-Period Checklist. The end-of-period procedures are critical to the
proper functioning of the system. Certain programs must be run in a
specific order to close the accounts payable module accurately.

It is suggested that copies of the checklist be made and used for each
period close-out to be filed for future reference.

3) End-of-Period Checklist Explanation. A detailed account of the purpose
of each program on the checklist.
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Recommended Operating Procedures

Daily Procedures (or as needed)

—_

VPN PN

Enter documents

Post Recurring Documents (if applicable)
Print/update Document Entry & Adjustments Register
Make payments

Print Payment Selection List

Print checks

Enter manual, void, non-invoice checks

Print/update Check Register

Print Cash Requirements Report

Period Procedures (or as needed)

*1.
*2.
*3.
4.
5.
6.

7.
*8.
*9.
*10.
*11.
*12.
13.

Post Recurring Documents through last day of period (if applicable)
Print/update last PO Invoice Receipt Register (if used)
Print/update last Document Entry & Adjustments Register
Print/update last Check Register

Print Open Payables Report

Print Aged Payables Report

Run Vendor Ledgercards print

Print/update Period Check Register (if used)

Print/update Period Expense Distribution (if used)
Print/update Disbursement Distribution (if used)
Print/update Register History Report

Print/update Document Removal Register

Run Vendor Ledgercard Removal

*14a. Run 1099 Print after the last check run in December.
*14b. Run End-of-Period Update

Yearly Procedures

1.

Run the End-of-Period Update. (If you did this as part of your
period procedures do NOT run this program.) If your year ends in
December, remember to run the 1099 Print program after the last
check run and before the End-of Period Update. If you fail to run
the 1099 Print before you close out December, you will lose all
payroll information on contractors.

* indicates the procedure is required and must be performed in the time period
designated
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End-of-Period Checklist - Accounts Payable

Period __ Year

User Date Menu Description

Recurring 1. Post Recurring Documents through last day of
period

PO Invoice 2. Print/update last PO Invoice Receipt Register
Receiving

Doc Entry 3. Print/update last Document Entry Register

Checks 4. Print/update last Check Register

Reports 5. Print Open Payables Report (detail with
transactions)

Reports 6. Print Aged Payables Report (detail with
transactions)

Reports 7. Run Vendor Ledgercards print

EOP 8. Print/update Period Check Register

EOP 9. Print/update Period Expense Distribution

EOP 10. Print/update Disbursement Distribution

EOP 11. Print/update Register History Report

EOP 12. Print/update Document Removal Register

EOP 13. Run Vendor Ledgercard Removal

EOP 14a. If December, run 1099 Print program before you
close.

EOP 14b. Run End-of-Period Update
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End-Of-Period Checklist Explanation

1. Post Recurring Documents through last day of period. If Recurring
Documents are used, in order to close the current period, this
procedure must be complete. The End-of-Period Update checks to
make sure that the last day posted is the last day of the month. The
reason for this check is to ensure that the user posts all recurring
documents in the correct period.

2-4. Print/update last PO Invoice Receipt Register, Document Entry &
Adjustments Register and Check Register. The PO Invoice Receipt
Register must be run before the AP End-of-Period Update. Running
this register is necessary to ensure that PO invoice receipts from the
current period are written to the Document Entry and Adjustment
File (APDOCM). The Document Entry & Adjustments Register and
the Check Register must be run to keep the AP balance up to date. If
either of these registers are run after the period is closed, the
documents and/ or checks are posted to the next period.

5-6. Print Open Payables Report and Aged Payables Report (detail
with transactions). These reports provide the user with a report of
all transactions that have taken place against all documents
including zero balance documents (paid down to zero). These
documents and transactions will be removed by the Document
Removal Register (#11). It is recommended that a hard copy of each
report be saved for future reference

7. Run Vendor Ledgercards print. If vendor ledgercards are used, this
program provides the user with a list of all transactions that have
occurred on vendor accounts. These transactions will be removed
by the Vendor Ledgercard Removal (#12). It is recommended that a
hard copy be saved for future reference.

8. Print Period Check Register. This register allows the user to obtain
a listing, grouped by bank, of all regular, manual, noninvoice and
void checks for the period. This register is a summary of the Check
Registers printed for the period. After the report prints, the user
should remove the records just printed to clear the file. If records
are not removed, they will appear on next period's register. All
Period Check Registers should be kept as an audit trail.

9. Print Period Expense Distribution. This report allows the user to
obtain a list of all general ledger expense distributions for the
period. This report is a summary of all general ledger expense
distributions from the Document Entry & Adjustments Registers for
the period. After the report prints, the user should remove the
records just printed to clear the file. If records are not removed, they
will appear on next period's register. All Expense Distribution
Reports should be kept as an audit trail.
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10.

11.

12.

13.

14a.

14b.

Print Period Disbursement Distribution. This report allows the
user to obtain a list of all general ledger disbursements distributions
for the period. This report is a summary of the general ledger
distributions from the Check Registers for the period. After the
report prints, the user should remove the records just printed to
clear the file. If records are not removed, they will appear on next
period's register. All Disbursement Distribution Reports should be
kept as an audit trail.

Print Register History Report. This report allows the user to obtain
a list of all registers (Vendor Balancing, Document Entry &
Adjustments, Check) for the period and update the AP balance. This
report provides a trace of what transactions occurred to obtain the
current AP balance. After the report prints, the user should remove
the records just printed to clear the file. If records are not removed,
they will appear on next period's register. All Register History
Reports should be kept as an audit trail.

Print Document Removal Register. This register allows the user to
obtain a list of all documents that have been paid down to zero in
the current period. After the register prints, the user should remove
the records just printed to clear the file. If records are not removed,
they will appear on next period's register. During the removal of the
records, the program also updates the paid documents file. All
Document Removal Registers should be kept as an audit trail.

Run Vendor Ledgercard Removal. If Vendor Ledgercards are used,
this program is run to remove ledgercard information. The user
determines the cutoff date through which to remove ledgercard
information.

In December, run 1099 Print. Run this before you close December.
Otherwise, payroll information for contractors will be lost.

Run End-of-Period Update. This is the last step to closing the
accounts payable current period and should only be run after all of
the above procedures have been completed. The program removes
all temporary vendors with a zero balance, removes documents from
the paid documents file which are stored longer than the number of
periods specified in the AP company static control record, clears
month-to-date vendor information and closes the current period. If
it is the last period of the year, year-to-date figures are rolled to prior
year. When this program is complete, the user may begin daily
procedures in accounts payable in the new (current) period.

Accounts Payable—7.50
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CHAPTER 2

DISTRIBUTION SOLUTIONS

Document Entry

This menu is used for entering all open payables (invoices) into the Accounts
Payable system. Users enter documents through the Document Entry program
or the system can generate open payables through the Recurring Payables
Submodule.

When documents (payables, invoices) are entered through Document Entry,
each document must be expensed to one or more General Ledger account
number(s) (up to 999). Through the use of the Accounts Payable General
Ledger groups, default General Ledger expense account numbers may be set
up for each vendor (see section on General Ledger groups).

Documents that are entered will not update the open documents file until the
Document Entry & Adjustments Register has been run and updated.

Therefore, if a document has been entered incorrectly and has not been
updated, the user may use Document Entry to correct the invoice. The
Document Adjustment Entry program is used to adjust AP invoice amounts,
which have already been entered, updated, and are in the open documents file.
Adjustment entries are not updated until the Document Entry & Adjustments
Register is run and updated. The Document Change F/M allows the user to
change dates on invoices and will affect documents in the open documents file
without running the register.
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Document Entry (APE110)

Function

This program allows the user to enter vendor documents (invoices and credit
memos) into the Accounts Payable system.

The document entry screen consists of two sections. The upper portion of the
screen is called the header portion where the vendor number, invoice number,
etc. are entered. The lower portion is called the line-item portion where each
GL expense account number is entered.

After documents are entered, they stay in the document entry file until the
Document Entry & Adjustments Register is run and updated. This allows the
user to make changes to the document. The update following the register will
remove the documents from the document entry file and update the open
documents file. Note also that the vendor balance and the current AP balance
are not updated until the register is updated. Corrections to documents still in
the document entry file are entered through the Document Entry program.
Documents that have been updated to the Open Documents File are corrected
through the Document Adjustment Entry program.

Updating past open payables: The Accounts Payable section of the “Operational
Analysis Survey” asked the following question: Maximum # of invoices
entered per period? This number divided by four is the number of payables
that can be entered before you run the Document Entry Register. You may want
to temporarily expand the Document Entry File to avoid running out of file
space.

The Document Entry Screen consists of two sections: the header and line-item
entry. The upper section of the screen is the header. This is where you enter the
vendor number, invoice number, and other document particulars. The lower
portion of the screen is the line-item entry section where you enter each general
ledger expense account number.

Once documents have been entered, they remain in the Document Entry File
until someone runs the Document Entry & Adjustments Register. If you need to
make changes to any of the documents and no one has run the register yet, use
the Document Entry program to edit the documents.

The update that follows the register removes the documents from the
Document Entry File and updates the Open Documents File. Note also that the
vendor balance and the current AP balance do not update until someone runs
and updates the register. Documents that have been updated to the Open
Documents File need to be corrected in the Document Adjustment Entry
Program.

Access this program by choosing Accounts Payable ?Document Entry ?Document Entry.
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User Inputs

The following inputs are involved in entering an accounts payable document:

1. Period

Enter the period (PPYY) the expense account distribution should be posted to in
GL. CR defaults to the current AP period. The period entered may be either
the current or next GL period.

2. Vendor

Enter the vendor number for this document. If the vendor number is not a
valid vendor number, there is an option to add the vendor. If the user chooses
to add the vendor, the program proceeds to the Vendor F/M screen. After the
addition is complete, it will return to the Document Entry screen. Entry of a
valid number displays the name, address, GL posting table, document group,
branch, terms code, and message for this vendor. If the vendor is inactive, the
entry is refused. F3 allows a document search (i.e., documents entered into the
document entry file, but not yet updated to the open documents file).

3. Document Number

Enter the document number (up to 10 characters). This entry is checked against
the past and open document files. If the entered document number is a
duplicate for this vendor, a message is displayed and the entry refused. If the
document has been currently entered and is in the document entry file, the
system will display the document on the screen and the user may make any
changes needed.

4. PO Number (Purchase Order Number)

Enter the purchase order number (up to 6 characters).

5. GL Tbl (General Ledger Table)

Enter the GL posting table. The entry must be a valid posting table. CR
defaults to the value already displayed, initially the posting table assigned to
the vendor. F2 allows a search (ref. 7).

6. Doc Grp (Document Group)

Enter the document group (up to 2 characters). CR defaults to the value
already displayed, initially the document group assigned to the vendor in
Vendor F/M.

7. Branch

Enter the branch number. The entry must be a valid branch. CR defaults to the
branch assigned to the terminal entering the document. F2 allows a search (ref.
7).

8. Terms (Code)

Enter the payment terms code. The entry must be a valid terms code. CR
defaults to the value already displayed, initially the terms code assigned to the
vendor in the vendor file. An M (manual) terms code will force the user to
enter due dates and discount amount. F2 allows a search (ref. 7).

Accounts Payable—7.50
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9. Document Amount

Enter the document amount (+/-9999999.99). Zero amounts are not accepted.
A negative number indicates a credit memo or credit adjustment.

10. Discountable Amount

Enter the amount to compute the discount on (+/- 9999999.99), i.e., freight may
be included in the document amount, however, not eligible for discount. CR
defaults to document amount.

11. Document Date

Enter the date of the document (ref. 2). The entry must be a date prior or equal
to a date in the next GL period. CR defaults to the system date.

12. Due Date

Enter the due date (ref. 2). CR automatically calculates the due date, discount
amount and date based on the Terms Code. If the due date is calculated, skip
to input #15. If the terms code is M (manual), inputs #12-14 must be entered.

13. Discount

This may be entered as an amount or as a percent of the document amount.
Enter the discount as a dollar amount or as a percent. If entering as a
percentage, type the number required and a percent (%) sign.

14. Discount Due Date

Enter the discount due date (ref. 2).
15. Memo

Enter any memo (up to 25 characters). This memo will print on the check stub
in the Comments column. F4 backs up to the discount due date.

This concludes the header portion of the Document Entry program. After the header record is
created, all previous inputs except #1-3 are accessible through the change header routine. Inputs #1-
3 can only be changed by deleting and re-entering the document.

The line-item portion of the program allows entry of up to 999 line-items.

Line numbers are assigned automatically beginning with 001 and incrementing by one for each
additional line-item up to 999. In the rare case where 999 line-items have been entered on a single
document, the program advances to the Prompt-selection input.

16. G/L Number, Job Number

Enter the GL expense account number to which this document will be
distributed. If the entire amount of the document is not to be distributed to this
account, enter other account numbers in subsequent line-items. The number
entered must be a valid GL number. If the GL posting table for this document
has preset expense accounts, CR defaults to the first GL account number in the
GL posting table. Press F2 to view all GL numbers listed for the GL posting
table assigned to this document and their descriptions. This search displays all
GL numbers listed for the GL posting table assigned to this document along
with the GL numbers description. If the Post by branch flag is set to Y in the
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static control record and the account number is selected from the initial search,
the GL account expense numbers assigned to the GL posting table are
displayed with the branch assigned to the document (input #7) inserted in the
branch position. Select the line number of the GL account number to expense
to. F2 allows a GL numbers alpha search. Any account number may be typed
in place of the standard numbers from the GL posting table. If you access the
full GL account search feature or manually enter the account number the
system does not insert the branch. If the entire amount of the document is not
distributed to this account, the next account number will be entered on line 002.
This continues until the document amount is distributed.

If this entry is to post to Job Cost, enter ] to enter the job number and proceed to

the next input. If you are not entering Job Cost information, proceed to input #
25.

17. Job Number

Enter the valid job number to post this entry against. Entering a valid job
number displays the job name, customer number and name, and billing type.
CR defaults to the last job number entered (if any). F2 allows a search (ref. 2).

18. Price Message

If the billing type for the job entered is fixed, contract or time and material, this
input is skipped. If the billing type is cost + (plus) or no charge, the program
displays the price (bill rate) that will be used to calculate the extension. If the
job is no charge, then the markup method can be changed if the Allow billing
override flag for the cost code is set to Y and neither the bill rate nor extension
will be affected. Press CR to continue.

19. Cost Code

Enter a valid cost code (up to 4 characters). Entering a valid cost code displays
the cost code description and the cost type. If the cost code is not set up to use
units (unit of measure field is blank in Cost Code F/M), the program displays a
message displaying this information. The cost code sets the defaults for
markup method (for all jobs that are not billed as cost plus) and the billing rate
for jobs that are billed as a fixed contract or as time and material. If the billing
type is not cost plus, the cost code also determines whether the user is able to
override the markup method and/or bill rate. F2 allows a search (ref. 7).

The item entry determines the units, unit of measure and cost rate/extension.

20. Markup

This input is initially skipped and set to the markup assigned to the cost code.
This may only be entered for jobs which are time and materials or fixed
contracts and the Allow override of billing flag is set to Y in the cost code
record. This may also be changed for no charge jobs but the bill rate is not
affected.

Enter the markup method to use for this posting entry. The user has the
following options:

#-  Enter the markup amount (0-9999999.99%). Entering a number tells the system to mark
up the cost by a dollar amount. The system marks up the cost rate by the dollar amount
and calculates the bill extension.
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#+% - Enter the percentage (0-9999999.99%) to mark up the cost. To enter a percentage, the user
must enter an amount and then the percentage sign. If no percentage sign is present, the
system assumes the entered amount is a dollar amount. The system marks up the cost rate
by the percentage amount and calculates the bill extension.

M-  Enter the bill rate manually. Entering M displays the word MANUAL and the program
proceeds to the bill rate input (#21).

The fixed markup method is unavailable for selection, but can be used. To
utilize the fixed method, select a cost code whose markup method is fixed.

CR initially defaults to the markup method (amount/ percentage) from the cost
code record.

21. Bill Rate

This input is unavailable if the Allow billing override flag is set to N in the
Cost Code F/M. This input is initially skipped unless the markup method of
the cost code is manual. Enter the price per displayed unit of measure. The bill
extension is calculated and displayed. CR initially defaults to 0.

22. Memo

Enter the memo (to print on invoice - see next input) for this posting entry (up
to 30 characters). CR initially defaults to blanks.

23. Print memo on job cost invoice?

This input is initially skipped if the print order for invoice transactions flag in
the jobs file is not set to A. Enter N or Y to indicate whether to print the memo
on the job cost invoice. CR initially defaults to N.

24. General Ledger Number

Enter the GL expense account to which this document will be distributed. The
number entered must be a valid GL number.. If the GL posting table for this
document has preset expense accounts, CR defaults to the first GL account
number in the GL posting table and all of the GL posting table may be
displayed by pressing F2-search. This search displays all GL numbers listed for
the GL posting table assigned to this document along with the GL numbers
description. If the Post by branch flag is set to Y in the static control record, the
GL account expense numbers assigned to the GL posting table are displayed
with the branch assigned to the document (input #7) inserted in the branch
position. Select the line number of the GL account number to expense to. F2
allows a GL numbers alpha search. Any account number may be typed in place
of the standard numbers from the GL posting table. If the entire amount of the
document is not distributed to this account, the next account number will be
entered on line 002. This continues until the document amount is distributed.

25. Amount

Enter the amount to be distributed to this GL number (+/-9999999.99). This
may be entered as an amount or as a percent of the original undistributed
amount (document amount). If entering a percentage, type the number
required and a percent (%) sign. Zero amounts are not accepted. CR defaults
to the document amount not yet distributed (undistributed). The ending
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routine may not be accessed until the entire document amount has been
distributed.

If you entered a job number in the G/L number field to post this entry to a job,
the system supplies the amount from the Cost ext field in the Job Posting Entry
window. In this case, the Amount input is initially skipped. Then, the system
asks for the expense GL account number. CR defaults to the account number
from Job Cost.

This concludes the line-item portion of the Document Entry program. F3 ends
entries of line-items and goes to the Prompt-selection input which allows the
user to perform a number of functions:

Changes a line-item

Lists line-items

Adds a line-item

g » to#*

- Deletes the document
F2 - Changes header

F3 - Ends entry of document

Technical notes

Documents entered are written to the document entry file (APDOCM) and its
sort file (APDOCX) as header records and line-item records. Nothing is
updated to the open documents file (APOPEN) until the Document Entry &
Adjustments Register is run and updated. When a document is deleted, the
header record and all line-item records are removed from the document entry
file. Vendors may be created in the Document Entry (APVEND). All Job Cost
information entered is stored in the document entry file (APDOCM).

FILES USED - SMCNTL, GLMSTR, APOPEN, APPAST, GLALPX, ARCUST,
JCJOBS, JCCODE, JCJOCX

FILES UPDATED - APDOCM, APDOCX, APVEND, APCLSX, APVALX,
APLEDG

Accounts Payable—7.50
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L® 01-Demo Company. Document Entry [APE110] & E
Ele Edit DOptons: GoTo Help
|Perios [i92002 | AP CP=09/2002 SEP
Vendar | vioo | Document | 1221
General Industrial MFG PO | 002321 Doc Amount | 211.00 Due Date |DTI3012002
ESTt”?:;T;i”V-P'- 6LThl [ 005 #4|  DocDiscs 211.00  Discount | 222
A;';Etalegq_ 20338 Dot Grp | 1 Dot Date |05r1nrznnz Disc Date |u?r1nrznnz
Branch I 01 #|
Terms | 02 _#4 | 2% 10th Net 30 Merno |
GL# | oog-ooo [l Amount | B
Ln# | oL | Daseription [ Amount| Job# | j-J
ool ATES-01-0 Inventany 211.00 ,/
o0z 475040 Irentony 22.00 —
add E’
=]
Undistributed: -22.00
Header Cane
MM 10% OFF CATALOG y
Help
@1-Demo Company Document Entry nPE11d
Period 69/2002 AP CP=09/2002 SEP
Uendor U118 Document 12211
Georgia Shipping Equip. Co. PO# A88123 Amount Disc % Date
3376 Washington Ave. S.E. GL Tbl &85 Doc 33.08 33.688 85/11/208082
Doc Grp B1 Due a7 /1172062
Atlanta, GA. 38302 Branch 81 Disc -8 a7 /11 /20082
Memo Terms 38 Het 38
GLi# [pp@aeA Amount

Descripti Amount Job #
175-81-8 Inventor

Undistributed: .88

Enter expense GL account #, F1-Job Entry, F2-3earch, F3-End, F18-Henu
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How to enter an AP Document header

1.

2.

10.

11.

Access this program by choosing Accounts Payable-->Document Entry-->Document Entry.

Enter the Period (PPYY) in which the expense account distribution should be posted in the

General Ledger. Press Enter (CR) or the icon to set the document to the current AP period.
The period entered may be either the current or next general ledger period.

Enter the Vendor Number for this document. If the vendor number is not a valid vendor
number, there is an option to add the vendor. If the user chooses to add the vendor, the program
proceeds to the Vendor F/M screen. After the addition is complete, it will return to the
Document Entry screen. Entry of a valid number displays the name, address, General Ledger
posting table, document group, branch, terms code, and message for this vendor. If the vendor is
inactive, the entry is refused. Press F3 to perform a document search (i.e., documents entered into
the document entry file, but not yet updated to the open documents file).

Enter the Document Number (up to 10 characters). This entry is checked against the past and
open document files. If the entered document number is a duplicate for this vendor, a message is
displayed and the entry refused. If the document has been currently entered and is in the
document entry file, the system will display the document on the screen and the user may make
any changes needed.

Enter the Purchase Order Number (up to 6 characters). The PO number can be alphanumeric.
Press Enter (CR) to default to 000000 for the PO number.

Enter the General Ledger Posting Table. The entry must be a valid AP General Ledger posting
table. Press ENTER (CR) to accept the value already displayed, initially the GL posting table
assigned to the vendor. Press # or F2 to search.

Enter the Document Group (up to 2 characters). Press ENTER (CR) default to the value already
displayed, initially the document group assigned to the vendor in the vendor file.

Enter the Branch Number. The entry must be a valid branch. Press Enter (CR) to default to the
branch assigned to the terminal entering the document. Press # or F2 to search.

Enter the payment Terms code. The entry must be a valid terms code. Press Enter (CR) to
default to the value already displayed. Initially the terms code assigned to the vendor in the
vendor file. An M (manual) terms code forces you to enter due dates and discount amount.
Press # or F2 to search.

Enter the Document Amount (+/-9999999.99). The system does not accept zero amounts. A
negative number indicates a credit memo or credit adjustment.

Enter the Discount Amount, which is the amount to compute the discount on (+/- 9999999.99).
For example, the document amount may include, but freight may not be eligible for discount. So
the document amount minus the freight would be the discount amount. Press Enter (CR) to
default to the document amount.
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12.

13.

14.

15.

16.

Enter the Document Date. The entry must be a date prior or equal to a date in the next GL period.
Press Enter (CR) to default to the system date.

discount amount and discount date based on the Terms Code. If the due date is calculated, skip
to Step 15 and enter the Memo. If the terms code is M (manual), enter the information required
in Steps 12-14.

Enter the Discount. This can be a dollar amount or a percent of the document amount. Press
Enter (CR) if you want to enter the discount in terms of dollars. To enter the discount as a
percentage, type the number followed by the percent (%) sign. The system automatically
calculates the discount in terms of dollars.

If a discount doesn’t apply, press F1 to skip this entry.

Enter the Discount Due Date. This is the date by which the invoice has to be paid in order to
receive the discount. If a discount doesn’t apply to this document, press F1 to skip the entry.

Enter any Memo up to 25 characters. This memo prints on the check stub in the Comments
column. F4 backs up to the discount due date.

To enter line items for AP documents, refer to the Entering AP Document line-items topics.

Copyright © 1984-2005 Infor, Inc 2-11



Document Entry Accounts Payable—7.50

How to enter AP Document line-items

1.

Access this program by choosing Accounts Payable-->Document Entry-->Document Entry. For
existing documents, enter the period, vendor and document number. For new documents,
complete the header information; refer to the How to enter an AP Document header procedure
for details.

The line-item portion of the program enables you to post the document amount to as many as
999 GL numbers.

The system automatically assigns line numbers beginning with 001. After you enter item
number 999, the program advances to the Prompt-selection input.

Enter the GL Expense Account Number (If this entry is to post to Job Cost, press F2 or the @ icon
to display Job Posting Entry screen) to which this document amount will be distributed. If you
want the entire amount of the document is not to be distributed to this account, enter other
account numbers in subsequent line-items. The number entered must be a valid GL number. If
the general ledger posting table for this document has preset expense accounts, the system
displays the first GL account number in the GL posting table as the default. Press F2 or # to
view all GL numbers listed for the GL posting table assigned to this document and their
descriptions.

If this entry needs to post to Job Cost, enter ] to enter the job number and refer to the Job Posting
Entry topic for input descriptions.

Enter the Amount that you want to distribute to this GL number (+/-9999999.99). You can enter
an amount or as a percent of the original undistributed amount (document amount). To enter a
percentage, type the number required and a percent (%) sign. You cannot enter zero as an

amount. Press Enter (CR) or I to default to the document amount not yet distributed
(undistributed). The ending routine may not be accessed until the entire document amount has
been distributed.

If you entered a job number in the G/L number field to post this entry to a job, the system
supplies the amount from the Cost ext field in the Job Posting Entry window. In this case, the
system initially skips the Amount input. Then, the system asks for the expense general ledger

account number; press Enter (CR) to default to the account number from Job Cost.

Press Enter (CR) to accept the line.

Press F3 or the o when you are finished entering line-items. Once you have completed the
header and the line-item entry sections, the following functions are available.

E;

=+ __Adds a line-item

-Changes the highlighted line-item

X-Deletes the document

2-12
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E—Inserts a line item above the highlighted line in the browser.

5. After you complete line item entry processing and select the Q icon, you can press the Header
button to access the Header Detail screen where you can review header details and modify the
document amount or header memo.

Press F3 or the Done button and the system returns you to Vendor input so you can specify a
vendor and enter additional AP documents in the displayed period. You can enter a vendor
code, press F4 to back up to the Period input and modify the period, press F3 or the Done button
to exit the program.
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Document Adjustment Entry (APE120)

Function

This program allows the user to enter adjustments to documents in the open
documents file.

Adjustments made to the current amount may be either positive or negative.
This amount is distributed into General Ledger account(s). The changes are
written to the document entry file and no updates are done at this time in the
open documents file. The vendor’s balance and the open documents are not
updated (along with the General Ledger) until the optional update following
the Document Entry & Adjustments Register. The Document Entry &
Adjustments Register will provide an audit trail of adjustments made in this
program.

Access this program by choosing Accounts Payable 2>Document Entry >Document Adjustment Entry.

User inputs

The following inputs are involved in entering an adjustment.

1. Period

Enter the period (PPYY) to which the GL distribution should be posted. CR
defaults to the current AP period. The period entered may be either the current
or next GL period.

2. Vendor

Enter the vendor number for the requested document. F2 allows a search (ref.
8). F3 allows a document search, (i.e., adjustments entered into the document
entry file, but not yet updated to the open documents file).

3. Document Number

Enter the document number to be adjusted. The number must be on file for this
vendor in the open documents file. If another adjustment was previously
made, and not yet updated, the adjustment is displayed and the program
proceeds to the Prompt-selection input. Entry of a valid document number
displays the PO number, GL posting table, document group, branch, original
amount and current amount. If the document is on hold, a message is
displayed and the user must press CR to return to the input. F2 allows a search
of open documents for the displayed vendor.

4. Adjustment Amount

Enter the amount of the adjustment (+/-9999999.99). The original, current and
adjusted amount of the document is displayed.
5. Memo

Enter the adjustment memo (up to 25 characters). This memo prints on the
Document Entry & Adjustments Register.
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This concludes the header portion of the Adjustment Entry program. After the header record is
created, the adjustment amount and memo are accessible through the change header routine in
the Prompt-selection input. Inputs #1-3 can only be changed by adjusting the document to a
zero balance and re-entering the document through the entry program with a different document
number.

Line numbers are assigned automatically beginning with 001 and incrementing by one for each
additional line-item up to 999. In the rare case that 999 line-items have been entered on a single
document, the program advances to the Prompt-selection input.

6. G/L Number, Job Number

If this entry is to post to JC, enter ] to enter the job number and proceed to the
next input. If not entering JC information, proceed to input# 17.

7. Job Number

Enter the valid job number to post this entry against. Entering a valid job
number displays the job name, customer number and name, and billing type.
CR defaults to the last job number entered (if any). F2 allows a search (ref. 7).

8. Price Message

If the billing type for the job entered is fixed, contract or time and material, this
input is skipped. If the billing type is cost + (plus) or no charge, the program
displays the price (bill rate) that will be used to calculate the extension. If the
job is no charge, then the markup method can be changed if the Allow billing
override flag for the cost code is set to Y and neither the bill rate nor extension
will be affected. Press CR to continue.

9. Cost Code

Enter a valid cost code (up to 4 characters). Entering a valid cost code displays
the cost code description and the cost type. If the cost code is not set up to use
units (unit of measure field is blank in Cost Code F/M), the program displays a
message. The cost code sets the defaults for markup method (for all jobs that
are not billed as cost plus) and the billing rate for jobs that are billed as a fixed
contract or as time and material. If the billing type is not cost plus, the cost
code also determines whether the user is able to override the markup method
and or bill rate. F2 allows a search (ref. 7).

The item entry determines the units, unit of measure and cost rate/extension.

10. Markup

This input is initially skipped and set to the markup assigned to the cost code.
This may only be entered for jobs which are time and materials or fixed
contracts and the Allow override of billing flag is set to Y in the cost code
record. This may also be changed for no charge jobs but the bill rate is not
affected.

Enter the markup method to use for this posting entry. The user has the
following options:
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# - Enter the markup amount (0-9999999.99%). Entering a number tells the system to mark
up the cost by a dollar amount. The system marks up the cost rate by the dollar
amount and calculates the bill extension.

#+% - Enter the percentage (0-9999999.99%) to mark up the cost. To enter a percentage, the
user must enter an amount and then the percentage sign. If no percentage sign is
present, the system assumes the entered amount is a dollar amount. The system marks
up the cost rate by the percentage amount and calculates the bill extension.

M - Enter the bill rate manually. Entering M displays the word MANUAL and the program
proceeds to the bill rate input (#11).

The fixed markup method is unavailable for selection, but can be used. To
utilize the fixed method, select a cost code whose markup method is fixed.

CR initially defaults to the markup method (amount/ percentage) from the cost
code record.

11. Bill Rate

This input is unavailable if the Allow billing override flag is set to N in the
Cost Code F/M. This input is initially skipped unless the markup method of
the cost code is manual. Enter the price per displayed unit of measure. The bill
extension is calculated and displayed. CR initially defaults to 0.

12. Memo

Enter the memo (to print on invoice - see next input) for this posting entry (up
to 30 characters). CR initially defaults to blanks.

13. Print Memo on Job Cost Invoice?

This input is initially skipped if the module using this program is sales orders,
or if the print order for invoice transactions flag is the jobs file is not set to A.
Enter N or Y to indicate whether to print the memo on the job cost invoice. CR
initially defaults to N.

14. General Ledger Number

Enter the GL expense account to which the adjustment will be distributed. The
number entered must be a valid GL number in the GL account file. If the GL
posting table for this adjustment entry has preset expense accounts, CR defaults
to the first GL account number in the GL posting table and all numbers of the
GL posting table may be displayed by pressing F2-search. This search displays
all GL numbers for the GL posting table assigned to this document along with
the GL numbers description. If the Post by branch flag is set to Y in the Static
control record, the GL account expense numbers assigned to the GL posting
table are displayed with the branch assigned to the document (input #7)
inserted in the branch position. Select the line number of the GL account
number to expense to. F2 allows a GL number alpha search (ref. 7). Any
account number may be typed in place of the standard number from the GL
posting table. If the entire amount of the adjustment is not distributed to this
account, the next account number may be entered on line 002. This continues
until the adjustment amount is distributed.
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15. Amount

Enter the amount to be distributed to this general ledger number (+/-
9999999.99). Zero amounts are not accepted. CR defaults to the adjustment
amount not yet distributed. The ending routine may not be accessed until the
entire adjustment amount is distributed.

This concludes the line-item portion of the Document Adjustment Entry
program. F3 ends entries of line-items and the program advances to the
Prompt-selection input which allows the user to perform a number of
functions:

s

L - Lists line-items

- Changes a line-item

A+ Adds a line-item
D - Deletes the adjustment
F2 - Changes header

F3 Q. Ends entry of adjustment

Technical notes

Adjustments entered are written to the document entry file (APDOCM) and its
sort file (APDOCX) as header records and line-item records. Adjustments are
not updated to the open documents file (APOPEN) until the Document Entry &
Adjustments Register is run and updated. When an adjustment is deleted, the
header record and all line-item records are removed from the document entry
file. All job cost information is stored in the document entry file (APDOCM).

FILES USED - APOPEN, APVEND, GLMSTR, APPAST, SMCNTL, APVALX,
APHOLD, GLALPX, JCJOBS, JCCODE, JCJOCX, ARCUST

FILES UPDATED - APDOCM, APDOCX
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L2 01-Demo Company, Document Adjustment Entry (APE120)
File Edit Qphong GoTo Help

Accounts Payable—7.50

Period [omzooz [
Yendor li

First Bank of the South PO#
P.0. Box 4988 LT
Allatna, GA 30301 Doc Grp

Branch

gl [ 000000

Docurment J

435727 QOriginal
006 vehicles Current
02 Adjusted

02  Dallas Branch

Adjust Amount

Mermno

Amount J

AP CP=09:2002 SEP

Balance

163.61
.00

12.00
12.00

LH# | GL# Deazeription Amount Job # +
oo 625011 12.00 o7l
ooz G625-01-1 FAuto & Truck Expense 1.00 =i
Cadd ;

Undistributed: -1.00
Header | Dore |
L Document Adjustment Entry [APE120] =]
Help
81-Demo Company Document Adjustment Entry APE124
Period AP CP=09/2882 SEP
Uendor Document Balance
Georgia Shipping Equip. Co. PO# Original
3376 Washington Ave. S.E. GL Tbl Inventory Current
Doc Grp Adjusted
Atlanta, GA. 368382 Branch Atlanta Br Adjust Amount
Hemo
GL# Amount
Description Amount Job #
#81 175-81-8 Inventory 2112 .88
Undistributed:
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How to enter adjustments to AP documents

1.

Access this program by choosing Accounts Payable-->Document Entry-->Document Adjustment
Entry.

In the Period input, enter the period (PPYY) to which the general ledger distribution should be

posted. Press Enter (CR) or the icon to default to the current accounts payable period.

In the Vendor input, enter the vendor number for the requested document. Press# or F2 to

search. Press the I icon or F3 to perform a document search, (i.e., adjustments entered into the
document entry file, but not yet updated to the open documents file).

In the Document input, enter the document number for the adjustment. The number must be on
file for this vendor in the open documents file.

If another adjustment was previously made, and not yet updated, the adjustment is displayed,
and the program proceeds to the Prompt-selection input.

When you enter a valid document number, the system displays the PO number, general ledger
posting table, document group, branch, original amount and current amount. If the document is
on hold, the system displays a message to this effect and you must press Enter (CR) to return to
the input. Press # or F2 to perform a search of open documents for the displayed vendor.

Enter the amount of the adjustment (+/-9999999.99). The original, current and adjusted amount
of the document is displayed.

Enter the adjustment memo (up to 25 characters). This memo prints on the Document Entry &
Adjustments Register.

This concludes the header portion of the Adjustment Entry program. After the header record is
created, the adjustment amount and memo are accessible through the change header routine in
the Prompt-selection input. Inputs #1-3 can only be changed by adjusting the document to a zero
balance and re-entering the document through the entry program with a different document
number.

In the G/L# input, enter the GL expense account number to which this document will be
distributed. If the entire amount of the document is not to be distributed to this account, enter
other account numbers in subsequent line-items. The number entered must be a valid GL
number. If the GL posting table for this document has preset expense accounts, CR defaults to
the first GL account number in the GL posting table. Press F2 or the # icon to view all GL
numbers listed for the GL posting table assigned to this document and their descriptions.

If this entry needs to post to Job Cost, press @ to enter the job number and refer to the Job Posting

Entry topic for input descriptions.

In the Amount input, enter the amount to be distributed to this general ledger number (+/-

9999999.99). You cannot enter zero amounts. Press Enter (CR) or the I icon to default to the
adjustment amount not yet distributed. You cannot access the ending routine until the entire
adjustment amount is distributed.
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Press Enter (CR) to accept the line.

9.  This concludes the line-item portion of the Document Adjustment Entry program. Press F3 or the

Q icon to end line-item entry, and the program advances to the Prompt-selection input that
allows the user to perform a number of functions:

E;

- Changes the highlighted line-item

*

Adds a line-item

- Deletes the document

g %

Inserts a line item above the highlighted line in the browser.

10. When you have completed your changes to the document, press F3 or the Done button. The
system returns you to Vendor input so you can specify a vendor and enter additional AP
documents in the displayed period. You can enter a vendor code, press F4 to back up to the
Period input and modify the period, or press Done or F3 to exit the program.
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Document Change F/M (APF110)

Function

This program allows the user to change the following information about a
document in the open documents file.

e  Current discount

e Purchase order number
e Entry date

e Due date

e Discount due date

e Entry period

e Memo

e Document group

The fields above may be changed without affecting the amount of the
document or the GL distribution. In order to make amount changes to the
document or GL expense distribution, the user must use the Document
Adjustment Entry program and run the Document Entry & Adjustments
Register.

Access this program by choosing Accounts Payable ?Document Entry Document Change F/M.

User inputs

The following inputs are involved in making a change to a document in the open documents file:
*. Vendor number

Press F3 to open the first record on file. Press CR to scroll through each AP
document, which appear in vendor order.

*. Document number
This field is display only.
*. Document Type

This field is display only.
*. Status

This field is display only.
*. Original Amount

This field is display only.
*. Original Discount
This field is display only.
*. Current Amount

This field is display only.

Copyright © 1984-2005 Infor, Inc 2-21



Document Entry Accounts Payable—7.50

2-22 Copyright © 1984-2005 Infor, Inc.



Accounts Payable—7.50 Document Entry

8. Current Discount

Enter the new current discount associated with this document. (0.00 to invoice
amount).

9. Purchase Order Number

Change the purchase order number associated with this document. You can
enter up to 6 characters.

10. Entry Date

Change the entry date for this document.
11. Due Date

Change the due date associated with this document.

12. Discount Due Date

Enter the new due date for any discounts.

13. Entry Period

Enter the period in which the document was entered (PPYY). The entry period
must coincide with the entry date.

14. Memo

Change the memo that appears in the comments (header) portion on the check.
You can enter up to 25 characters.

*.  Last Sequence Number

This field is display only.

*

Register Number
This field is display only.
*. GL Table

This field is display only.
18. Document Group

Change the document group code (up to 2 characters) for this character.

*. Branch
This field is display only.
Technical notes

When a field is changed, the field is updated immediately in the open
documents file (APOPEN). No registers need to be run.

FILES USED - SMCNTL, APVEND, APVALX
FILES UPDATED - APOPEN
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L2 Document Change F/M [APF110]
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Document Entry & Adjustment Register (APR110)

Function

This program allows the user to list all documents and adjustments in the
current or next period entered since the last Document Entry & Adjustments
Register was run.

The user has the option to:

e Print a listing of all documents entered and adjustments made.

e Build and print a General Ledger distribution, if desired.

e Post to General Ledger, if a General Ledger distribution is built.

e Update the open documents file and the vendor balance.

e Update the monthly expense distribution file.

e Update the company accounts payable balance, clear the document
entry file and update the appropriate control records.

Information on this register includes the following;:

¢ Document Entries: Period, branch(es) selected, vendor number and
name, document number, branch, GL posting table, PO number, entry
date, due date and discount date, gross amount, allowable discount
amount, GL account number and the posting amount.

e Document Adjustments: Vendor number and name, document number,
current amount, adjustment amount, new current amount, memo, GL
account number and the posting amount.

A recap is given of the AP balance including the following: the beginning
balance, entry total, adjustment total, ending balance and total documents listed
on the register. Depending on the flag in the AP static control record, the user
may obtain a general ledger distribution printout.

Access this program by choosing Accounts Payable ?Document Entry >Document Entry and Adjustment
Register.

User Inputs
The following inputs are involved in printing and updating the Document Entry & Adjustments
Register:
1. Period

Enter whether to print Current period or Next period documents. CR defaults
to C.

2. Branch

Enter the branch number. The entry must be a valid branch. F1 defaults to
ALL. F2 allows a search.

The GL distribution is built during the printing of the Document Entry & Adjustments Register
according to the entries made in the Document and Adjustment Entry programs and the information
entered in the general ledger posting tables.
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_For users printing the GL distribution, the following input is displayed:
3a. Check Register. OK to Print GL Distribution?

After printing the Document Entry & Adjustments Register, verify the
printout. If there is a correction to be made, choose CANCEL or enter N to exit
the program. After the correction is made, run the register again. If everything
is correct, select OK or enter to continue. The program then prints the GL
distribution. Once the GL distribution prints, this message appears:

For users not printing the GL distribution, the following input is displayed:
3b. Check Register. OK To Update?

After printing the Document Entry & Adjustments Register, verify the
printout. If there is a correction to be made, select CANCEL or enter N to exit
the program. After the correction is made, the register can be rerun. If
everything is correct, select OK or Enter to continue and no GL distribution will
be printed, the following input (#4) is skipped and the program proceeds with
the update.

4. Check GL Distribution. OK To Update?

After printing the distribution, verify the printout. If everything is correct,
enter to continue. The program proceeds with the update. If there is a
correction to be made, select CANCEL or enter N to exit the program. After
the correction is made, the entire register process begins again.

Technical Notes

Printing of the Document Entry & Adjustments Register proceeds by reading
through the document entry sort file (APDOCX) and the document entry file
(APDOCM) and building the GL distribution file (SMGLD?) with the necessary
information to print and update the GL distribution. The accounts payable
update removes the records from the document entry files, updates the open
documents file (APOPEN), the vendor balance (APVEND), the invoice
transaction file (APTRAN), the vendor ledgercards file (APLEDG), the current
accounts payable balance and all appropriate control records.

The general ledger journal update posts a journal entry automatically to the
journal entry file (GLJRNL) according to the information appearing on the GL
distribution report. The appropriate sort file (GLJRNX) is maintained and
records are also written to the period expense distribution file (APDISE).

FILES USED - GLMSTR, JCCODE

FILES UPDATED - SMCNTL, APDOCM, APDOCX, APDISE, SMGLD?,
APVEND, GLJRNL, GLJRNX, APOPEN, APTRAN, APLEDG, JCJOBS, JCPOST
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;2 Document Entry & Adj Register [APR110)

L® Document Entry & Adj Register [APR110])
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How to run the AP Document Entry & Adjustment
Register

1.

Access this program by choosing Account Payable-->Document Entry--> AP Document Entry &
Adjustment Register.

In the Period field, select C-Current Period Documents to run the register for the current period
or N-Next Period Documents to run the register for next period documents. Press Enter (CR) to
default to C-Current Period Documents.

In the Branch field, enter the branch to use for the Document Entry & Adjustment Register. Press

Enter (CR) to default to ALL. Select the S icon to process all branches for the register. Select
the # to search for branches.

Select the OK button to print the report. The General Ledger distribution is built during the
printing of the Document Entry & Adjustments Register according to the entries made in the
Document and Adjustment Entry programs and the information entered in the general ledger
posting tables.

If you have FACTS set to print GL distribution, the system displays the following message:
Document Entry & Adjustment Register. OK to Print GL Distribution?

After printing the Document Entry & Adjustment Register, verify the printout. If you need to
correct the register data, select Cancel or enter N to exit the program. After you make the
correction, you can rerun the Document Entry & Adjustment Register. If everything is correct,
select OK or enter YES to continue. The program then prints the GL distribution.

Once the GL distribution is printed, the program displays the message: Check GL Distribution.
OK to Update?

After printing the distribution, verify the printout. If everything is correct, select OK or enter
YES to continue. The program proceeds with the update. If you need to make a correction, select
Cancel or enter N to exit the program. After you correct the information the correction is made,
re-run the entire register process — meaning run the register first, then print the GL distribution,
followed by the optional update.

OR

If you are not printing the GL distribution, the program displays the message: Document Entry
& Adjustments Register. OK to Update?

After printing the Document Entry & Adjustments Register, verify the printout. If you need to
make a correction, select Cancel or enter N to exit the program. After you make corrections,
rerun the register. If everything is correct, select OK or enter YES to continue.

2-28
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CHAPTER 3

Recurring Documents

This sub-module is used to process invoices that are recurring (such as rent or
loan payments). It allows you to set up the liability one time and then the
system will automatically post it to the payables system for each month that
you designate. It also allows you to set up a cutoff so the monthly payables
will stop at a predetermined time. As with regular document entry, all
recurring documents must be expensed to the proper GL account number(s).
The Recurring Document Review program provides the user with a way of
changing the amount to post each month without affecting the permanent
recurring payable. The listing will provide you with options to print out the
different types of recurring payables (expired, unexpired, etc.).

The Post Recurring Documents program must be run to update any recurring
payables. However, this program does not post invoices directly into the open
documents file but rather into the Document Entry & Adjustments file which is
used in printing the Document Entry & Adjustments Register. By posting this
way, the user has an audit trail of all documents entered that will update the
open documents file and update the accounts payable balance.
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TS 7.5 Distribution Software - Accounts Payable (APS000)
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Recurring Document Entry (APE130)

Function

This program allows the user to enter and maintain documents (invoices)
which will post to the open documents file on a periodic basis (monthly,
quarterly, yearly, etc.).

The user may set up standard monthly bills such as utilities and rent or
periodic entries such as lease and note payments. This will relieve the burden
of the entry each period. The program may also be used to change header or
line-item information for existing documents.

The recurring payables entry screen consists of two sections. The upper portion
of the screen is called the header portion where the vendor number, document
amount, etc. are entered. The lower portion is called line-item portion where
each GL expense account number is entered.

After documents are entered, the amount may be changed for the current
month without affecting the standard amount through the Recurring Document
Review program. A list may be printed at any time through the Recurring
Document Listing. The document will post to the Document Entry &
Adjustments file when the Post Recurring Documents program is run. It will
then be treated like any other document in the document entry system. The
vendor’s balance and the open documents file are updated along with the GL in
the update following the Document Entry & Adjustments Register print.

Access this program by choosing Accounts Payable >Recurring Documents >Recurring Document Entry.

User Inputs

The following inputs are involved in using the Recurring Document Entry program:
1. Vendor

Enter the vendor number for this document. Entry of a valid vendor number
displays the name, address, general ledger posting table, document group,
terms code and branch for this vendor. F2 allows a search (ref. 7). F3 allows a
search for recurring documents already on file.

2. SEQ # (Sequence Number)

Enter the sequence number (01-99). This is used to allow the user to enter up to
99 different recurring documents per vendor. For example, if there are two
loans to be paid to the same bank, sequence numbers 01 and 02 are used. Each
time the user refers to this document, he must use the sequence number. The
system will default to the sequence number 01 if only one document is entered
per vendor. Entry of an already existing sequence number for this vendor
displays all the information about this recurring document and proceeds to the
Prompt-selection input.

3. PO Number (Purchase Order Number)

Enter the purchase order number (up to 6 characters).
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4. GL Tbl (General Ledger Table)

Enter the GL posting table. The entry must be a valid AP GL posting table. CR
defaults to the value already displayed; initially the GL posting table assigned
to the vendor in the vendor file. F2 allows a search (ref. 7).

5. Doc Grp (Document Group)

Enter the document group (up to 2 characters). CR defaults to the value
already displayed, initially the document group assigned to the vendor in the
Vendor F/M.

6. Terms (Code)

Enter the payment terms code. The entry must be a valid terms code. CR
defaults to the value already displayed, initially the terms code assigned to the
vendor in the vendor file. F2 allows a search (ref. 7).

7. Months

Enter a string of numbers designating the periods of the calendar year to post
this document to. For example, if it is a yearly document and only posts in
December, and December is the company’s 12th period, enter 12. If this
document is to post quarterly, enter 03060912. CR defaults to ALL and will
display every period of the calendar year.

8. Branch
Enter the branch number. The entry must be a valid branch. CR defaults to the

branch assigned to the terminal entering the document. F2 allows a search (ref.
7).

9. Doc Amt (Document Amount)

Enter the document amount to update the open documents file each time the
document is posted (+/-9999999.99). Zero amounts are not accepted.

10. Post Day

Enter the day the document should post to in the document entry &
adjustments file (01-31). This will be used to determine when to post this
document and also to determine which day of the month to use for the
document date. For example, if this were set to 15 and it was being posted for
February, the document date would be posted as February 15. The terms code
automatically determines the due date, discount amount and discount due date
based on the post day (document date).

11. Cutoff (Type)

Enter whether to base the cutoff (time when a document stops being a recurring
payable) on a Date, Number of postings, or Amount. CR defaults to D.

12. Cutoff
This depends on the cutoff type specified. Enter one of the following:

D - Date. Enter the cutoff period (PPYY), i.e., the last period documents are to post.
N - Number of postings. Enter the cutoff number of postings (2-99).
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A - Amount. Enter the cutoff total amount (+/-999999.99). If the next posting of the
document exceeds this amount, the document will not post.

13. Memo

Enter the memo (up to 25 characters). This will print on the check stub in the comments
column.

This concludes the header portion of the Recurring Document Entry program. After this header
record is created, all previous inputs except #1-2 may be changed through the change header routine.
Inputs #1-2 can only be changed by deleting and re-entering the document.

Line numbers are assigned automatically beginning with 001 and incrementing by one for each
additional line-item up to 999. In the rare case where 999 line-items have been entered on a single
document, the program advances to the Prompt-selection input.

14. General Ledger Number

Enter the number of the GL expense account to which the payment will be distributed. The
number entered must be a valid GL number in the GL account file. If the GL posting table for
this vendor has preset expense accounts, CR defaults to the first GL account number in the GL
posting table and all numbers of the GL posting table may be displayed by pressing F2-
search. This search displays all GL numbers listed for the GL posting table assigned to this
document along with the GL number’s description. Select the line number to expense to. F2
allows a GL number alpha search (ref. 7). Any account number may be typed in place of the
standard numbers from the GL group. If the entire amount of the document is not distributed
to this account, the next account number will be entered on line 002. This continues until the
document amount is distributed.

15. Amount
Enter the amount to be distributed to this GL account (+/- 9999999.99). Zero amounts are not

accepted. CR defaults to the document amount not yet distributed. The ending routine may
not be accessed until the entire document amount has been distributed.

F3 ends entries of line-items and goes to the Prompt-selection input which allows the user to
perform a number of functions:

Changes a line-item

Lists line-items

Adds a line-item

g »

- Deletes the document
F2 - Changes header

F3 - Ends entry of document
Technical Notes

Recurring documents entered are written to the recurring entry file (APRECR). Nothing is
updated to the document entry & adjustments file (APDOCM) until the Post Recurring
Payables program is run. When a document is deleted, the header record and all the line-item
records are removed from the recurring entry file.

FILES USED - SMCNTL, GLMSTR, GLALPX, APVEND, APVALX
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FILES UPDATED - APRECR

L2 Recurring Document Entry [(APE130)
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How to enter recurring AP documents

1.

10.

11.

Access this program by choosing Accounts Payable-->Recurring Document-->Recurring
Document Entry.

In the Vendor input, enter the vendor number for this document. Entry of a valid vendor
number displays the name, address, general ledger posting table, document group, terms code
and branch for this vendor. Press F2 to search. Press F3 to search for recurring documents
already on file.

In the Seq # input, enter the sequence number (01-99). The sequence number allows you to enter
up to 99 different recurring documents per vendor. For example, if there are two loans to be paid
to the same bank, sequence numbers 01 and 02 are used. Each time you refer to this document,
you must use the sequence number. The system will default to the sequence number 01 if only
one document is entered per vendor. Entry of an already existing sequence number for this
vendor displays all the information about this recurring document and proceeds to the Prompt-
selection input.

In the PO#, enter the purchase order number (up to 6 characters). Press Enter (CR) to default to
000000 as the PO number.

In the GL Tbl inputs, enter the general ledger posting table. The entry must be a valid AP
general ledger posting table. Press Enter (CR) to default to the value already displayed; initially
the GL posting table assigned to the vendor in the vendor file. Press F2 to search.

In the Doc Grp input enter the document group (up to 2 characters). Press Enter (CR) to default
to the value already displayed, initially the document group assigned to the vendor in the
vendor file.

In the Terms input, enter the payment terms code. The entry must be a valid terms code. Press
Enter (CR) to default to the value already displayed, initially the terms code assigned to the
vendor in the vendor file. Press F2 to search.

In the Months input, enter a string of numbers designating the periods of the calendar year to
post this document to. For example, if it is a yearly document and only posts in December, and
December is the company’s 12th period, enter 12. If this document is to post quarterly, enter
03060912. Press Enter (CR) to default to ALL and will display every period of the calendar year.

In the Branch input, enter the branch number. The entry must be a valid branch. Press Enter
(CR) to default to the branch assigned to the terminal entering the document. Press F2 to search.

In the Doc Amt (document amount) input, enter the document amount to update the open
documents file each time the document is posted (+/-9999999.99). You cannot a zero amount for
the document amount.

In the Post Day input, enter the day the document should post to in the document entry &
adjustments file (01-31). This will be used to determine when to post this document and also to
determine which day of the month to use for the document date. For example, if this were set to
15 and it was being posted for February, the document date would be posted as February 15.
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12.

13.

14.

15.

16.

The terms code automatically determines the due date, discount amount and discount due date
based on the post day (document date).

In the Cutoff input, enter whether to base the cutoff (time when a document stops being a
recurring payable) on a Date, Number of postings, or Amount. Press Enter (CR) to D.

In the second Cutoff input, depending on the cutoff type specified, enter one of the following;:

D -Date. Enter the cutoff period (PPYY), i.e., the last period documents are to post.
N -Number of postings. Enter the cutoff number of postings (2-99).
A -Amount. Enter the cutoff total amount (+/-999999.99). If the next posting of the

document exceeds this amount, the document will not post.

In the Memo input, enter the memo (up to 25 characters). This memo prints on the check stub in
the comments column.

This concludes the header portion of the Recurring Document Entry program. After you create
this header record, you can change all previous inputs except the vendor number and the
sequence number (inputs#1-2) through the change header routine. The only way you can change
the vendor number and the sequence number by deleting and re-entering the document. To
enter line items in recurring documents, complete steps 14-16.

Line numbers are assigned automatically beginning with 001 and incrementing by one for each
additional line-item up to 999. In the rare case where 999 line-items have been entered on a
single document, the program advances to the Prompt-selection input.

In the G/L# input, enter the number of the general ledger expense account to which the payment
will be distributed. The number entered must be a valid GL number in the general ledger
account file. If the general ledger posting table for this vendor has preset expense accounts, press
Enter (CR) to default to the first GL account number in the GL posting table. Press F2 (search) to
display all G/L numbers listed for the GL posting table assigned to this document along with the
G/L number’s description. Select the line number to expense to. You can enter any account
number in place of the standard numbers from the general ledger group. If the entire amount of
the document is not distributed to this account, enter the next account number on line 002. This
process continues until the document amount is distributed.

In the Amount input, enter the amount to be distributed to this general ledger account (+/-
9999999.99). You cannot enter zero for this amount. Press Enter (CR) to default to the document
amount not yet distributed. The ending routine may not be accessed until the entire document
amount has been distributed.

Press Enter (CR) to accept the line.

Press F3 to the line item entry process and return to the Prompt-selection input, which allows
you to perform a number of functions:

# - Changes a line-item

L - Lists line-items

3-8
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A - Adds a line-item

D - Deletes the document
F2 - Changes header

F3 - Ends entry of document

nts

17. When you have completed the document, press F3. The system returns you to Vendor input so

you can specify a vendor and enter additional AP documents in the displayed period. You can
enter a vendor code or press F4 to exit the program.

Copyright © 1984-2005 Infor, Inc.
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Recurring Document Review (APE140)

Function

This program allows the user to change the amounts to post for specific recurring documents.
This change will be reflected in the posting for the current period. However, the document
amount will return to its original value after the posting.

Each document in the recurring entry file has a standard amount and a current period
amount. The current period amount is initially set to the standard amount. The standard is
changed in the Recurring Document Entry program. The Recurring Document Review
program will allow the change of the current amount (the amount to post in the current
period) and allows the user to change the total document amount and the distributed
amounts to each general ledger account. New GL expense accounts may not be added; only
the original expense account amounts are changed.

Recurring documents are initially entered in the Recurring Document Entry program. They
may be listed in the Recurring Document Listing and they are posted to the document entry &
adjustments file by the Post Recurring Documents program.

Access this program by choosing Accounts Payable >Recurring Documents >Recurring Document
Review.

User Inputs

The following inputs are involved in entering the amounts for the current period:
1. Vendor

Enter the vendor number for this document. Entry of a valid vendor number displays the
vendor name, address, general ledger posting table, document group, terms code and branch
for this vendor. F2 allows a search (ref. 7). F3 allows a search for recurring documents.

2. Sequence Number

Enter the sequence number of the document (01-99). The sequence number must be on file for
this vendor in the recurring payables file. Input of a valid sequence number for this vendor
will display all screen information about this document. CR defaults to 01.

3. Prompt-selection input allows the user to perform a number of functions:

# - Changes a line-item

L - Lists line-items

F2 - Changes header

F3 - Clears the screen and returns to the vendor input for further entries

To change the amount for this period, change the document amount in the header, enter a memo (if
needed), and expense the same amount to the appropriate general ledger number(s).
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Technical Notes

When this program is used, only the amount for the current period is affected in the recurring
entry file (APRECR). The standard value will not be updated.

FILES USED - SMCNTL, APVEND, GLMSTR, APVALX
FILES UPDATED - APRECR

L Recurring Document Review [APE140)
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How to change posting amounts for recurring
documents for the current period

1.  Access this program by choosing Accounts Payable-->Recurring
Document-->Recurring Document Review.

2. Inthe Vendor input, enter the vendor number for this document. When
you enter a valid vendor number, the system displays the vendor name,
address, general ledger posting table, document group, terms code and
branch for this vendor. Press F2 to search. Press F3 to search for recurring
documents.

3. Inthe Seq# input, enter the sequence number of the document (01-99).
The sequence number must be on file for this vendor in the Recurring
Payables file. Input of a valid sequence number for this vendor will
display all screen information about this document. Press Enter (CR) to
default to 01.

4.  The system goes to the prompt-selection input where you can select from a
number of functions:

# -Changes a line-item

L -Lists line-items

F2 -Changes header

F3 -Clears the screen and returns to the vendor input for further
entries

5. To change the amount for this period, change the document amount in the
header, enter a memo (if needed), and the line-item section, change the
lines necessary to expense the same amount to the appropriate general
ledger number(s).

6. Press F3 to end the change process, enter the line number to change, press
F2 to change the header information or L to list additional line items.
When you are done press F3 to end the change process.

7. The system returns you to the Vendor input where you can enter another
vendor or press F4 to exit the program.
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Recurring Document Listing (APR120)

Function

This program allows the user to print a list of recurring payables to verify proper entry, to
project future expiration, postings for a specific period and to verify proper amounts for the
current period.

The user has the option to:
e Select a beginning and ending vendor.
e Select ending post date.

e Select documents to print.
e Select branch to print.

Report information includes the following: vendor number, name, sequence number,
document group, GL posting table, terms code, branch number, purchase order number,
posting day, months to post, standard posting amount, this period amount, cutoff, number of
postings to date, amount posted to date, memo and status. The number of documents printed
is included along with an index of the captions of the report.

Access this program by choosing Accounts Payable >Recurring Documents >Recurring Document
Listing.

User Inputs

The following inputs are involved in printing the Recurring Document Listing:
1. Beginning Vendor

Enter the beginning vendor number to print. CR defaults to FIRST.
2. Ending Vendor

Enter the ending vendor number to print. CR defaults to LAST.
3. Ending Post Date
Enter the ending post date of the month to print. It must be within the current or next GL

period and after the last date recurring documents were posted (ref. 2). CR defaults to the
system date.

4. Status

Enter whether you wish to print All documents, documents to be posted this Period,
documents Completed this period, Expired documents, or Unexpired documents. CR
defaults to ALL.

5. Branch

Enter the branch. Documents assigned to this branch will be printed. The entry must be a
valid branch. CR defaults to ALL.
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6. Check listing. OK to remove these records?

If only expired documents are printed, the user has the option to remove the printed records
from the file. Select CANCEL or N to skip the update. Select OK or Y to remove expired
records from the system.

Technical Notes

Printing proceeds by reading through the recurring entry file (APRECR) and printing
documents that meet the criteria entered.

The update portion removes header and line-item records from the recurring entry file.
FILES USED - SMCNTL, APVEND
FILES UPDATED - APRECR

;¥ Becurring Document Listing [APR120)

Template  Print Options

Recurring Documents Have Been Fosted Through 10001011957 CP=09/1947 SEP

Beginning Vendor | 14] # | First
Ending Vendar M| | Last
Ending Post Date  [04r27/19949 M

Status |A-AII j

Branch m Mﬂd Atlanta Branch

Ok

Template Printer
Mane Genicom Line Printer Cancel

Enter Beginning Wendor, F1-First, F2-Search

L¥ Recurring Document Listing [APR120)

Help

81-Demo Company Recurring Document Listing aPR124
CP=82/2802 SEP

Recurring Documents Have Been Posted Through 89/28/2082.

Beginning VUendor First

Ending Vendor Last

Ending Post Date

Status All

Branch Atlanta Branch

— Template — Printer
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Post Recurring Documents (APU110)

Function

This program allows the user to post recurring documents to the document entry &
adjustments file.

This program will post recurring documents to the document entry & adjustments file.
Documents then print on the next Document Entry & Adjustments Register. When the
Document Entry & Adjustments Register is updated, the recurring payables will post to the
open documents file. This program does not post recurring payables into the open
documents file, but rather into the document entry & adjustments file where an audit trail
will be traced.

Posting through day 31 will close out the current month for recurring payables.

Access this program by choosing Accounts Payable >Recurring Documents >Post Recurring Documents.

User Inputs

The following inputs are involved in posting recurring documents:
1. Post Through

Enter the date through which to post recurring documents. It must be within the current or
next GL period within 30 days and after the last date posted. CR defaults to the system date.

2. Listing Run

Enter N or Y to indicate whether a Recurring Document Listing has been run. CR defaults to
N and notifies the user that the listing needs to be printed and verified before documents are
posted.

Technical Notes

Updating proceeds by reading through the recurring entry file (APRECR), updating
documents which meet the criteria entered, and posts recurring documents to the document
entry & adjustments file (APDOCM).

FILES UPDATED - SMCNTL, APRECR, APDOCM, APDOCX
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#1-FACTS 7.5 Development

POST THROUGH

LISTIHE RUH

POST RECURRING DOCUMENTS [TIIRET: |
CP=89/084 SEP

N e | _Backue | oK
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How to post recurring documents

1. Access this program by choosing Accounts Payable-->Recurring
Document-->Post Recurring Documents.

2. In the Post Through input, enter the date through which to post recurring
documents. It must be within the current or next GL period within 30
days and after the last date posted. Press Enter (CR) to default to the
system date.

3. Inthe Listing Run input, enter N or YES to indicate whether a Recurring
Document Listing has been run. Press Enter (CR) to default to N; the
system notifies you that the listing needs to be printed and verified before
documents are posted.

Recurring Documents
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CHAPTER 4

Payment & Hold Selection

The Payment & Hold Subsystem is used to select invoices for payment. It is a very flexible
system that can adapt to any office environment. All payables must be selected and the
Payment Selection List must be printed before the user can print checks.

There are two programs used to make payment selection. If an office always pays accounts
payable invoices on time or always pays invoices in time to take the discount, then the
Payment Selection by Date program should be used. This program will select the invoices to
be paid based on the parameters the user has chosen (i.e., are payments based on due date or
discount date — what is the check date?, etc.). By using this program, a user does not need to
worry about missing or overlooking an invoice. The other program used to make payment
selection is Individual Payment Selection. This is used by an office which selectively picks
which invoices it wants to pay. This program can also be used in addition to the Payment
Selection by Date program. For example, if the system does not pick an invoice the user
wishes to pay, the user can selectively choose any additional invoice to pay.

When invoices have been selected for payment, the Payment Selection List should be run to
provide a list of all payments. Payments may then be deleted or corrected through Individual
Payment Selection or unselected by vendor through Unselect Payments. Payments may be
selected or deselected up until the time checks are printed. (See next section.)

Specific documents may be placed on hold and released from hold in the Hold Selection.
Documents on hold may be viewed by printing the Hold List.

Once checks have been printed but not updated by the Check Register, the payment selection
process may begin again. The system keeps track of invoices paid by the previous (not yet
updated) batch of checks.
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Payment Selection by Date (APU210)

Function

This program allows the user to determine which documents shall be selected for payment.
The program runs through the open documents file and selects the invoice to pay based on
the parameters set by the user.

The user has the option to:
o Select the order to pay - vendor, alpha or vendor class.
e Select the beginning and ending order choice.
e Select the document group(s) to select.
e Select by due or discount date.
o  Select the date to pay through.
o Select the lead time.

e Select a minimum invoice balance to pay.
e Select the branch.

This program only determines which documents will be paid the next time checks are
printed. No documents are updated in the open documents file until the checks are printed
and the check register is printed and updated. Documents on hold will not be chosen for
payment.

The Payment Selection List program prints a report of all documents chosen for payment and
the Unselect Payments program may be used to unselect any documents chosen by the
Payment Selection programs for payment. Individual payments may be changed or selected
through the Individual Payment Selection program.

Access this program by choosing Accounts Payable >Payment & Hold Selection >Payment Selection by
Date.

User Inputs

The following inputs are involved in Payment Selection by Date:
1. Order

Select the order in which payment selection is to be made (ref. 4).

2. Beginning Order Choice

Select the beginning order choice to pay (ref. 5).
3. Ending Order Choice

Select the ending order choice to pay (ref. 6).

4. Document Group

Enter up to ten 2-character document groups side by side to select. CR defaults to ALL.
5. Due/Discount

Enter whether selection should be based on DU-due date or DI-discount date. CR defaults to
DUE DATE.
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6. Check Date

Enter the date on which checks will print (ref. 2). CR defaults to the system date. This date is
used to compare to the due/discount date in determining payment selection. This will not
determine the actual date to print on checks. This date is for payment selection only.

7. Lead Time

Enter the number of days lead time (0-99). This may be the number of days until the next
check print. This lead time is added to the check date and used to determine payment
selection. CR defaults to the automatic increment set in the AP static control record. For
example, if checks will not be printed again for seven days, all documents due within the next
seven days will be selected for payment.

8. Minimum

Enter the minimum invoice balance to be selected; i.e., the user may not want to pay an
invoice for $.02 (+/-9999999.99). CR defaults to no minimum.

9. Branch

Enter the branch to select payments for. The entry must be a valid branch. Only documents
assigned to the branch entered will be selected for payment. CR defaults to ALL.

Technical Notes

Payment selection proceeds by reading through the chosen file - vendor (APVEND), alpha
sort (APVALX) or vendor class (APCLSX). The open documents file (APOPEN) is then
checked for documents which meet all the criteria entered by the user. Each selected
document number is printed to the screen as the payment selection file (APPYMT) is built.
Documents in the open documents file are not updated until checks are printed and the Check
Register is printed and updated.

FILES USED - SMCNTL, APVEND, APVALX, APCLSX, APOPEN, APHOLD, APCKRG
FILES UPDATED - APPYMT
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L Payment Selection By Date [APU210]

Copyright © 1984-2005 Infor, Inc 4-5



Payment & Hold Selection Accounts Payable—7.50

How to select AP documents for payment

1.  Access this program by choosing Accounts Payable-->Payment & Hold
Selection-->Payment Selection by Date.

2. Inthe Order input, select the order in which payment selection is to be
made. Payment selection can be done in vendor, alpha or vendor class order.

3. Inthe Beginning order choice input, select the beginning order choice to
pay. For instance, if you choose to select payments according to vendor class,
enter the vendor class that you want the system to start with. The default is
FIRST.

4.  In the Ending order choice input, select the ending order choice to pay. For
instance, if you choose to select payments according to vendor class, enter the
vendor class that you want the system to end with. The default is LAST.

5. Inthe Document group input, enter up to ten 2-character document
groups side by side. Press Enter (CR) to default to ALL.

6. Inthe Due/Discount input, enter whether selection should be based on
DU-due date or DI-discount date. Press Enter (CR) to default to DUE DATE.

7. Inthe Check date input, enter the date on which checks will print. Press
Enter (CR) to default to the system date. The program compares this date to the
due/discount date so it can prioritize invoice selection. This date does not
determine the actual date that will appear on checks.

8. Inthe Lead time input, enter the number of days lead time (0-99). This
may be the number of days until the next check print. The program adds the
lead-time value to the check date to prioritize invoice selection.

Press Enter (CR) to default to the Automatic Increment setting in the AP Static
Control F/M. For example, if checks will not be printed again for seven days,
all documents due within the next seven days will be selected for payment. The
Auto Increment setting defaults to 7.

9. Inthe Minimum input, enter the minimum invoice balance to be selected
(+/-9999999.99). For instance, you may not want to pay an invoice for $.02, so
you might enter a minimum balance of $10. Press Enter (CR) to default to no
minimum.

10. In the Branch input, enter the branch to select payments for. The entry
must be a valid branch. Only documents assigned to the branch entered will be
selected for payment. Press Enter (CR) to default to ALL.

11. Press Enter (CR) to start the payment processing.

12. The system displays the processing criteria in the upper portion of the
screen and processing information in the lower portion of the screen.

13. When the processing is complete message displays, press OK to exit the
program.
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Individual Payment Selection (APE220)

Function

This program allows FACTS users to select documents for payment by vendor.

This program only determines which documents will be paid the next time checks are printed. No
documents are updated in the open documents file until the checks are printed and the Check
Register is printed and updated. Documents on hold may not be selected for payment.

This program is useful when the user wishes to select for payment only certain documents and not
include all those the automatic selection (Payment Selection by Date program) would select. It can
also be used when the entire document amount will not be paid, when the user wants to override
the discount amount, or to unselect a payment of a document that the automatic selection program
has chosen. The total discount taken and payment amount are displayed for each vendor.

Payment Selection may be made after a batch of checks have been printed but the Check Register
has not been updated. Invoices paid by the previous listed batch of checks are listed with the check
number which paid them displayed.

The Payment Selection List program prints a report of all documents chosen for payment through
this program and the Payment Selection by Date program.

Access this program by choosing Accounts Payable >Payment & Hold Selection 2Individual Payment
Selection.

User Inputs

The following inputs are involved in Individual Payment Selection:
1. Discount Cutoff Date

Enter the date on or before discounts will automatically be taken (ref. 2). CR defaults to the system
date. The user may always override the discount. F3 allows the user to change the branch for
which documents will be displayed. F2 allows a search (ref. 7).

2. Vendor Number

Enter the vendor number for selection. CR defaults to the first vendor on file (ref. 8).

3. Beginning Document

Enter the beginning document number to display for this vendor (up to 10 characters). CR defaults
to the first document on file for this vendor.

If there are open documents on file for this vendor, the documents are displayed.
4. Prompt-Selection Input

This input allows the user to pay all documents, delete payment for all documents, individually
select or unselect documents to pay, continue listing documents, bring up the next vendor or
backup.

P - Pays all - All documents for this vendor that have not been previously placed on hold
or paid will be selected for payment. The discounts (where applicable) will be taken
if the discount due date is after the discount cutoff date entered. Each payment
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amount and discount amount is displayed. The totals are displayed in the header
portion of the screen.

D - Deletes all - All documents for this vendor previously selected for payment will be
unselected.

S - Steps (through) - The user may step through each document and selectively determine
payment amounts and discounts. The user may choose to manually type in the
payment and discount amount. The branch assigned to each document is displayed
during the step through. Various function keys aid the user in this process:

D- Deletes the payment
F1 - Skips the document and moves to the next document
F2 - Pays the document in full and takes the discount if appropriate
F3 - Ends payment selection
F4 - Backs up to the previous document
CR -Continues - If the screen becomes filled with documents, CR clears the screen and
displays the next page of documents.

F2 - Next vendor - This automatically enters the next vendor who has open documents and
proceeds to the beginning document input #3.

F3 - Backup - This backs up to the beginning document input (#3).
Technical Notes

When a document is selected for payment, a record is written to the payment selection file
(APPYMT). Documents in the open documents file (APOPEN) are not updated until checks are
printed and the Check Register is printed and updated.

FILES USED - APVEND, APOPEN, APHOLD, SMCNTL, APVALX
FILES UPDATED - APPYMT
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L Individual Payment Selection [APE220]
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How to select individual documents for
payment by vendor

1.  Access this program by choosing Accounts Payable -->Payment & Hold Selection -->Individual
Payment Selection.

2. Inthe Discount Cutoff Date input, enter the date on or before discounts will automatically be
taken. CR defaults to the system date. The user may always override the discount. F3 allows
the user to change the branch for which documents will be displayed. F2 allows a search.

3. Inthe Vendor Number input, enter the vendor number for selection. Press Enter (CR) defaults to
the first vendor on file.

4. In the Beginning Document input, enter the beginning document number to display for this
vendor (up to 10 characters). CR defaults to the first document on file for this vendor.

5.  If there are open documents on file for this vendor the documents are displayed, and the system
does to the Prompt-Selection Input. Use this input to pay all documents, delete payment for all
documents, individually select or unselect documents to pay, continue listing documents, bring
up the next vendor or backup.

6. You can select from the following;:

P -Pays all - All documents for this vendor that have not been previously placed on hold or
paid will be selected for payment. The discounts (where applicable) will be taken if the discount
due date is after the discount cutoff date entered. Each payment amount and discount amount is
displayed. The totals are displayed in the header portion of the screen.

D -Deletes all - All documents for this vendor previously selected for payment will be
unselected.

S -Steps (through) - You can step through each document and selectively determine
payment amounts and discounts.

F2 - Next vendor - This automatically enters the next vendor who has open
documents and proceeds to the beginning document input #3.

F3 - Backup - This backs up to the beginning document input (#3).

7. (Optional) If you select S, you can choose to manually type in the payment and discount amount.
The branch assigned to each document is displayed during the step through. You can select from
the following functions:

D -Deletes the payment
F1 -Skips the document and moves to the next document
F2 -Pays the document in full and takes the discount if appropriate
F3 -Ends payment selection
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F4 -Backs up to the previous document

CR -Continues - If the screen becomes filled with documents, CR clears the screen and
displays the next page of documents.

F2 - Next vendor - This automatically enters the next vendor who has open
documents and proceeds to the beginning document input #3.

F3 - Backup - This backs up to the beginning document input (#3).
8.  (Optional) When you have stepped through the lines, press F3 to end the payment selection.
9.  The system returns to the prompt selection input. You can select from the following:

F2 - Next vendor - This automatically enters the next vendor who has open
documents and proceeds to the beginning document input #3.

F4 - Backup - This backs up to the beginning document input (#3).

10. Press F4 twice to exit the program.

Copyright © 1984-2005 Infor, Inc 4-11



Payment & Hold Selection Accounts Payable—7.50

Payment Selection List (APR210)

Function

This program allows users to obtain a list of documents selected for payment.

This program may be used as an edit list prior to the check print. It is useful to determine the
total amount of the checks to be printed and to determine if additional documents should be
released for payment or unselected. Documents appear on this report only after being
selected for payment in the Payment Selection by Date or Individual Payment Selection
programs. This selection list should be printed prior to printing checks. The user may
include invoices paid by a previous batch of checks not yet updated by the Check Register.

Report information includes the following: vendor number and name, document number,
document group, entry date, due date, discount date, current amount and discount, and
payment amount and discount. If vendor totals are to be included, the total payment amount
and discount amount for each vendor is printed. Report totals are included along with total
documents listed. An asterisk indicates the invoice was paid in the previous batch of checks,
not yet updated by the Check Register.

Access this program by choosing Accounts Payable 2>Payment & Hold Selection Payment Selection List.

User Inputs

The following inputs are involved in printing the Payment Selection List:
1. Order

Select the order the report is to print (ref. 4).
2. Beginning Order Choice

Select the beginning order choice to print (ref. 5).
3. Ending Order Choice

Select the ending order choice to print (ref. 6).

4. Document Group

If you set up document group codes in Vendor F/M, enter up to 10 two-character document
groups side by side to print. CR defaults to ALL.

5. Vendor Totals

Enter N or Y to indicate whether totals by vendor will print. CR defaults to N.
6. Branch

Enter the branch number to print. The entry must be a valid branch. Only documents
assigned to the branch entered will print. CR defaults to ALL.

7. Include

Enter N or Y to indicate whether to include payments that have already been printed on a
previous batch of checks, not yet updated by the Check Register. CR defaults to N.
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Technical Notes

Printing proceeds by reading through the chosen file - vendor (APVEND),
alpha sort (APVALX), or vendor class (APCLSX). The payment selection file is
then checked for any documents selected for payment that meet the criteria
entered.

FILES USED - APPYMT, APVEND, APOPEN, APVALX, APCLSX, SMCNTL
FILES UPDATED - NONE
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Unselect Payments (APU220)

Function

This program allows the user to unselect payments established in the Payment Selection by
Date program or the Individual Payment Selection program.

The user may choose a beginning and ending vendor to be processed and the branch number.
All documents selected for payment for the chosen vendors will be unselected. Invoices
already paid by checks not yet updated by the Check Register may not be unselected.

Access this program by choosing Accounts Payable 2Payment & Hold Selection >Unselect Payments.

User Inputs

The following inputs are involved in unselecting documents for payment:
1. Beginning Vendor
Enter the beginning vendor for de-selection. CR defaults to FIRST.
2. Ending Vendor
Enter the ending vendor for de-selection. CR defaults to LAST.

3. Branch

Enter the branch to unselect payments for. The entry must be a valid branch.
Only documents assigned to the branch entered will be unselected. CR defaults
to All

Technical Notes

The unselect process proceeds by reading through the payment selection file (APPYMT) and
removing all records meeting criteria entered.

FILES USED - SMCNTL, APVEND, APCKRG, APOPEN
FILES UPDATED - APPYMT
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¥ Unselect Payments (APU220]
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How to deselect documents tagged for
payment

1.  Access this program by choosing Accounts Payable-->Payment & Hold
Selection-->Unselect Payments.

2. Inthe Beginning vendor input, enter the beginning vendor. Press Enter
(CR) to default to FIRST.

3. Inthe Ending vendor input, enter the ending vendor. Press Enter (CR) to
default to LAST.

4.  In the Branch vendor input, enter the branch in which you want to deselect
payments. The entry must be a valid branch. Only documents assigned to
the branch entered will be unselected. Press Enter (CR) to default to ALL.

5. Press Enter (CR) to continue with processing.

6. The system displays the processing criteria in the upper portion of the
screen and processing information in the lower portion of the screen.

7. When the processing is complete message displays, press OK to exit the
program.
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Hold Selection (APE240)

Function

This program allows the user to place documents not currently in the payment selection file
on hold.

Documents on hold may not be selected for payment by any of the payment selection
programs. Documents with payments assigned may not be placed on hold. The user may
enter any memo to appear on the Hold List and may remove holds at any time. Documents
on hold will remain on hold until the user removes the hold through this program.

Access this program by choosing Accounts Payable >Payment & Hold Selection Hold Selection.

User Inputs

The following inputs are involved in running the Hold Selection program:
1. Vendor

Enter the vendor number for hold selection. CR defaults to the first vendor on. F2 allows a
search (ref. 8). F3 allows the hold document search. This allows the user to search and
display all vendors with documents on hold. Select the line number of the vendor to display
documents.

2. Beginning Document

Enter the beginning document number to be displayed (up to 10 characters). CR defaults to
the first document in the open documents file for this vendor.

If there are open documents on file for the vendor, the documents are displayed.

3. Prompt-Selection Input

This input allows the user to selectively choose the documents to be placed on hold and
released from hold, to continue listing documents, bring up the next vendor or back up.

S - Steps through - The user may step through each document and selectively hold open
documents. The branch assigned to each document is displayed during the step
through. Various function keys aid in this process:

D- Deletes the hold

F1 -Skips the document and moves to the next document
F2 -Places the document on hold. Enter hold memo.

F3 -Ends

CR -Continues - If the screen becomes filled with documents, press CR to clear the screen
and display the next page of documents.

F2 - Next vendor - This automatically enters the next vendor who has open documents and
proceeds to the beginning document input #2.

F4 - Backup - This ends the prompt-selection input and backs up to the beginning
document input (#2).

Copyright © 1984-2005 Infor, Inc 4-17



Payment & Hold Selection Accounts Payable—7.50

Technical Notes

When a hold is placed on a document, a record is written to the invoices on hold file
(APHOLD). This file is checked by all payment selection programs before payment is made
to make sure the document is not on hold.

FILES USED - APVEND, APOPEN, APCKRG, APPYMT, APVALX, SMCNTL
FILES UPDATED - APHOLD

L2 Hold Selection [(APE240])
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Hold List (APR220)

Function

This program allows the user to obtain a printout of all documents on hold.

Documents appear on this report after being placed on hold by the Hold Selection program.
The Hold Selection program is also used to remove documents from hold status. Vendors
may be placed on hold through the Vendor F/M. If a vendor is on hold, all documents for
that vendor will print on the Hold List. The hold memo prints * vendor on hold *.

The user has the option to:

Select the order to print.

Select the document group(s) to print.
Print vendor totals.

Select the branch to print.

Report information includes the following: vendor number and name, document number,
document group, entry date, due date, discount date, amount, discount amount and the hold
memo. If vendor totals are included, the total amount and discount on hold for each vendor
are printed. Report totals are included along with total document(s) listed.

Access this program by choosing Accounts Payable >Payment & Hold Selection Hold List.

User Inputs

The following inputs are involved in printing the Hold List:
1. Order

Select the order the report is to print (ref. 4).
2. Beginning Order Choice

Enter the beginning order choice to print (ref. 5).

3. Ending Order Choice

Enter the ending order choice to print (ref. 6).

4. Document Groups

Enter up to ten 2-character document groups side by side to print. CR defaults to ALL.
5. Vendor Totals

Enter N or Y to print totals by vendor. CR defaults to N.
6. Branch

Enter branch number to print. The entry must be a valid branch. Only documents assigned
to the branch entered will print. CR defaults to ALL.
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Technical Notes

Printing of this report proceeds by reading through the selected file - vendor (APVEND),
alpha sort (APVALX) or vendor class (APCLSX). The invoices in the hold file (APHOLD) and
vendors on hold in the vendor file are then checked for records which meet the criteria
entered.

FILES USED - SMCNTL, APVEND, APVALX, APCLSX, APHOLD, APOPEN
FILES UPDATED - NONE
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How to place documents on hold

Note: Documents currently in the payment selection file or with payments
already assigned cannot be placed on hold. Documents on hold cannot be
selected for payment by any of the payment selection programs.

1.

Access this program by choosing Accounts Payable-->Payment & Hold
Selection-->Hold Selection.

In the Vendor input, enter the vendor number for hold selection. Press
Enter (CR) to default to the first vendor on file. Press F2 to search. Press
F3 to access the hold document search, which allows you to search and
display all vendors with documents on hold. Select the line number of the
vendor to display documents.

In the Beginning document input, enter the beginning document number
to be displayed (up to 10 characters). Press Enter (CR) to default to the
first document in the open documents file for this vendor.

If there are open documents on file for the vendor, the documents are
displayed and the system goes to the Prompt-selection input, which allows
you to selectively choose the documents to place on hold and release from
hold, to continue listing documents, bring up the next vendor or back up.

Steps through each document and selectively hold open documents. The
branch assigned to each document is displayed during the step through.
Various function keys aid in this process:

D Deletes the hold

F1 Skips the document and moves to the next document

F2 Places the document on hold. You can enter hold memo.

F3 Ends

CR Continues. If the screen becomes filled with documents, press

Enter (CR) to clear the screen and display the next page of documents.

(Optional) If you select S, you can choose to manually type in the payment
and discount amount. The branch assigned to each document is displayed
during the step through. You can select from the following functions:

(Optional) When you have stepped through the lines, press F3 to end the
payment selection.

The system returns to the prompt selection input. You can select from the
following;:

F2 Next vendor. This automatically enters the next vendor who has
open documents and proceeds to the beginning document input #2.

F4 Backup. This ends the prompt-selection input and backs up to the
Beginning Document input.

Press F4 twice to exit the program.

Payment & Hold Selection
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How to delete document holds

1.

Access this program by choosing Accounts Payable-->Payment & Hold
Selection-->Hold Selection.

In the Vendor input, enter the vendor number for hold selection. Press
Enter (CR) to default to the first vendor on file. Press F2 to search. Press
F3 to access the hold document search, which allows you to search and
display all vendors with documents on hold. Select the line number of the
vendor to display documents.

In the Beginning document input, enter the beginning document number
to be displayed (up to 10 characters). Press Enter (CR) to default to the
first document in the open documents file for this vendor.

Select S-Step through and you can choose to manually release documents
from hold. Press D-Delete to delete the hold status of the document. Press
F1-Skips to skip document and move to the next document as necessary.

(Optional) When you have stepped through the lines, press F3 to end the
payment selection.

The system returns to the prompt selection input. You can select from the
following;:

F2 Next vendor. This automatically enters the next vendor who has
open documents and proceeds to the beginning document input #2.

F4 Backup. This ends the prompt-selection input and backs up to the
Beginning Document input.

Press F4 to exit the program.

Accounts Payable—7.50
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CHAPTER 5

Checks

The Accounts Payable System consists of four types of checks: printed, manual, void, and
non-invoice. The Check Print program is used to print checks generated from the Payment
Selection List. When the user is satisfied with the list and is ready to print checks, the user
uses the Check Print program. One check prints for each vendor and pays the documents
listed on the Payment Selection List.

The Manual Check Entry program allows you to enter and record manual checks (written
manually by the user to pay invoices in the open documents file). Manual checks are usually
entered after the check has been written. The user enters the vendor, manual check number,
date and amount and then selects the documents paid by the manual check.

The Void Check Entry program is used to void out (system generated or manual) checks
updated by the Check Register. The user enters the check number and the number of the
invoice that was paid off by the check. Void checks are not updated until the Check Register
is updated, at which point the documents (invoices) go back into the open documents file.

The Noninvoice Check Entry program is used to pay an invoice not in the open documents
file, e.g., the user is entering the invoice(s), expensing the invoice(s) and recording payment of
the invoice(s) at the same time.

System generated (printed), manual and noninvoice checks are not updated until the Check
Register has been run and updated. Checks may be reprinted and manual and noninvoice
checks may be deleted or corrected until the time when the register is updated. If the register
is incorrect, the user may choose not to update at that time. It is possible to reprint and
update after corrections have been made. Multiple batches of checks may be printed before
the Check Register is printed and updated.
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Check Print (APP310)

Function

This program allows the user to prepare checks to be printed and then prints
the checks on check forms. The program also allows the same checks to be
reprinted, if, for example, the printer jams and a number of checks print off
alignment. When checks are reprinted, the original check to be printed is
automatically voided. The reprint check process may be used as often as
needed until the Check Register update is run. Once a check is updated by the
Check Register, the check may only be reprinted after the check has been
voided.

The program first prepares all the checks. When preparation is complete, the
checks are printed. The preparation of the checks is based on the documents
selected for payment in the Payment Selection subsystem. The Payment
Selection List should be printed for review prior to printing checks. The Check
Print prints the checks by first printing the stub of the check (comments, invoice
number, date, etc.) and then the actual check. If the check is paying more
invoices than can fit on one stub, the system automatically voids the first check
and continues with the second stub. The checks are printed on the standard
check forms based on the Bank F/M (Banking and Check System in System
Management) and the Check Print Control F/M programs.

NOTE: Checks are created and printed. However, no updating occurs in the
open documents file until the Check Register is printed and updated.

['To print an alignment (or test page) in graphical mode, select Print Options
> Alignment from the menu bar. In character mode, enter A at the selection
prompt and press return.

Access this program by choosing Accounts Payable >Checks >Check Print.

User Inputs

The following inputs are involved when printing a check:
1. Bank Code

Enter a bank code for this check run. The entry must be a valid bank code. The bank code
will display the bank name and the last check number printed. CR defaults to the first bank
on file.

2. Branch

Enter the branch to print checks. CR defaults to the branch assigned to the terminal. F3
defaults to ALL.

3. Check Date

Enter the date to print on the check (ref. 2). The date must be within the current or next
general ledger period and not before the current AP period. CR defaults to the system date.
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4. Beginning Check Number

Enter the beginning check number to print. This must be determined by looking at the check
forms in the printer. The first check is always skipped (unless the user attaches a forms leader
to the top check).

5. Void Checks

Enter Y or N to determine whether to void the checks displayed. This input is skipped if the
first check to print is the next number after the last check printed. If the first check to print is
NOT the next number after the last check printed, the system will ask if the user wishes to
void the checks in between. Input of Y will record all the checks as void, input of N will not
void any unused checks. CR defaultsto Y.

FACTS doesn’t allow you to void a check that’s in the Manual/Void Check File, the Check
Reconciliation File, or the Non-Invoice Check File.

If checks are being printed for the first time, skip to input #10.
6. Reprint Checks

Enter N or Y to indicate if any checks should be reprinted. If the user is not reprinting checks,
inputs #7-9 are skipped. If N is entered, inputs #8-9 are skipped. CR defaults to N.

7. Vendor Alpha Order

Indicate whether to print the AP checks in Vendor Alpha order rather than Check Number
order. CR defaults to No.

Technical Notes

The program runs in two stages. In the first stage, documents in the payment selections file
(APPYMT) are tabulated and assigned to a specific check number and written to the regular
check file (APCKRG). If a vendor’s selected documents total is zero or less than zero, the
selected payments will be removed from the payment selection file and will not produce a
check. If a check is prepared, the payments will be left in the payment selection file to be
removed later in the Check Register update. If the total number of documents is greater than
the maximum number of documents on a check voucher, the system will automatically assign
the number of checks needed to handle all of the documents.

In the second stage, the checks will print from the regular check file. The program will print
all the checks in this check file by first printing the voucher and then the check. If a check is to
be continued, the words VOID and CONTINUED print where the normal dollar amounts
would print. The bank codes record in the (SMCNTL) file will be updated to record the last
check used and the last check printed.

FILES USED - APVEND, APOPEN, SMCHKR, APCKMV
FILES UPDATED - SMCNTL, APCKRG, APPYMT
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How to print checks

1.

2.

Access this program by choosing Account Payable-->Checks-->Check Print.

In the Bank field, enter a bank code for this check run. The entry must be a valid bank code. The
bank code will display the bank name and the last check number printed. Press Enter (CR) to
default to the first bank on file.

In the Branch field, enter the branch to use for the Document Entry & Adjustment Register. Press
Enter (CR) to default to ALL. Select the icon to process all branches for the register. Select the
to search for branches.

In the Check date field, enter the date to print on the check. The date must be within the current
or next general ledger period and not before the current AP period. Press Enter (CR) to default
to the system date.

In the Beginning check number field, enter the beginning check number to print. This must be
determined by looking at the check forms in the printer. The first check is always skipped
(unless you attach a forms leader to the top check).

Select the Void checks checkbox to indicate whether to void the checks displayed. This input is
skipped if the first check to print is the next number after the last check printed. If the first check
to print is not the next number after the last check printed, the system asks if you want to void
the checks in between. If you select this option, the system records all the checks as void. If you
do not select, the system will not void any unused checks. Press Enter (CR) to default to Y.

FACTS does not allow you to void a check that’s in the Manual/Void Check File, the Check
Reconciliation File, or the Non-Invoice Check File.

If you are reprinting checks, select Reprint Checks checkbox to reprint check. Then in the From
field, enter the first check to reprint. You should read the check number from the previously
printed check and input that number. This will be the first check to reprint. Press Enter (CR) to
default to the FIRST check previously printed. In the To field, enter the last check to reprint.
Press Enter (CR) to default to the LAST check previously printed.

If you are printing a batch of checks for the first time, enter the Vendor alpha order to print the
checks by vendor. Otherwise, this program automatically prints checks in check number order.

Select the OK to start the check run or the Cancel button to stop this process.
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Manual Check Entry (APE310)

Function

This program allows the user to enter handwritten checks into the Accounts Payable system
and bypass the check print portion of processing. A manual check must be written to pay off
documents in the open documents file, such as purchase orders, customer refunds, etc. A
manual check used to pay off a document that is not in the open documents file is entered
through the Noninvoice Check Entry; i.e., if an invoice comes in C.O.D. and never existed in
the open documents file. The manual check number entered cannot be the same number
found in the manual and void check file, check reconciliation file or regular check file.
Manual checks may not be entered for vendors on hold.

Complete check information must be entered including the following: bank number, check
number, vendor number, check date, check amount, each document (invoice) paid by the
check and the payment and discount amounts.

The Manual Check Entry program consists of two sections. The upper portion of the screen is
called the header portion where the vendor number, check date, etc. are entered. The lower
portion is called the line-item portion where each invoice, amount, etc. is entered.

Manual check information appears on the next Check Register and all applicable files are
updated during the optional Check Register update. No updating occurs in the open
documents file during entry of a manual check.

User Inputs

The following inputs are involved in entering a manual check:
1. Bank

Enter the bank number on which the check was written. The entry must be a valid bank. CR
defaults to the first bank on file. F2 allows a search (ref. 7).

2. Check Number

Enter the manual check number (1-999999). CR defaults to the next check number after the
number displayed as last manual check. F2 lists manual checks already entered but not yet
updated by the Check Register. Once checks are listed, enter the beginning check to list if not
already displayed, CR to continue listing documents or enter the line number of the check to
display in detail. If a check is selected, the check is displayed and the program proceeds to
the Prompt-selection input.

3. Vendor

Enter the vendor number for this check. The vendor number, name, address and balance are
displayed. F2 allows a search (ref. 8).
4. Date

Enter the date of the manual check (ref. 2). The date must be within the current or next GL
period and not prior to the current AP period. CR defaults to the system date.
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5. Check Amount

Enter the dollar amount of this check (.01-9999999.99). A message is displayed if the amount
is greater than the vendor balance.

This concludes the header portion of the Manual Check Entry program. At this time, a header record
is created; once the header is created, all header inputs except #1-3 are accessible through the change
header routine (input #7). Inputs #1-3 can only be changed by deleting and re-entering the check.

6. Prompt-Selection Input # 1
This allows the user to perform the following functions to apply the check:

CR -Lists documents - Press CR to list all open documents for this vendor. Enter the
beginning document number to list or press CR to begin with the FIRST. The
information displayed includes document number, due date, current amount and
discount, discount due date and payment amount, discount taken and check status.
The check status indicates whether the payment is recorded on THIS CHECK, MN#- a
manual check number already entered, REGULAR CK - a regular check or if the
document is on hold. Press CR to continue listing documents. When all open
documents for this vendor are displayed, the system returns to Prompt-selection input
#1.

F3 - Lists selected - Enter the document number to be displayed. The entry must be a valid
document number which will display the screen information and return to the
document number input. When all selected documents are displayed, press F4 to
return to Prompt-selection input #1.

F4 - Ends selection and payment - The user may end the payment process and move to
Prompt-selection input #2.

The following functions may be performed after documents are displayed on
the screen.

A - Auto apply - Enter A to allow the system to automatically pay open documents. It will
begin with the first displayed document and continue paying off documents until the
check amount is distributed. If the check date is before or on the discount due date,
any applicable discounts are taken. The payment amount and discount amount are
displayed, the distributed amount is displayed in the header and the program returns
to Prompt-selection input #1.

S - Steps through - The user may use the step through option to selectively pay open
documents. The user then has the option to:

Enter payment - The user may manually type in the payment amount (i.e., allowing
for partial payments) and enter the discount amount (i.e., allowing a discount
to be taken after the discount due date).

CR - Deletes the payment

F1 - Skips the document and moves to the next line

F2 - Pays the document and takes the discount, if the discount due date is after or
the day of the check date

F3 - Ends payment selection

F4 - Backs up to the previous line

5-8
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7. Prompt-Selection Input #2
This allows the user to perform the following functions:

CR -Lists check payments - The user may list all payments made with this manual check.
Displayed information includes document number, due date, current amount and
discount, discount due date, payment amount, discount and status.

D - Deletes check - The user may delete all records of this manual check. Upon responding
with YES to the Are you sure you want to delete check? prompt, the system clears the
screen and returns to the check number input. The displayed field of last manual
check number used is updated. However, the deleted check number may be used
again.

F2 - Changes header - The user may change the check date or check amount in the header
portion of the screen. The check amount may not be less than the distributed amount.
F1 allows the currently displayed value to remain the same.

F3 - Apply check - The user may return to the selection and payment process Prompt-
selection input #1.

F4 - Ends - The user may end the input of the manual check. The distributed amount must
equal the check amount to exit this program. The last manual check number used is
updated and the program returns to the bank input.

Technical Notes

At the completion of entering the header information, a header record is written to the
manual and void check file (APCKMYV). Each invoice paid off in the line-item section also
writes a line-item record to the manual and void check file. Invoices paid off are also written
to the payment selections file (APPYMT) so that they may not be selected for payment
through the payment selection process before the check register is updated. The holding file
(APHOLD) is checked for documents on hold which may not be selected for payment.

FILES USED - APVEND, APOPEN, APHOLD, APCKRG, SMCHKR, APVALX,
GLALPX

FILES UPDATED - SMCNTL, APCKMV, APPYMT

Copyright © 1984-2005 Infor, Inc 5-9



Checks Accounts Payable—7.50

Li® Manual Check Entry [APE310]
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How to enter manual checks

1.

2.

Access this program by choosing Accounts Payable-->Checks-->Manual Check Entry.

In the Bank input, enter the bank number on which the check was written. Press Enter (CR) to
default to the first bank on file. Press F2 to search.

In the Check Number input, enter the manual check number (1-999999). Press Enter (CR) to
default to the next check number after the number displayed as last manual check. Press F2 to list
manual checks already entered but not yet updated by the Check Register. Once checks are
listed, enter the beginning check to list if not already displayed, press Enter (CR) to continue
listing documents or enter the line number of the check to display in detail. If a check is selected,
the check is displayed and the program proceeds to the Prompt-selection input.

In the Vendor input, enter the vendor number for this check. The vendor number, name, address
and balance are displayed. Press F2 to search.

In the Date input, enter the date of the manual check. The date must be within the current or
next GL period and not prior to the current AP period. Press Enter (CR) to default to the system
date.

In the Check Amount input, enter the dollar amount of this check (.01-9999999.99). A message is
displayed if the amount is greater than the vendor balance.

This concludes the header portion of the Manual Check Entry program. At this time, the system
creates a header record; once the header is created, you can change all header inputs — except
the bank, check number and vendor fields — by pressing F2. To change the other three fields,

you must delete the document and reenter it.

When you have entered the header information, the system goes to the prompt selection input,
where you can select from the following:

CR Lists documents. Press Enter (CR) to list all open documents for this vendor.

Enter the beginning document number to list or press Enter (CR) to begin with the FIRST. The
information displayed includes document number, due date, current amount and discount,
discount due date and payment amount, discount taken and check status.

The check status indicates whether the payment is recorded on:

THIS CHECK — the current check,

MN#- a manual check number already entered,

REGULAR CK - a regular check or if the document is on hold.

Press Enter (CR) to continue listing documents. When all open documents for this vendor are
displayed, the system returns to Prompt-selection input #1.

F3 Lists selected.
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Enter the document number to be displayed. The entry must be a valid document number that
will display the screen information and return to the document number input. When all selected
documents are displayed, press F4 to return to Prompt-selection input #1.

F4 Ends selection and payment. You can end the payment process and move to Prompt-
selection input in step 8.

8.  After you select documents, you can perform the following functions:

A Auto apply. Enter A to allow the system to automatically pay open documents. It will

begin with the first displayed document and continue paying off documents until the check

amount is distributed. If the check date is before or on the discount due date, any applicable
discounts are taken. The payment amount and discount amount are displayed; the distributed

amount is displayed in the header and the program returns to Prompt-selection input #1.

S Steps through. You can use the step through option to selectively pay open documents.

9. (Optional) If you select S, you then have the option to:

Enter payment. You can manually type in the payment amount (i.e., allowing for partial

payments) and enter the discount amount (i.e., allowing a discount to be taken after the discount

due date).

Enter (CR) Deletes the payment

F1 Skips the document and moves to the next line

F2 Pays the document and takes the discount, if the discount due date is after or the day of the
check date

F3 Ends payment selection

F4 Backs up to the previous line

10. When you are finished with payment processing, press F3 to access Prompt-selection input #2,
where you can perform the following functions:

CR Lists check payments. You can list all payments made with this manual check. Displayed
information includes document number, due date, current amount and discount, discount
due date, payment amount, discount and status.

D  Deletes check. You can delete all records of this manual check. If you answer YES to the Are
you sure you want to delete check? prompt, the system clears the screen and returns to the
check number input. The displayed field of last manual check number used is updated.
However, the deleted check number may be used again.

F2 Changes header. You can change the check date or check amount in the header portion of
the screen. The check amount may not be less than the distributed amount. Press F1 to
allow the currently displayed value to remain the same.

F3 Apply check. Press F3 to apply the check and the system returns you to the Bank input
where you can continue the selection and payment process.
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F4 Ends. You can end the input of the manual check. The distributed amount must equal the
check amount to exit this program. The last manual check number used is updated and the
program returns to the Bank input.

11. When you are done, press F4 to exit the program.
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Void Check Entry (APE320)

Function

This program allows the user to record as void any system or manual check previously
updated by the Check Register. In order to void a check, it must be in the check reconciliation
file.

After entering the number of the check to be voided, the user enters the number of each
document originally paid by the check. Void check information appears on the next Check
Register. Each document previously paid by the void check goes back into the open
documents file and the vendor’s balance increases accordingly.

User Inputs

The following inputs are involved in entering a void check:
1. Bank

Enter the bank number on which the check was written. The entry must be a valid bank. CR
defaults to the first bank on file. F2 allows a search (ref. 7).

2. Check Number

Enter the number of the check to be voided. This check must be in the check reconciliation
file. Entry of a valid check number displays the vendor number and name, address, balance,
check amount, discount amount and check date. F2 lists any void checks entered since the
last Check Register. Once checks are listed, enter the beginning check to list if not already
displayed, CR to continue listing documents or enter the line number of the check to display
in detail. If a check is selected, the check is displayed and the program proceeds to the
Prompt-selection input.

3. Is This Correct Check to Void?

Enter Y or N to indicate whether you wish to void the displayed check. CR defaults to Y.

4. Document Number

Enter the invoice number of each document originally paid by this check. Entry of a
document number still existing in the open documents file displays the document entry date,
due date, discount due date, document amount, discount amount and new balance and the
system returns to this input. F3 ends entries.

If the document no longer exists in the open documents file (it has been removed by the
Document Removal Register), the user has the option to add it to the file. Enter Y or N to
indicate whether this document should be added to the file. If Y is entered the user must
enter inputs #5-12.

If you are voiding a noninvoice check, you must enter a document number (that is not on file)
so that the check can be correctly voided. Complete input #5-12 to add the document number
to the open documents file. The void for the noninvoice check can then be correctly processed
through the system, including posting to General Ledger.

5. Document Entry Date

Enter the date the document was entered (ref. 2).
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6. Document Due Date

Enter the due date of the document (ref. 2).

7. Document Discount Due Date

Enter the due date of the document discount (ref. 2).

8. Void Payment Amount

Enter the amount paid to be voided by the check (+/- 9999999.99). (This will be the amount of
the document when updated to the open documents file.)

9. Void Discount Amount

Enter the amount to be the allowable discount amount when the document is updated to the
open documents file (+/- 9999999.99).

10. Branch

Enter a valid branch number. CR defaults to the branch assigned to the terminal. F2 allows a
search (ref. 7). The AP Check Register uses this entry to post voided checks by branch.

11. Memo

Enter the document memo (up to 25 characters). This memo will appear in the comments
column of the check stub when this invoice is paid off.

Upon completion of entering documents to be voided, the check amount must equal the
distributed amount and the discounts must equal the distributed discount amount to end
entries. F3 ends entry and moves to input #12. F4 backs up to the previous line, removes
that line and updates the distributed amounts accordingly.

12. Prompt-Selection Input
This allows the user to perform the following functions:

Change a document - Information may be changed regarding documents added to the open
documents file during Void Check Entry. Enter the document number to be changed. The prompt
Change or Delete (C/D)? is then displayed. Enter C to begin changing the information about the
document or enter D to delete this document from the screen and update the distributed amount
accordingly. If Cis entered, inputs #5-11 are entered and F1 allows the currently displayed value to
remain the same. If D is entered, the user must then respond with YES to the Are you sure you want
to delete? prompt.

L

Lists - A limited number of documents can be displayed on the screen at any one time.
Enter L to display documents related to this void check. F4 ends list.

A - Adds - Enter A to return to the document number input for further entries.

D - Deletes - Enter D to delete all information regarding this void check. Upon responding
with YES to the Are you sure you want to delete entire entry? prompt, the screen is
cleared and the check is not voided.

F3 - Ends - The distributed amount in the header is constantly updated as each line is

entered. This distributed amount must equal the original check amount and the
distributed discount amount must equal the original discount amount to end the
program. Press F3 to clear the screen and return to the check number input.
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Technical Notes

At the completion of entering the header information, a header record is written to the
manual and void check file (APCKMYV). Each invoice voided in the line-item section also
writes a line-item record to the manual and void check file.

Invoices will not be written to the open documents file until the Check Register is updated.
FILES USED - APVEND, APOPEN, SMCHKR, APTRAN
FILES UPDATED - SMCNTL, APCKMV, APPYMT
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How to enter a void check

1.

10.

11.

In the Bank input, enter the bank number on which the check was written. The entry must be a
valid bank. Press Enter (CR) to default to the first bank on file. Press F2 to search.

In the Check number input, enter the number of the check to be voided. This check must be in
the check reconciliation file. When you enter a valid check number, the system displays the
vendor number and name, address, balance, check amount, discount amount and check date.
Press F2 to list any voided checks entered since the last Check Register. Once checks are listed,
enter the beginning check to list if not already displayed, press Enter (CR) to continue listing
documents or enter the line number of the check to display in detail. If a check is selected, the
check is displayed and the program proceeds to the Prompt-selection input.

When the system displays: Is this correct check to void? Enter Y or N to indicate whether you
wish to void the displayed check. Press Enter (CR) defaults to Y.

In the Document number, enter the invoice number of each document originally paid by this
check. Entry of a document number still existing in the open documents file displays the
document entry date, due date, discount due date, document amount, discount amount and new
balance and the system returns to this input. Press F3 to end entries.

If the document no longer exists in the Open Documents file (it has been removed by the
Document Removal Register), and you need to add it to the file. Enter Y to indicate whether this
document should be added to the file and complete inputs 5-12.

If you are voiding a noninvoice check, you must enter a document number (that is not on file) so
that the check can be correctly voided. Complete inputs 5-12 to add the document number to the
open documents file. The void for the noninvoice check can then be correctly processed through
the system, including posting to General Ledger.

In the Document entry date input, enter the date the document was entered.

In the Document due date input, enter the due date of the document.

In the Document discount due date input, enter the due date of the document discount.

In the Void payment amount input, enter the amount paid to be voided by the check (+/-
9999999.99). (This will be the amount of the document when updated to the open documents

file.)

In the Void discount amount input, enter the amount to be the allowable discount amount when
the document is updated to the open documents file (+/- 9999999.99).

In the Branch input, enter a valid branch number. Press Enter (CR) to default to the branch
assigned to the terminal. Press F2 to search. The AP Check Register uses this entry to post
voided checks by branch.

In the Memo input, enter the document memo (up to 25 characters). This memo will appear in
the comments column of the check stub when this invoice is paid off.
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12.

13.

14.

Accounts Payable—7.50

Once you've entered all the documents that need to be voided, the check amount must equal the
distributed amount and the discounts must equal the distributed discount amount to end entries.

Press F3 to end the entry process and move step 13, which is the prompt selection input.
-OR-

Press F4 to back up to the previous line, remove that line and update the distributed amounts
accordingly.

At the Prompt-selection input, you can perform the following functions:

Change a document - Information can be changed for documents added to the open documents
file during Void Check Entry. Enter the document number to be changed. The prompt Change
or Delete (C/D)? is then displayed. Enter C to begin changing the information about the
document or enter D to delete this document from the screen and update the distributed amount
accordingly. If you enter C, you can change steps #5-11 or press F1 to allow the currently
displayed value to remain the same. If D is entered, you must then respond with YES to the Are
you sure you want to delete? prompt.

L Lists. A limited number of documents can be displayed on the screen at any one time.
Enter L to display documents related to this void check. Press F4 to end the list.

A Adds. Enter A to return to the document number input for further entries.

D Deletes. Enter D to delete all information regarding this void check. Upon responding
with YES to the Are you sure you want to delete entire entry? prompt, the system clears the
screen and does not void the check.

F3 Ends. The distributed amount in the header is constantly updated as each line is entered.
This distributed amount must equal the original check amount and the distributed discount
amount must equal the original discount amount to end the program. Press F3 to clear the screen
and return to the check number input.

When you are finished, press F3 to clear the screen and return to the check number input. Press
F4 to exit the program.

5-18
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Noninvoice Check Entry (APE330)

Function

This program allows the user to enter handwritten checks which pay off invoices that are not
currently in the open documents file and bypasses the check print portion of processing. This
program is used to enter a document (invoice) and pay it off in the same entry program, i.e.,
an invoice comes in C.O.D. and a manual check was written. If a check pays an existing
document in the open documents file, the check should be entered in the Manual Check Entry
program.

The noninvoice manual check number entered cannot be the same number found in the
manual and void check file, check reconciliation file or regular check file. Noninvoice checks
may not be entered for vendors on hold.

Complete check information must be entered including the following: bank number, check
number, vendor number, check date and check amount. Complete document information
must also be entered including document number, invoice date, amount paid, discount taken,
the general ledger expense number(s) and memo.

The Noninvoice Check Entry screen consists of two sections. The upper portion of the screen
is called header portion where the vendor number, check date, etc., are entered. The lower
portion is called line-item portion where each invoice, amount, etc., is entered.

Noninvoice check information appears on the next Check Register and is updated during the
optional Check Register update. A noninvoice check updated by the register will create a
zero balance open document in the open documents file and a payment transaction in the
transaction file.

User Inputs

The following inputs are involved in entering noninvoice checks:
1. Bank

Enter the bank on which the check was written. The entry must be a valid bank. CR defaults
to the first bank on file. F2 allows a search (ref. 7).

2. Check Number

Enter the manual check number (1-999999). CR defaults to the next check number after the
number displayed as the last manual check. F2 lists noninvoice manual checks already
entered but not yet updated by the Check Register. Once checks are listed, enter the
beginning check to list if not already displayed, CR to continue listing documents or enter the
line number of the check to display in detail. If a check is selected, the check is displayed and
the program proceeds to the Prompt-selection input.

3. Vendor

Enter the vendor number for this check. The vendor number, name, address and balance are
displayed. F2 allows a search (ref. 8).
4. Check Date

Enter the date of the manual check (ref. 2). The date must be within the current or next
general ledger period and not prior to the current AP period. CR defaults to the system date.
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5. Check Amount
Enter the dollar amount of this check (.01-9999999.99).

This concludes the header portion of the Noninvoice Check Entry program. At this time, a header
record is created and all header inputs except #1-3 are accessible through the change header routine.
Inputs #1-3 can only be changed by deleting and re-entering the check. The line-item portion allows
the entry of up to 999 line-items to complete the check.

Line numbers are assigned automatically beginning with 001 and incrementing by one for each
individual line-item up to 999. In the rare case where 999 line-items have been entered on a single
check, the program jumps to the Prompt-selection input #12 and refuses further entries.

6. Document

Enter the document (invoice) number (up to 10 characters). F3 ends entries and proceeds to
the prompt-selection input.

7. Invoice Date

Enter the invoice date (ref. 2). CR defaults to the system date.
8. Amount Paid

Enter the amount paid (+/-9999999.99). CR defaults to 0.

9. Discount Taken

Enter the amount of the discount taken (+/- 9999999.99) not greater than the payment
amount. CR defaults to 0.

10. GL Number

Enter the GL number to expense. The entry must be a valid GL number. If the GL posting
table assigned to this vendor has preset expense accounts, CR defaults to the GL account
number in the GL posting table and all numbers of the GL posting table may be displayed by
pressing F2-search. This search displays all GL numbers listed for the GL posting table
assigned to this document along with the GL numbers description. Select the line number of
the GL account number to expense to. F2 allows a GL numbers alpha search (ref. 7).

If the document is to expense to more than one GL number, each expense amount should be
entered on separate lines using the same document number. For example, if entering a $110
document (#12345 where $100 is to post to 620-00 office expense and $10 is to post to 640-00 -
freight expense, enter as two lines:

Invoice Amount Discount
Ln # Document Date Paid Taken G/L # Memo
001 12345 06/15/89 100.00 .00 620-00
002 12345 06/15/89 10.00 .00 640-00

The system automatically creates one invoice expensing to two GL account numbers.

11. Memo

Enter the memo to appear on the Check Register (up to 30 characters). CR skips the entry.
When the memo is complete, the input returns to the document number (input #6).

12. Prompt-Selection Input

5-20 Copyright © 1984-2005 Infor, Inc.



Accounts Payable—7.50 Checks

This allows the user to perform the following functions:

- Changes a line-item

Lists documents

Adds document

g » - #*

- Deletes a check

F2 - Changes header

F3 - Ends check entry and returns to the bank input (1)
Technical Notes

At the completion of entering the header information, a header record is written to the
noninvoice manual check entry file (APCKMI). Each invoice entered in the line-item section
also writes a line-item record to the noninvoice manual check entry file.

FILES USED - APVEND, GLMSTR, APVALX, GLALPX, APCKRG, APCKMYV,
SMCHKR

FILES UPDATED - SMCNTL, APCKMI

L Noninvoice Check Entry [APE330] M=l E

Help

81-Demo Company HOHINUDICE CHECK ENTRY APE336
CP=09/82 SEP

UEHDOR U118 BALAHGE C218.88 BANK 81 First Mational Bank of

Georgia Shipping Equip. Co. LAST CHECK USED: REGULAR GH2187 MAMUAL 875422

3376 Washington Ave. S.E.
CHECK # 875423 CHECK AHOUNT 23442 88

Atlanta, GA. 38302 DATE 09/01/682 DISTRIBUTED 1211.00
INUDICE AHDUNT DISCOUNT

LH#  DOCUHENT DATE PAID TAKEN G/L# ME HD

01 LG5 06711702 1211.08 12.6868 175-81-8

B8z |..........

EHTER DOCUMEHNT #, F3-EHD ENTRIES, Fu4-BACKUP
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How to enter noninvoice checks

1.  Access this program by choosing Accounts Payable-->Checks-->Noninvoice Check Entry.

2. Inthe Bank input, enter the bank on which the check was written. The entry must be a valid
bank. Press Enter (CR) defaults to the first bank on file. Press F2 to search.

3. Inthe Check number input, enter the manual check number (1-999999). CR defaults to the next
check number after the number displayed as the last manual check. F2 lists noninvoice manual
checks already entered but not yet updated by the Check Register. Once checks are listed, enter
the beginning check to list if not already displayed, CR to continue listing documents or enter the
line number of the check to display in detail. If a check is selected, the check is displayed and the
program proceeds to the Prompt-selection input.

4. Inthe Vendor input, enter the vendor number for this check. The vendor number, name, address
and balance are displayed. Press F2 to search.

5. Inthe Check date input, enter the date of the manual check. The date must be within the current
or next general ledger period and not prior to the current AP period. CR defaults to the system
date.

6. Inthe Check amount input, enter the dollar amount of this check (.01-9999999.99).

7. This concludes the header portion of the Noninvoice Check Entry program. At this time, the
system creates a header record and all header inputs except #1-3 are accessible through the
change header routine. Inputs #1-3 can only be changed by deleting and re-entering the check.

8. To enter invoices in the line item section, enter A and then complete steps.

9. Inthe Document input, enter the document (invoice) number (up to 10 characters). Press F3 to
end entries and proceed to step 11-16.

10. In the Invoice date input, enter the invoice date. Press Enter (CR) to default to the system date.

11. In the Amount paid input, enter the amount paid (+/-9999999.99). Press Enter (CR) to default to
0.

12. In the Discount taken input, enter the amount of the discount taken (+/- 9999999.99) not greater
than the payment amount. Press Enter (CR) to default to 0.

13. In the General ledger number input, enter the general ledger number to expense. The entry must
be a valid general ledger number. If the general ledger posting table assigned to this vendor has
preset expense accounts, press Enter (CR) to default to the GL account number in the GL posting
table. All numbers of the GL posting table may be displayed by pressing F2-search.

14. In the Memo input, enter the memo to appear on the Check Register (up to 30 characters). Press
Enter (CR) to skip the entry. When the memo is complete, the input returns to the document
number input so you can enter another document line.

15. Press F3 when you are finished entering documents and the system goes to the Prompt-selection
input, where you can select from the following functions:
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#  Changes a line-item

L  Lists documents

A Adds document

D  Deletes a check

F2 Changes header

F3 Ends check entry and returns to the Bank input.
F4 Exits the program.

16. When you are finished entering documents, press F3 to end check entry. Press F4 to exit the
program.
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Check Register (APR310)

Function

This program allows the user to obtain a report of all regular, manual, non-invoice and void
check information since the last Check Register was updated. The optional update following
the register updates all necessary files.

This register is an audit trail of all check disbursements or voids and should be printed,
checked and updated each time regular checks are printed. It may also be printed after input
of manual, noninvoice or void checks. If the register is not printed directly after input of
manual, noninvoice or void checks, the information appears on the next register with regular
checks.

Information for the register comes from four programs - Check Print, Manual Check Entry,
Noninvoice Check Entry and Void Check Entry.

The user has the option to:

e Print a listing of all checks.

e Select check types (regular and/or manual and void).

e Build and print a general ledger distribution, if needed.

e Post to general ledger, if a general ledger distribution is built.

e Update the open documents file and vendor balance.

e Update the monthly disbursement distribution and check files

e Update the company accounts payable balance, clear the check files, and the
appropriate control records.

Register information includes the following: check number, check date, check amount, vendor
number and name. Information about each document paid by the check includes document
number, entry date, due date, payment amount, discount taken and memo.

Totals are printed for regular checks, manual and void checks and register. The register recap
prints the beginning AP balance, payments, discounts and ending AP balance. The total
number of regular, manual and void checks listed is also included. Depending on a flag set in
the AP static control record, the user may obtain a general ledger distribution.

User Inputs

The following inputs are involved in printing the Check Register:
1. Date

Enter the check register date (ref. 2). The date entered must be in the current or the next GL
period and not prior to the current AP period. CR defaults to the system date.

2. Bank

Enter the bank for which checks are to print. The entry must be a valid bank. CR defaults to
the first bank on file.

3. Regular Checks

Enter Y or N to indicate whether information regarding regular checks (checks generated
through the Check Print program) should print. CR defaults to N automatically if there are
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no regular checks to print. CR defaults to Y automatically if there are no manual and void
checks to print.

4. Manual and Void Checks

Enter Y or N to indicate whether information regarding manual and void checks should print.
CR defaults to N automatically if there are no manual or void checks to print. CR defaults to
Y automatically if there are no regular checks to print.

The Check Register prints by reading through the regular check file and the manual and void check
file. Information about each check prints as the general ledger distribution file is built.

For users printing the GL distribution, the following input is displayed:
5. Check Register. OK to Print GL Distribution?

After printing the Check Register, verify the printout. If there is a correction to be made,
enter N to exit the program. After the correction is made, run the register again. If everything
is correct, select OK or enter Y to continue. The program then prints the GL distribution.
Once the GL distribution is printed, the next message appears:

6. Check GL Distribution. OK to Update?

After printing the GL distribution, verify the printout. If everything is correct, select OK or
enter Y to continue. The program proceeds with the update. If there is a correction to be
made, select CANCEL or enter N to exit the program. After the correction is made, the entire
register process begins again.

For users not printing the GL distribution, the following input is displayed:
Check Register. OK to Update?

After printing the Check Register, verify the printout. If there is a correction to be made,
select CANCEL or enter N to exit the program. After the correction is made, the register can
be rerun. If everything is correct, enter YES to continue and no GL distribution will be
printed, the following input (#7) is skipped and the program proceeds with the update.

Technical Notes

Before the update, the GL distribution file (SMGLD?) is built with the necessary information
to print and update the GL distribution.

The AP update begins by reading through the regular check file (APCKRG) and/ or the
manual and void check file (APCKMYV) and updating the open documents file (APOPEN).
Then a record is written to the invoice transactions file (APTRAN) and the payment selections
file (APPYMT) and check records are removed. Next the vendor file (APVEND) is updated
and the update continues by reading through the noninvoice manual check entry file
(APCKMI). Then records are written to the ledgercard file (APLEDG). Records are then
written to the period check register file (SMCHKP), the check reconciliation file (SMCHKR),
the vendor history file (APHIST) and the bank ledgercard file (SMLEDG). The control file is
updated as to company AP balance, register number, register trace number, current bank and
register history. Finally, open documents are created from any void checks entered.

The optional GL update reads through the GL distribution file and writes records to the GL
journal entry files (GLJRNL and GLJRNX). Finally, the period disbursement distribution file
(APDISD) is written to.
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FILES USED - GLMSTR

FILES UPDATED - SMCNTL, APCKRG, APVEND, APCKMV, APOPEN, APPYMT,
SMCHKR, SMCHKP, APCKMI, APTRAN, GLJRNL, GLJRNX, APDISD, SMGLD?, SMLEDG,
APHIST, APLEDG

;2 Check Register [APR310) M= E3

Template  Print Options

AP CP=09/1397 SEP
Date |ITIEREES ] 6L CP=09/1997 SEP
Bank | 01 ¢ | Bank of Greater Duluth
[V Reaular Checks
[v MWanual ¥oid Checks

Template Printer
Mone Genicom Line Printer ﬂl

| Enter Check Register Date, F1-Systemn Date

L Check Register [(APR310] [_ O]

Help

B1-Demo Company Check Register aPR314
AP CP=09/2802 SEP

Date System Date GL CP=89/2882 SEP

Bank 61 First Hational Bank of Atlanta
Reqular Checks ¥

Manual and Uoid Checks ¥

— Template — Printer
Hone Print to file

CR-Run Report, F1-Template, F2-Printer, F3-Change Answers, FAh-Exit .

5-26 Copyright © 1984-2005 Infor, Inc.



Accounts Payable—7.50 Checks

How to run the Check Register

1.

Access this program by choosing Account Payable--> Checks-->Check
Register.

In the Date field, enter the check register date. The date entered must be in
the current or the next GL period and not prior to the current AP period.

Press Enter (CR) defaults to the system date. Select the
the system date.

icon to input

The current AP and GL Periods appear in the upper left corner of the screen.

3.

In the Bank field, enter the bank for which checks are to print. The entry
must be a valid bank. Press Enter (CR) defaults to the first bank on file.
Select the # to search for banks.

Select the Regular Checks checkbox to indicate whether or not you want to
print information regarding regular checks (checks generated through the
Check Print program). The program defaults to N if there are no regular
checks to print. However if the program cannot find manual and void
checks to print, it defaults to Y.

Select the Manual and void checks checkbox to indicate whether or not
you want to print information regarding manual and void checks. Press
Enter (CR) to default to N if there are no manual or void checks to print.
However, if there are no regular checks to print, it defaults to Y.

The Check Register prints by reading through the regular check file and the

manual and void check file. Information about each check prints as the
general ledger distribution file is built.

If you have FACTS set to print GL distribution, the system displays the
following message: Check Register. OK to Print GL Distribution?

After printing the Check Register, verify the printout. If you need to
correct the register data, select Cancel or enter N to exit the program.
After you make the correction, you can rerun the Check Register. If
everything is correct, select OK or enter YES to continue. The program
then prints the GL distribution.

Once the GL distribution is printed, the program displays the message:
Check GL Distribution. OK to Update?

After printing the distribution, verify the printout. If everything is correct,
select OK or enter YES to continue. The program proceeds with the
update. If you need to make a correction, select Cancel or enter N to exit
the program. After you correct the information the correction is made, re-
run the entire register process —meaning run the register first, then print
the GL distribution, followed by the optional update.

OR

If you are not printing the GL distribution, the program displays the
message: Check Register. OK to Update?
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After printing the Check Register, verify the printout. If you need to make
a correction, select Cancel or enter N to exit the program. After you make
corrections, rerun the register. If everything is correct, select OK or enter
YES to continue.
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CHAPTER 6

Inquiries

The Accounts Payable inquiry allows the user to display information on
vendors on the screen without affecting any data in any files and without
locking any files. The Vendor Inquiry displays various information for
vendors. The information included is general, code, and activity, open/ detail
documents, paid documents, vendor notes, payment history, and ledgercard
information. (Notes are entered through this program.)

™, FACTS 7.5 Distribution Software - Accounts Payable (APS000)

FACTS (~nTom

DISTRIBUTIUN 50FTWARE

ULWITEC) FACTS 7.6 Development - Company 01 02402405 - 1:39 pm

b |
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S
G
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™\ Company 01, FACTS 7.5 Development !Eu
Help
B1-FACTS 7.5 Developme AP5688
Selection
ENTER SELECTION #, ACCESS CODE, 'OFF', ARROWS, F4-PREVIOUS HMEHU
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Vendor Inquiry (AP1610)

Function
Use this program to display the following information about any vendor set up in the system:

e General information

e Code information

e Activity

e Open/detail documents
e Paid documents

e Payment history

e Ledgercards

e Notes

< For more information about inquiry features, such as Sync, filters and
preferences, see Using FACTS.

To view vendor information:

1. Enter the vendor for which you want to view information.

Select whether to sort vendor records by vendor number, alpha lookup or
contact. In GUI, select a sort order by choosing Sort by from the menu bar. In
character, press F2.

Select filters if you want to limit the number of records in the inquiry browser.
In GUI, choose Options DFilter Values. In character, press F1.

Use the up and down arrow keys or the Page Up and Page Down keys through
the list of displayed vendors. (Graphical users can also use the vertical scroll
bar.)

2. Select a view.

In graphical: Choose a view from the View menu option or select a view from the
view bar.

In character: Use the right and left arrow keys to select a view from the view bar.

View descriptions

General Displays general information including phone
number(s), contact(s), message, vendor status, our
customer number, our tax exempt number, normal
document group, 1099 ID, ship-from, store past PO’s
flag and use ledgercards flag.

Codes Displays code information including vendor class,
terms code, freight code and general ledger posting
table.

Activity Displays vendor activity information including

month-to-date, year-to-date and prior year figures for
invoices, payments, discounts taken and allowable
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6-4

Open
Documents

Paid
Documents

Payment
History

discount. The account opening date, last invoice date,
last payment date, highest balance date, highest
balance amount and 1099 balance are also included.

Displays open documents, from oldest to newest, for
the selected vendor. Summary information includes
document number, document type (Invoice,
Noninvoice), purchase order number, register
number, entry period, date entered, date due, original
amount and current amount.

Getting more information on an open document:

Graphical users: In the view area, select the line and
choose the Line Detail button or double click the icon
at the beginning of that line.

Character users: Press F3-Bottom, highlight the line
and press CR.

Detail information displays summary plus the memo,
original and current discount amounts and any
transactions against the open documents. Transaction
information includes sequence number, transaction
date, entry period, register number, payment and
discount amounts and memo.

Displays, for the vendor selected, paid documents
that have been removed from the open documents file
by the Document Removal Register. Information
includes document number, original amount and
discount, entry period and register number,
document removal register number, last check
number and purchase order number.

Getting more information on a paid document:

Graphical users: In the view area, select the line and
choose the Line Detail button or double click the icon
at the beginning of that line.

Character users: Press F3-Bottom, highlight the line
and press CR.

Detailed transaction information includes sequence
number, transaction date and period, register
number, payment amount, discount amount and a
memo. Memo information displays check type
(Manual, Regular) and check number.

Displays the total of all payments made to the vendor
for the next period, current period and the 26-prior
periods.

Accounts Payable—7.50
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Ledgercards Displays all ledgercard information for the selected
vendor.

The inquiry lists ledgercards from newest to oldest by
default. To view oldest to newest:

Graphical users: Click on the Date column header.
(You can also click on any other column header to
resort ledgercards.)

Character users: Press F3-Bottom and enter O.

In either order, select the beginning date to view.
Information includes date, debit amount, credit
amount, balance, transaction register name, document
and register number.

Graphical users: Select the View Doc button at the
bottom of the screen to display additional document
detail information.

Character users: Press F3-Bottom and press Enter to
display additional document detail information.

The system checks to see if detail info exists for
currently highlighted ledgercard line for its
transaction type. For AP ledgercards there are 4
transaction types: B - Begin Balance, E - Doc Entry
Register, C - Check Register, and V - Vendor Balance.
Only ledgercards of type E will result in a drill down
to. Doc Entry Register type documents display
additional either the Open Docs line detail window
(API614) or the Paid Docs line detail window
(API615).

Notes Displays notes for the specified vendor. In the
browser in the lower portion of the screen the system
displays the date the note was created, note category,
urgent note indicator, and subject. You can double
click a note line in the browser to display the View
Note screen, which lists the note subject and text,
note type, category, date created, and date edited.

You can access the Notes Entry (SME710) program
from the Options=>1 Vendor Note Entry to enter or
modify notes for the specified vendor.

User-Defined The data that appears on the User-Defined view of
Vendor Inquiry comes from the User-Defined view of
Vendor F/M (APF910). Many users have a few
pieces of information about customers, vendors, and
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Technical Notes

items that are unique to their business that they
would like to enter into FACTS for reference
purposes. The User-Defined view displays user-
defined fields entered the major file maintenances
and makes them available in FACTS Inquiry
programs for information only. There are 5 user-
defined fields that can be entered on the User-
Defined screen of Vendor F/M (APF910). There
user-defined field must first be configured by a user
that has administrator privileges for User-defined
Fields setting on the Security tab of User Code F/M
(SMF410).

Information displayed is accessed from the following files:

FILES USED - SMCNTL, APVEND, APOPEN, APPAST, APTRAN, APHIST,
APVALX, APLEDG, APNOTE, APLEDG

FILES UPDATED - APNOTE

Accounts Payable—7.50
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m 01-Specialty Distributors, Inc.. AP Yendor Ingquiry - Yendor # Order [APIG10]

Options  “iew SortBy E=port Print Help

GoTo | | Startswith | ErE | v

Vendor vendar Mame City, State Alpha =l
U108 General Industrial Mfg + Atlanta, GA GENERAL
U181 Industrial Supply Distributors Atlanta, GA INDUSTRI
U182 S.E. Industrial Prod. & Equip. Atlanta, GA S.E. Irﬂd
L3
j Activity Codes Contacts I General Ledgercards Open Docs ﬂ
Address 1 9610 Dunwoothy, PL Yendor Status  Permanent
Address 2 Suite 133-134 Our Cust# S890-0
Address 3 Atlanta, GA. 30338 Doc Group 34
Tax Exempt# 3400022-12 Ship-Fram 5100
10949 ID# 3422-09-8887 Store PastPO's  Yes

iy hallmark. com Use Ledgercards  Yes

! Exit |

|Enter characters vendor # must start with

E% vendor Inquiry (AP1610)

Help
B81-Specialty Distributors, InAP VUendor Inquiry - Alpha Order APIa1d
Alpha Uendor Uendor Hame City, State Uend
Uendoc 1 Uendoc Here, AL
U185 Warehouse Equipment Unlimited Dallas, T3
WAREHOUSE U128 Warehouse Interiors, Inc. Dallas, TX
Go To Filters Off
Sync OfFf
Activity Codes Contacts -
Address 1 11598 General Ave . Uendor Status Permanent
2 Our Customer # J42700-X
3 Dallas, TX 75822 Doc Group &1
Tax Exempt # Ship-From  SAlE
1899 ID # Store Past PO's Yeso

Use Ledgercards Yes

F2-0rder: Alpha, Contact, Uendor #
Enter beginning alpha, F1-Edit filters, F4-End, F18-Menu |..........
Arrows: Up=Prev, Down=Hext, Left/Right=View, PglUp, PqDn, Home, End
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2% 01-5pecialty Distributors, Inc., AP Yendor Inquity - Yendor # Order [APIG10)

Optionz  Yiew SortBy Ewxport Print Help

GoTo | Starts with | E~A= |1|

‘Vendor Yendar Mame City, State
U180 General Industrial Hfg + Atlanta, GA GEHERAL
U181 Industrial Supply Distributors Atlanta, GA INDUSTRI
U182 S_E. Industrial Prod. & Equip. Atlanta, GA S.E. IHD -]
1
j Arctivity I Codes Cantacts General Ledgercards Open Docs ﬂ
Yendar Class INV  Inventory Suppliers
Terms Code M Manual

GL Table 005  Inventory
Freight Code  Prepayidd

! Exit I

Enter characters wvendor # must start with

2
E% Vendor Inquiry [APIE10) M= E3
Help
81-Specialty Distributors, InAP Uendor Inquiry - Alpha Order aPI61da
Alpha Uendor VUendor Hame City, State Uend
Uendoc 1 Uendoc Here, AL
U185 Warehouse Equipment Unlimited Dallas, TX
WAREHOUSE U128 Warehouse Interiors, Inc. Dallas, TX
Go To Filters OffF
sync DFFf
Activity | Codes | Contacts General ->

Uendor Class IHU Inventory Suppliers
Terms Code 36 Het 38
GL Table ©9685 Inventory
Freight Code Prepaid

F2-0rder: Alpha, Contact, Uendor #
Enter beginning alpha, F1-Edit filters, F4-End, F18-Henu |..........
Arrows: Up=Prev, Douwn=Next, Left/Right=Uiew, PgUp, PqgDn, Home, End

6-8 Copyright © 1984-2005 Infor, Inc.



Accounts Payable—7.50

E; 01-5pecialty Distributors, Inc.. AP Yendor Inguiry - Yendor # Order [APIE10)
Options  Wiew SortBy  Export  Print Help

GoTo | | Starts with |

BB ||

City, State
+ Atlanta, GA

Yendor Wandor Mame

U188 General Industrial Hfg
U181 Industrial Supply Distributors Atlanta, GA
U182 S.E. Industrial Prod. & Equip. Atlanta, GA

sipha =]
GENERAL
INDUSTRI

S.E. IHD - |
L3

jl Activity Codes Contacts General Ledgercards

Open Docs ﬂ

Date Balance

Opened  11/30/1997 Last Payment 101072000 Current 10104358.90
Last Inwoice  10015/2000 High Balanze  10/01/2000 1099 97859.77
Inwoices Fayments Cisc Taken Disc Allowahle
MTD 10109143.33 7306.69 ¥7.03 101503.80
YTD 10185218.95 97859.77 5026.12 106064.34
PYR 104206.00 102909.15 1296.85 1206.85
APIB1DACTIVITY.18
U Exit |
Enter characters vendor # must start with i
E% vendor Inquiry [APIG10] [_ O] x]
Help
81-Specialty Distributors, InAP Uendor Inquiry - Alpha Order aPIa1d
Alpha Uendor Uendor Hame City, State Uend
Uendoc 1 Uendoc Here, AL
WAREHDOUSE U185 Warehouse Equipment Unlimited Dallas, TX
WAREHOUSE U128 Warehouse Interiors, Inc. Dallas, TX
Go To Filters Off
Sync OfF
Codes Contacts General -
— Date — Balance
Opened 8372871997 Last Payment H9/12/2888 Current 458B8.96
Last Invoice 16/16/2000 High Balance G8/24/20008 1899 169667 .43
— Invoices — — Payments — — Disc Taken — — Disc Allowable —
MTD LG5L .72 33621.78 .88 2.88
YTD 163118 .89 169667 .43 .88 2.88
PYR 209726.00 208583 .71 .86 .88

F2-0rder: Alpha, Contact, Uendor #
Enter beginning

alpha, F1-Edit filters, F4-End, F18-Henu .........
Arrows: Up=Preu, Down=Hext, Left/Right=Uiew, PgUp, PgqDn, Home, End

Copyright © 1984-2005 Infor, inc.
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Inquiries

E; 01-5pecialty Distributors, Inc.. AP ¥Yendor Inguiry - Yendor # Order [API610]
Options  Miew SortBy Export Print Help

Accounts Payable—7.50

GaTa | #|  Startswith | ExE| |

Yendor Yendor Name City, State Alpha |
U180 General Industrial Hfg + Atlanta, GA GEHERAL
U181 Industrial Supply Distributors Atlanta, GA INDUSTRI

U182 S.E. Industrial Prod. & Equip. Atlanta, GA S.E. IND -]
L3

j Activity Codes Contacts General Ledgercards I Open Docs ﬂ

Document# | T Entry Date Diue Date Current Amt | Reg# =
001070 092052000 (2000 1367.16 13 G 1521

1| 3
91 oooooz  0s/01r2000 10/ 672000 100.00 100.00 1521
101 o000t 08/09r2000 10/09/2000 100.00 001524
131 ooooot 1050152004 117302004 100.00 0015145
42| oooooo 0&rz0r2000 1053072000 100.00 100.00 1521
43| noooooo - 10M 052000 11/30/2000 250.00 250.00 1522
| 51 | ooo0oo - 1052652004 12/30/2004 120.00 1IED.DD 1513_|_'|
4 »

Start Fram IDc--:umen‘t j I LI il |_I

T LineDetail | @ Exit |

Enter characters vendor # must start with

E% Vendor Inquiry [APIG10)

6-10

Help
81-Specialty Distributors, InAP Uendor Inquiry - Alpha Order aPI61d
Alpha Uendor Uendor Hame City, State Uend
Uendoc 1 Uendoc Here, AL
U185 Warehouse Equipment Unlimited Dallas, TX
WAREHOUSE U128 Warehouse Interiors, Inc. Dallas, TH
Go To Filters OfF
Sync OFF
<- Contacts General Ledgercards -
Document # T PO # Entry Date Due Date Orig Amt Current Amt Regh  Peri
66 I G@008681 18716872080 127317200808 1088.08 168.88 1532 18/29
1289 I @6AA982Z 8878372084 BD702/72084 1388.146 .aa 1588 @8/20@
1380 I 000989 08/13/2004 A9/12/72004 Lo .57 .08 1582 @g/20
1389 I 681867 08/17/72004 8971672004 2008 .82 .88 1582 og/20
1321 I 681822 8872472084 BD723/720084 2333.81 .88 1583 @8/20
1322 1 ae1@12 8872772004 89726720084 SLBH .96 L488.96 1584 A8/20
1332 I 6816831 08/31/2004 0973072004 23608.38 .88 1584 o0g/209
1334 I 600997 08/31/2084 6973872004 2857 .67 .88 1584 08/20
FZ2-0rder: Alpha, Contact, Uendor #
Enter beginning alpha, F1-Edit filters, F3-Uiew, F4-End, F18-Henu ..........

Arrows: Up=Prev, Down=Hext, Left/Right=Uiew, PqUp, PqDn, Home, End

Copyright © 1984-2005 Infor, Inc.




Accounts Payable—7.50

E; 01-5pecialty Distributors, Inc.. AP ¥Yendor Inguiry - Yendor # Order [API610]
Options  Miew SortBy Exportt Print Help

GoTo | | Starts with | Er-E | '7|

Alpha =]
GENERAL
INDUSTRI
S.E. IND~

3

\endor Wendor Name City, State
U180 General Industrial Mfg....... + Atlanta, GA
U181 Industrial Supply Distributors atlanta, GA
U182 S._E. Industrial Prod. & Equip. Atlanta, GA

j Activity Codes I Contacts General Ledgercards Qpen Daocs ﬂ

Contact 1 Roger Smith Fhone  404-393-9444

E-mail smittyftsomewhere.com

Contact 2 Gloria Fayve-Smith Fhone {404)393-0457

E-mmail GLORIA#@aol.com

Weh Site wwaw hallmark.com
Message  MIN 10% OFF CATALOGK

! Exit I

Enter characters vendar 3 must start with

E% Yendor Inquiry [APIE10)

Help
@1-Specialty Distributors, InAP Vendor Inquiry - Alpha Order APIG18
Alpha Uendor Uendor Hame City, State Uend

Uendoc 1 Uendoc Here, AL

U185 WYarehouse Equipment Unlimited Dallas, TX

WAREHDUSE U128 Yarehouse Interiors, Inc. Dallas, TH
Go To Filters Off
Sync OFF

nctivity Codes General ->

Phone 214-982-9485

Contact 1 James Hubbard
E-mail

Contact 2 Phone
E-mail

Web Site
Hessage

F2?-0rder: Alpha, Contact, Vendor #
Enter beginning

alpha, F1-Edit filters, FA-End, Fi18-Menu ..........
, Pgqbn, Home, End

Arrows: Up=Prev, Down=Hext, Left/Right=Uiew, Pglp

Copyright © 1984-2005 Infor, inc.
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Inquiries

m 01-Specialty Distributors, Inc., AP Yendor Inquiry - Yendor # Order [APIG10]

Options  Yiew Sort By Esport Print Help

Accounts Payable—7.50

GoTo | |

Starts with |

Yendor Yendor MName

U188 General Industrial Hfq

City, State
+ Atlanta, GA

U181 Industrial Supply Distributors fAtlanta, GA
U182 S_E. Industrial Prod. & Equip. Atlanta, GA

GEMERAL
IHNDUSTRI
5.E. IND ~

L3

6-12

ﬂ Codes Contacts General Ledgercards Qpen Docs I Faid Docs ﬂ
Doc # Jriginal Amt Jriginal Disc Entry Fer | Entry Reg# Rl Reg# =
5 2004010 1519 1059
12494 A305.02 106.10 2000/08 1501 no&s
1311 MIeTT 4348 2000/08 1503 no&s
1326 227266 4545 2000/08 1504 no&s
I3 o o 2000010 1523 0060
0505180262 303585 6072 2000/07 25486 noss
1515165470 1668.05 3336 2000/07 3748 nosa _I_*'I
4 L4
Start From IFaid Documents = | Ll ﬂl I_|
) LineDetail | I Exit |
|Entercharactersvendnr#muststartwith ‘é
E% Vendor Inquiry [APIE10) [_ O] =]
Help
#1-Specialty Distributors, InAP Vendor Inquiry - Alpha Order nPI61a
Alpha Uendor Uendor Hame City, State Uend
Uendoc 1 Uendoc Here, AL
U185 Warehouse Equipment Unlimited Dallas, TX
WAREHOUSE U128 Warehouse Interiors, Inc. bpallas, TR
Go To Filters OFF
Sync OFfF
<- General Ledgercards Open Docs -

Doc # Original Amt Original Disc Entry Per

8823866218 1948 .69 a.08
823408087 835 1878.71 a.08
2182438714 1943.11 a.08
2759614838 11597 .86 a.08
3528783886 1867 .81 a.08

F2-0rder: Alpha, Contact, Vendor #

87720808 1946
8772008 8347
8772888 2433
g7/72888 7214
8772808 344y

Entry Regit Rmuvl Reg#t Lst Chkit

aes58
aes58
aes58
aes58
aes58

Enter beginning alpha, F1-Edit filters, F3-Uiew, F4-End, F18-Henu

Arrows: Up=Prev, Down=Hext, Left/Right=Uiew, Pglp

, Pgqbn, Home, End

ap3 068
ap3elvz
ap3 068
ae3831
ap3elvz
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Ec 01-5pecialty Distributors, Inc., AP Yendor Inquiry - Yendor ## Order [APIG10)

Option:  VWiew SortBy Ew=port Print Help

GoTo | | Stars with | B | |

Vendor Wendar Marne City, State

U188 General Industrial MFqQ....... + Atlanta, GA GEHERAL

U181 Industrial Supply Distributors Atlanta, GA INDUSTRI

U182 S.E. Industrial Prod. & Equip. Atlanta, GA S.E. Irﬂ;[
13

ﬂ Contacts General Ledgercards Open Docs Paid Docs I Payrment Hist ﬂ

Current Periad 2000/10 OCT 7308.59 :I
Last Period 2000/09 SEP 23373
Previous Period 2000008 ALG 11655.25
Previous Period 2000507 JuL 11736.54
Prexvious Period 2000706 JURN 10269.24
Presious Period 2000705 MAY 922272
Prexious Period 2000/04 APR T350.03 =l
! Exit |
|Entercharactersvendar#muststartwith v
L Vendor Inquiry [APIG10) =
Help
81-Demo Company AP Vendor Inquiry - Alpha Order [TITRL |
Alpha Uendor Uendor Hame Cit State Uend
ATLANTA CR U113 Atlanta Crane & Hoists Doraville, GA
ATLANTA GA U111 Atlanta Gas Company Atlanta, GA
D' ANCONIA U117 D'Anconia Copper and Electric Stone Mountain, GA
Go To Filters OfF
sync OFF
<= Ledgercards Open Docs Paid Docs Payment Hist
Period Desc Period Payment
Hext Period 14726082 OCT -6a
Current Period B9 /208082 SEP 454864
Last Period 8872002 AUG FA3.59
Previous Period 8772882 JUL 1877 .83
Previous Period 06/20082 JUN 1808 _48
Previous Period B5/2082 HaY 1798 .54
Previous Period B4/2882 APR 1787 .61
Previous Period 03/2002 HAR 1778.66
F2-0rder: Alpha, Contact, Vendor #
Enter beginning alpha, Fi1-Edit filters, F3-Uiew, F4-End, F18-Menu |..........
Arrows: Up=Prev, Down=Hext, Left/Right=Uiew, Pglp, PgDbn, Home, End First Line
4
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Inquiries

\\.DI—Specialty Distributors, Inc., AP ¥Yendor Inquiry - ¥endor # Order (APIG10}) - |EI|5|

Cphions  Wiew  Sort By Export Print Help

Accounts Payable—7.50

GaTo | | staswitn BT Exa | P

Vendor Wendor Name City, State
U180 General Industrial MWfg....... + Atlanta, GA

j Arctivity Codes contacts General I Ledgercards Open Docs ﬂ

Balance | Transaction Coc

03/10/2003 H32. 10129028.40 Check Renister

0370772003 20.00 10128396.40 Doc Entry Reg 234523432

0370772003 50.00 10128376.40 Doc Entry Reg 345242

0201772003 882.25 10128326.40 Doc Entry Reg

0201772003 1.00 1012744415 Doc Entry Reg 4346234

0201372003 1000.00 1012744315 Doc Entry Reg 1456
p r?rn?r?nm ARRE R 1N17R443 15 Nine Frtre Ran ﬂmi?_l

Start From INeu.lest to Oldest = | Ll ﬂl I_|

o wiewDoe | Ext |

|Entercharactersvendnr#muststar‘[with A
\'h'endnr Inquiry (APIG10) — |EI|£|
Help
81-Specialty Distributors, InAP Vendor Inquiry - Uendor # Order AaPI616

Vendor Uendor Hanme Cit State Alpha Cont
U188 General Industrial Hfg GEMERAL IH Roge|

U161 Industrial Supply Distributors Atlanta, GA INDUSTRIAL Jon

U162 S.E. Industrial Prod. & Equip. Atlanta, GA S.E. INDUS Jerr

Go To Starts MWith Filters Off
Sync OFf

<~ Codes Contacts General ->

Date Debit Credit Balance Transaction Doc # Reg
B3/18/2003 632.08 10129028 _48 Check Register 17 B34
8378772883 20.88 18128396.48 Doc Entry Reg 2345234234 154
83/87/2003 58.88 18128376.48 Doc Entry Reg 4524234 154
82/17/20083 g82.25 18128326.48 Doc Entry Reg 12 154
8271772003 1.88 18127444 .15 Doc Entry Reg 43523453 154
8271372003 16868.68 18127443.15 Doc Entry Reg 145645 154
8278772003 4E555.86 18126443.15 Doc Entry Reg 12456677 154
8278772003 327.71 18121888.8%9 Doc Entry Reqg SDFASDL 154
Enter beginning: Hewest to 0ldest, O0ldest to Hewest
CR-View Doc, F1-Reload, F3-Header, F4-End |..........

Arrows: Up=Preu, Down=Hext, Left/Right=Scroll, Pglp Home, End First Line

6-14
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Accounts Payable—7.50 Inquiries

‘\'I]1—S|:|et:ially Distributors. Inc.. AP Yendor Inquiry - Yendor # Order [APIG10)
Options  Wiew SortBy Ewxpott Print Help

GoTo | | Starts with [ A= |!|

Vendor endar Mame City, State Alpha =]
U188 General Industrial Mfg....... + Atlanta, GA GEHERAL

U181 Industrial Supply Distributors Atlanta, GA IHDUSTRI
U182 S.E. Industrial Prod. & Equip. Atlanta, GA S.E. IHD |
L3
ﬂ General Ledgercards Open Docs Paid Docs Fayrnent Hist I Motes u

Category Suhbject

01/14/2003 General Information MUST PLACE CRDE
0100272003 General Infarmatian b TEST

Start From IDate = | Ll ll I_|

O LineDetail | 0 Emt |

|Enter characters vendor # must start with

v
"\ ¥endor Inquiry [APIE10) M=l E3
Help
81-Specialty Distributors, InAP Uendor Inquiry - Uendor # Order APIG16
Uendor Uendor Mame City, State Alpha Cont
U188 General Industrial Hfg GENERAL IH Roge
U181 Industrial Supply Distributors Atlanta, GA INDUSTRIAL Jon
U182 S.E. Industrial Prod. & Equip. Atlanta, GA S$.E. INDUS Jerr
Go To Starts With Filters Off
Sync OFf
< Open Docs Paid Docs Payment Hist
Date Created Category Urgent Subject
81/14/2883 General Information HUST PLACE ORDERS OH WEEKDAYS BEFORE

81/82/20083 General Information ¥ TEST

FiB-Menu; F2-0rder: Alpha, Contact, Uendor # (Vendor # Search)
Enter beqginning vendor #, F1-Edit filters, F3-Uiew, F4-End ..........
Arrows: Up=Prev, Down=Hext, Left/Right=VUiew, PgUp, PgDn, Home, End
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™\ 01-7.4 Development, AP Vendor Inquiry - Alpha Order (AP1610) M= E3

2| ¥|
|

ATLAHNTA CR U113 Atlanta Crane & Hoists Doraville, GA
ATLAHNTA GA U111 Atlanta Gas Company Atlanta, GA
D" AMCONIA U117 D'Anconia Copper and Electric Stone HMountain

™\ Vendor Inquiry (API1610)
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Accounts Payable—7.50 Inquiries

How to view vendor information

1.

2.

Access this program by choosing Accounts Payable->Inquiries=>Vendor Inquiry.
Enter the vendor code for which you want to view information.

Select whether to sort vendor records by vendor number, alpha lookup or contact. In GUI mode,
select a sort order by choosing Sort by from the menu bar.

Select filters if you want to limit the number of records in the inquiry browser. In GUI, choose
Options—>Filter Values. Use the up and down arrow keys or the Page Up and Page Down keys
through the list of displayed vendors. (You can also use the vertical scroll bar.)

Choose a view from the View menu option or select a view from the view bar.
View descriptions

General Displays general information including phone number(s), contact(s), message, vendor
status, our customer number, our tax exempt number, normal document group, 1099 1D,
ship-from, store past PO’s flag and use ledgercards flag.

Codes Displays code information including vendor class, terms code, freight code and general
ledger posting table.

Contacts Display phone numbers, contacts, email addresses, customer company website,
and any message entered about the customer (on the Customer F/M Invoicing screen).

ActivityDisplays vendor activity information including month-to-date, year-to-date and prior
year figures for invoices, payments, discounts taken and allowable discount. Also
included are the account opening date, last invoice date, last payment date, highest
balance date, highest balance amount and 1099 balance.

Open Documents Displays open documents, from oldest to newest, for the selected
vendor. Summary information includes document number, document type (Invoice,
Noninvoice), purchase order number, register number, entry period, date entered, date
due, original amount and current amount.

Getting more information on an open document: n the view area, select the line and choose the
Line Detail button or double click the icon at the beginning of that line.

Detail information displays summary plus the memo, original and current discount amounts and
any transactions against the open documents. Transaction information includes
sequence number, transaction date, entry period, register number, payment and discount
amounts and memo.

Paid Documents Displays, for the vendor selected, paid documents that have been
removed from the open documents file by the Document Removal Register. Information
includes document number, original amount and discount, entry period and register
number, document removal register number, last check number and purchase order
number.

Copyright © 1984-2005 Infor, inc. 6-17



Inquiries

4.

6-18

Accounts Payable—7.50

Getting more information on a paid document: In the view area, select the line and choose the
Line Detail button or double click the icon at the beginning of that line.

Detailed transaction information includes sequence number, transaction date and period, register
number, payment amount, discount amount and a memo. Memo information displays
check type (Manual, Regular) and check number.

Payment History Displays the total of all payments made to the vendor for the next
period, current period and the 26-prior periods.

Ledgercards  Displays all ledgercard information for the selected vendor. The inquiry lists
ledgercards from newest to oldest by default. To view oldest to newest: Click on the
Date column header. (You can also click on any other column header to resort
ledgercards.)

In either order, select the beginning date to view. Information includes date, debit amount, credit
amount, balance, transaction register name, document and register number.

Notes Displays notes for the specified vendor. In the browser in the lower portion of the screen
the system displays the date the note was created, note category, urgent note indicator,
and subject. You can double click a note line in the browser to display the View Note
screen, which lists the note subject and text, note type, category, date created, and date
edited.

You can access the Notes Entry (SME710) program from the Options=>1 Vendor Note
Entry to enter or modify notes for the specified vendor.

User-Defined The data that appears on the User-Defined view of Vendor Inquiry comes from
the User-Defined view of Vendor F/M (APF910). Many users have a few pieces of
information about customers, vendors, and items that are unique to their business that
they would like to enter into FACTS for reference purposes. The User-Defined view
displays user-defined fields entered the major file maintenances and makes them
available in FACTS Inquiry programs for information only. There are 5 user-defined
fields that can be entered on the User-Defined screen of Vendor F/M (APF910). There
user-defined field must first be configured by a user that has administrator privileges for
User-defined Fields setting on the Security tab of User Code F/M (SMF410).

When you are finished reviewing information for vendors, select the F4 or the Done button to
close the Vendor Inquiry program.

Copyright © 1984-2005 Infor, Inc.
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CHAPTER 7

DISTRIBUTION SOLUTIONS

Reports & Prints

Most Accounts Payable reports have the option of printing in vendor number,
alphabetical or vendor class order. In addition to the order, the user may
choose the range to be printed. For example, if the order selected is vendor
number, input of the beginning/ending vendor is required.

1. The Cash Requirements Report prints up to six time periods of cash
requirements for invoice payment. The periods of time are
determined by the user as well as whether the documents are to print
based on due date or discount date. The report may be printed in
summary (total amount due to each vendor within the specified time
periods) or detail (information on each document due to each vendor
within the specified time periods).

2. The Open Payables Report prints a list of open payables, zero balance
documents or both. The options are to print in summary (vendors and
their balances), detail (vendors and information on each document
due) or detail with transactions (vendors, and all transactions against
each document).

3. The Aged Payables Report prints a report of open payables in aging
columns as of a specified aging date. The user may also specify how
many days past due an invoice must be before appearing on the report
and whether to include contact information and purchase information.
The report may be printed in summary (vendor and balance) or detail
(vendor and information on each invoice due to the vendor).

4. The Inactive Vendor Listing prints a list of all vendors who have been
inactive as of a specified cutoff. Purchase history figures may be
included in the report. This report will not update any files but may
be useful in allowing the user to delete inactive vendors.

5. The Vendor Listing prints a report of either general or historical
information on vendors. The vendor’s address, phone number,
and/or contact may print on either report.

6. The Vendor Ledgercards Report prints a list of the transaction types
chosen that have affected the vendor’s balance.

7. The Vendor Label Print program prints up to 99 labels per vendor and
may be sorted by zip code.

8. The Rolodex Vendor Card Print program prints up to 99 rolodex cards
per vendor and may be sorted alphabetically.

Copyright © 1984-2005 Infor, Inc 7-1



Reports & Prints

7-2

9.

10.

11.

12.

13.

The Purchase History Report prints various purchase history
information from the vendor’s history. The user may select month-to-
date, year-to-date or prior year information and determine the
minimum purchases to print. The user has the option to select specific
document groups to print.

The Payment History Report prints total payments made to vendors
for up to 6 periods.

The 1099 Print prints the non-employee compensation statements. The
user chooses the beginning and ending vendor and the document
group(s) to print. The forms used are the standard 1099 forms
distributed by the IRS.

The Vendor Balancing Register is run only when the vendor’s balance
does not agree with the invoices for that vendor (i.e., very unlikely - if
there is a power failure in the middle of an update, etc.). The register
prints all out-of-balance vendors. The optional update will correct
each vendor balance and the total AP balance.

.The AP Code List prints a listing of the various AP codes: vendor
classes, terms codes and GL posting tables.

Accounts Payable—7.50
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Accounts Payable—7.50 Reports & Prints

’7 ™\ FACTS 7.5 Distribution Software - Accounts Pavable (APS000)

(INII:IQ)

(ILWITEC) FACTS 7.5 Development - Campany 01 02/02/05 - 1:39 pm

ha |

Accounts Payable Reports & Prints Tasks:

. B 4

[ equirenient:

Zpen Payahles Report
Aged Payables Repont
Inactive Yendor LISting

Yendor Listing

Vendor Ledgernards
cerroend G Fayment & Hald . e Wendor Label Print
" Bt Selection Shedks " Rolodex Vendor Card Print

Furchase History Repart
Payment History Report

1099 Print
Wendaor Balancing Register
& AP Code List
Ly
4
Reports & Fiints End of Period File Maintenances
@ Accecss Code M
™, Company 01, FACTS 7.5 Development !EE
Help
B1-FACTS 7.5 Developme APS7 88

Selection |

ENTER SELECTION #, ACCESS CODE, "OFF', ARROWS, F4-PREUIOUS MENU
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Reports & Prints

Cash Requirements Report (APR710)

Function

This program allows the user to obtain a report showing cash requirements for
invoice payments for specified time periods.

The user has the option to:

e Select the order to print - vendor, alpha, or vendor class.

o Select the beginning and ending order choice.

e Select the branch(es) to print.

e Select the document group(s) to print.

e Select due date or discount due date as the date to determine in which
time period the document falls.

e Determine if documents on hold will print.

e Select a detail or summary version of the report.

e Select the status to print: active, inactive or all.

e Print up to six time groupings.

e Select up to 99 days to be used for automatic date increments.

e Select the dates for the time groupings.

If the report is printed based on discount due date, the report will deduct the
allowable discount from the invoice.

Report information includes the following;:

e Summary: The total amount due to each vendor within the specified
time periods and the total balance for the vendor.

e Detail: For each vendor, all open documents that are due within the
time periods specified. Each document number, due date , discount due
date, amount and allowable discount are printed.

Totals are included for each vendor and time period. Report totals are also
included for each time period and all vendors listed. The total number of
vendors listed is also included.

User Inputs

7-4

The following inputs are involved in printing the Cash Requirements Report:
1. Order
Select the order the report is to print (ref. 4).

2. Beginning Order Choice

Select the beginning order choice to print (ref. 5). Press F2 to search or the #h
icon.
3. Ending Order Choice

Select the ending order choice to print (ref. 6). Press F2 to search or the #4
button.

Accounts Payable—7.50

Copyright © 1984-2005 Infor, Inc.



Accounts Payable—7.50 Reports & Prints

4. Branch

Enter the branch. The entry must be a valid branch. CR defaults to the branch
assigned to the terminal. F3 defaults to ALL. Press F2 to search or the # icon.

5. Document Group

Enter up to ten 2-character document groups side by side to print. CR defaults
to ALL.

6. Due/Discount

Enter whether documents should be grouped based on DUe date or DIscount
date. CR defaults to DU.

7. Holds

Enter Y or N to indicate whether to include documents on hold. CR defaults to
Y.

8. Scope

Enter whether to print the report in Summary or Detail form. CR defaults to S.
9. Status
Enter whether to print Active, Inactive or CR for all vendors. CR defaults to

ALL.
10. Groupings

Enter the number of date groupings to print (2 to 6). CR defaults to 6.

11. Auto Increment

Enter the number of days to be used for automatic date increments (0-99). CR
defaults to the value stored in the AP static control record. Entry of 0 indicates
the user will manually type in all ending dates of time groupings. Most
common values are 14 or 30 days.

12. Dates

Enter the ending date for the first date grouping (ref. 2). If automatic
increments are to be used, the next groups calculate automatically. If automatic
increments are not used, enter each group ending date up to the number of
groups selected. CR defaults to the system date.

Technical Notes

Printing of the Cash Requirements Report proceeds by reading through the
selected file - vendor (APVEND), alpha (APVALX) or vendor class (APCLSX).
The open documents file (APOPEN) is then checked for any documents that
meet all criteria entered. The document amount is placed in the correct time
grouping based on due date or discount date as chosen by the user.

FILES USED - SMCNTL, APVEND, APVALX, APCLSX, APOPEN, APHOLD
FILES UPDATED - NONE
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Open Payables Report (APR720)

Function
This program allows the user to:

e Obtain a list of open payables, zero balance documents or both.
e Review all transactions made against each document.
e View the company accounts payable balance.

The user has the option to:

e Select the order to print - vendor, alpha or vendor class.

e Select beginning and ending order choice.

e Select the branch(es) to print.

o Select the document group(s )to print.

e Select open documents, zero balance documents or both to print.
e Print next period documents and transactions.

e  Select the status to print - active, inactive or all.

e Select summary, detail or detail with transactions print format.

Report information includes the following;:

e Summary: Vendor number, name and balance.

e Detail: Vendor number, name, document number, document group,
entry period, entry date, original amount and discount, transaction total
amount and current document balance.

e Detail with transactions: Detail plus the transaction date, register
number, type, amount and discount in addition to most of the previous
detail information.

Totals are included for each vendor. Report totals include the total of all
vendors. The total number of vendors listed is also included.

User Inputs

The following inputs are involved in printing the Open Payables Report:
1. Order

Select the order the report is to print (ref. 4).
2. Beginning Order Choice

Select the beginning order choice to print (ref. 5). Press F2 to search or the #h
icon.

3. Ending Order Choice

Select the ending order choice to print (ref. 6). Press F2 to search or the # icon.

Copyright © 1984-2005 Infor, Inc 7-7



Reports & Prints

4. Branch

Enter the branch to print. The entry must be a valid branch. CR defaults to the
branch assigned to the terminal. F3 defaults to ALL. Press F2 to search or the
icon.

5. Document Groups

Enter up to ten 2-character document groups side by side to print. CR defaults
to ALL.

6. Balance

Enter whether the report should include All documents, Open documents, or
Zero balance documents. CR defaults to ALL.

7. Next Period

Enter Y or N to indicate whether documents and transactions posted to the next
AP period should be included. CR defaults to Y.

8. Status

Enter whether to print Active, Inactive or CR for all vendors. CR defaults to
ALL.

9. Scope

Enter whether the report is to print Summary, Detail, or detail with
Transactions information. CR defaults to S.

Technical Notes

Printing of the open payables report proceeds by reading through the chosen
file - vendor (APVEND), alpha (APVALX) or vendor class (APCLSX). The
open documents file (APOPEN) is then checked for documents that meet all
criteria entered. If transactions are included, the invoice transactions file
(APTRAN) is checked.

FILES USED - SMCNTL, APVEND, APVALX, APCLSX, APOPEN, APTRAN
FILES UPDATED - NONE

Accounts Payable—7.50
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Aged Payables Report (APR730)

Function

This program allows the user to obtain a printout of open payables grouped
into aging columns. It may also be used to print only past due amounts.

The user has the option to:

e Select the order to print - vendor, alpha or vendor class.
e Select beginning and ending order choice.

e Select the branch(es) to print.

e Select the document group(s) to print.

e Enter the aging date.

e  Select up to 999 days past due to print.

e Print next period’s information.

e Print vendor phone numbers and contacts.

e Print year-to-date and prior year figures.

e Print in summary or detail format.

The headings of the aging columns are determined by the company AP static
control record.

Report information includes the following;:

e Summary: Vendor number, name, date of last payment, balance,
current amount and the total amount in each aging column.

e Detail: Vendor number, name and date of last payment. Then
information regarding each open document for the vendor is printed
including document number, entry date, due date and the invoice
amount. Phone numbers, contacts and historical data may be included
on either the summary or detail formats.

Report totals are included for each time period and total vendors listed. The
total number of vendors listed is also included.

FACTS Report Formatter and Multiple Output Options

This report has access to the FACTS Report Formatter and Multiple Output
options. The Multiple Output option allows you to print to more than one
output for each instance of a report. For example, a report can print to Excel,
the viewer, and to a printer all in one print run. To access the multiple output
feature simply choose the Multiple option from the Print Options screen. The
FACTS Report Formatter allows users to expand reporting capabilities beyond
defining a printer (in Printer F/M). To access the FACTS Report Formatter,
select Custom Report Layout-> Customize Report from the menu bar.

GUI/CUI Users: The FACTS Report Formatter is only available in Graphical
mode. However, Character system users can access the Multiple Output option
and custom templates and outputs that have been created by graphical users.
However, if the template specifies an output that a character user cannot access,
like Excel, the report will not run properly.
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User Inputs

The following inputs are involved in printing the Aged Payables Report:
1. Order

Select the order the report is to print (ref. 4).
2. Beginning Order Choice

Enter the beginning order choice to print (ref. 5). Press F2 to search or the #
icon.

3. Ending Order Choice

Enter the ending order choice to print (ref. 6). Press F2 to search or the ## icon.

4. Branch

Enter branch number to print. The entry must be a valid branch. CR defaults
to the branch assigned to the terminal. F3 defaults to ALL. Press F2 to search or
the # icon.

5. Document Groups

Enter up to ten 2-character document groups side by side to print. CR defaults
to ALL.

6. Aging Date

Enter the aging date to be used in determining which column an invoice
belongs to (ref. 2). CR defaults to the system date.

7. Days Past Due

Enter the number of days past due an invoice must be to appear on this report
(0-999). CR defaults to no cutoff (NONE), in which case all documents,
including current invoices, will print.

8. Next Period

Enter Y or N to indicate whether documents and transactions posted to the next
AP period should be included. CR defaults to Y.

9. Contact Information

Enter N or Y to indicate whether to print the vendor’s phone number and
contact. This information may be useful in making calls about invoices or
payments. CR defaults to N.

10. Purchase Information

Enter N or Y to indicate whether to print year-to-date and prior year invoice
totals for each vendor. CR defaults to N.

11. Scope

Enter whether the report is to print Summary or Detail information. CR
defaults to S.
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Technical Notes

Printing of the Aged Payables Report proceeds by reading through the chosen
file - vendor (APVEND), alpha (APVALX) or vendor class (APCLSX). The
open documents file (APOPEN) is then checked for documents that meet all
criteria entered. If the next period’s information is not included, the invoice
transactions file (APTRAN) is referenced to back out any payments posted to
the next period.

FILES USED - SMCNTL, APVEND, APVALX, APCLSX, APOPEN, APTRAN
FILES UPDATED - NONE

;% Aged Payables Report [(APR730) M= B3
Template  Print Options
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Template Printer
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Help
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Aging Date System Date

Days Past Due Ho Cutoff

Hext Feriod

Contact Info Purchase Info

Scope Summary

— Template — Printer
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Inactive Vendor Listing (APR740)

Function

This program allows the user to obtain a list of vendors with no activity since a
specified date or who have had activity less than a specified dollar amount.
This program may be used to list vendors who may need to be removed from
the vendor file.

The user has the option to:

e Select the order to print - vendor, alpha or vendor class.
e Select the beginning and ending order choice.

e Select the document group(s) to print.

e Base activity on last payment date or dollar volume.

o Select either a cutoff date or cutoff dollar amount.

e Print year-to-date and prior year purchase history.

Report information includes the following: vendor number and name, vendor
class, document group, last purchase date, last payment date, date opened, date
and amount of highest balance and current vendor balance. This information
may also include year-to-date and prior year purchase history. The total
number of vendors listed is also included.

User Inputs

The following inputs are involved in printing the Inactive Vendor Listing:
1. Order

Select the order the report is to print (ref. 4).
2. Beginning Order Choice

Enter the beginning order choice to print (ref. 5). Press F2 to search or the #
icon.

3. Ending Order Choice

Enter the ending order choice to print (ref. 6). Press F2 to search or the # icon.

4. Document Groups

Enter up to ten 2-character document groups side by side to print. CR defaults
to ALL.

5. Cutoff Basis

Enter whether to base inactivity on last payment Date or dollar Volume. CR
defaults to D.

6. Cutoff

If cutoff is to be based on last payment date (if D was entered in input #5), enter
the date (ref. 2). Vendors with last payment dates after the chosen date will be
excluded from this report. CR defaults to the system date. If cutoff date is to be
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based on volume (if V was entered in input #5), enter the year-to-date purchase
volume (+/-9999999.99). CR defaults to the system date.

7. Purchase History

Enter N or Y to indicate whether to print year-to-date and prior year purchase

history. CR defaults to N.

Technical Notes

Printing proceeds by reading through the chosen file - vendor (APVEND),

alpha (APVALX) or vendor class (APCLSX). The vendor file is then checked
for vendors that meet the entered criteria.

FILES USED - SMCNTL, APVEND, APVALX, APCLSX

FILES UPDATED - NONE

;¥ Inactive Yendor Listing [APR740)

Template  Print Options
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Vendor Listing (APR750)

Function

This program allows the user to print out vendor information.

The user has the option to:

e Select the order to print - vendor, alpha or vendor class.

e Select the beginning and ending order choice.

e Select the code range to print - terms code, GL posting table, document
group or no code range.

e Select the beginning and ending code range to print.

e Print either general or historical information.

e Include address, phone and/or contact information.

e Select whether to print active, inactive or all vendors.

e  Skip up to nine lines between vendors.

Report information includes the following: vendor number, name, alphabetical
sort key, vendor class, terms codes, document group and GL posting table.
Also indicated is whether the vendor is on hold, if it is a permanent or
temporary vendor, customer number and tax exempt number. Historical
information includes: vendor number, name, balance, date of last invoice, date
of last payment, date account opened, date of highest balance, highest balance
amount and whether the vendor is on hold.

The vendor address, phone number, and/or contact may also print on either
report. The total number of vendors listed is also included.

FACTS Report Formatter and Multiple Output Options

This report has access to the FACTS Report Formatter and Multiple Output
options. The Multiple Output option allows you to print to more than one
output for each instance of a report. For example, a report can print to Excel,
the viewer, and to a printer all in one print run. To access the multiple output
feature simply choose the Multiple option from the Print Options screen. The
FACTS Report Formatter allows users to expand reporting capabilities beyond
defining a printer (in Printer F/M). To access the FACTS Report Formatter,
select Custom Report Layout-> Customize Report from the menu bar.

GUI/CUI Users: The FACTS Report Formatter is only available in Graphical
mode. However, Character system users can access the Multiple Output option
and custom templates and outputs that have been created by graphical users.
However, if the template specifies an output that a character user cannot access,
like Excel, the report will not run properly.

User Inputs

The following inputs are involved in printing the Vendor Listing;:
1. Order

Select the order the report is to print (ref. 4).
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2. Beginning Order Choice

Select the beginning order choice to print (ref. 5). Press F2 to search or the #h
icon.

3. Ending Order Choice

Select the ending order choice to print (ref. 6). Press F2 to search or the # icon.

4. Code Range

The list may be printed for a specific range of terms codes, GL posting tables or
document groups. Only vendors with the chosen codes will print. Enter Terms
code, GL posting table, or Document group to determine which codes will
print. If no code range is desired, press CR to skip this and inputs #5-6.

5. Beginning Code Range

If a code was chosen in input #4, enter the beginning code range to print. For
example, if terms code was chosen above, enter the beginning terms code to
print. CR defaults to FIRST.

6. Ending Code Range

If a code was chosen in input #4, enter the ending code range to print. For
example, if terms code was chosen above, enter the ending terms code to print.
CR defaults to LAST.

7. Info (General Or History)

Enter General or Historical to indicate the type of information to print. CR
defaults to G.

8. Include (Information To Include)

Enter any combination of A-vendor address, P-phone number and/or C-
contact to print on the report. CR defaults to NONE.

9. Status

Enter whether to print Active, Inactive or CR for all vendors. CR defaults to
ALL.

10. Lines To Skip

Enter the number of lines to skip between vendors (0-9). CR defaults to 0.

Technical Notes

Printing proceeds by reading through the chosen file - vendor (APVEND),
alpha (APVALX) or vendor class (APCLSX). The vendor file is then checked
for vendors meeting criteria entered.

FILES USED - SMCNTL, APVEND, APVALX, APCLSX
FILES UPDATED - NONE
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Vendor Ledgercards (APR755)

Function

This program allows the user to obtain a printout of ledgercards and related
information stored in the ledgercard file. Vendor Ledgercards provide a
detailed history of every transaction for each vendor. The Ledgercard File is
optional. History is stored if the Use Ledgercards flag is set to Y in the Vendor
File.

The user has the option to:

e Select the order to print - vendor, alpha or vendor class.
e Select the beginning and ending order choice.

o Select the date range to print.

e Select the transaction type to print.

Report information includes the following: vendor number and name,
transaction date and type, debit and credit amount, document number and
register number. This report also includes ending balance and total number of
vendors listed.

User Inputs

The following inputs are involved in printing the Vendor Ledgercards:
1. Order

Select the order the report is to print (ref. 4).
2. Beginning Order Choice

Select the beginning order choice to print (ref. 5). Press F2 to search or the #h
icon.

3. Ending Order Choice
Select the ending order choice to print (ref. 6). Press F2 to search or the # icon.

4. Date Order

Enter date order in which to print: Newest date to oldest date or Oldest date to
newest date. CR defaults to N.

5. Beginning Date

Enter the beginning date to print (ref. 2). CR defaults to FIRST.
6. Ending Date

Enter the ending date to print (ref. 2). CR defaults to LAST.
7. Type

Enter whether to print Beginning balance, document Entry, Check register
and/or Vendor balance transaction types. CR defaults to ALL.
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Technical Notes

Printing proceeds by reading through the chosen file - vendor (APVEND),
alpha (APVALX) or vendor class (APCLSX). The ledgercard file (APLEDG) is
then checked for records which meet the criteria entered.

FILES USED - SMCNTL, APLEDG, APVEND, APVALX, APCLSX
FILES UPDATED - NONE

L;2 Yendor Ledgercards [APR755) =
Template  Print Options

Order

W - wendaor QOrder

Beginning 4] ¢ | First
Ending Mm Last
Froperies

Date Order |N - Mewest to Oldest j
Beginning Date

Ending Date

Transaction

B=Beginning Balance, E=0ac Entry Register, C=Check Register, ¥=Vendar Balancing

Twpe  |ALL

Template Printer

Mone Genicom Line Printer Cancel

Select Print Order

Ok

L;2 Win with ProvideX [_ O]
Help

81-Demo Company Uendor Ledgercards APR755
Order U Uendor Order Beginning First

Ending Last

— Properties
Date Order H Hewest to 0Oldest

Beginning Date

Ending Date

— Transaction
B=Beginning Balance, E=Doc Entry Register, C=Check Register, U=Uendor Balancing
Type ALL

— Template — Printer
Hone Genicom Line Printer

CR-Run Report, F1-Template, F2-Printer, F3-Change Answers, F4-Exit .

Copyright © 1984-2005 Infor, Inc

Reports & Prints



Reports & Prints Accounts Payable—7.50

Vendor Label Print (APP710)

Function

This program allows you to print labels from the information stored in the
vendor file.

The user has the option to:

e Select the order to print - vendor, alpha or vendor class.

o Select the beginning and ending order choice.

e  Print the labels in zip code order.

e Select whether to print vendor number, contact #1, or contact #2.
e  Select the number of labels to print for each vendor.

e Print an alignment check.

Label information includes the following: vendor name, address, city, state, zip
code and either contacts #1 or #2, or the vendor number. The program prints
on 11-1/2 x 15 inch paper and prints (4) labels across (see forms information in
the installation manual).

To print an alignment (or test page) in graphical mode, select Print Options
>Alignment from the menu bar. In character mode, enter A at the selection
prompt and press return.

User Inputs

The following inputs are involved in printing the vendor labels:
1. Order
Select the order the labels are to print (ref. 4).
2. Beginning Order Choice

Select the beginning order choice to print (ref. 5). Press F2 to search or the #4
icon.

3. Ending Order Choice

Select the ending order choice to print (ref. 6). Press F2 to search or the # icon.

4. Zip Code Sort

Enter N or Y to indicate whether to sort the vendors by zip code. CR defaults to
N.

5. Vendor #/Contact

Enter whether to print on all labels contact #1, contact #2 or #-vendor number.
CR defaults to NONE.

6. Number Of Labels

Enter the number of labels to print per vendor (1-99). CR defaults to 1.
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Technical Notes

Printing proceeds by reading through the chosen file - vendor (APVEND),
alpha (APVALX) or vendor class (APCLSX). The vendor file is then checked
for the information needed to print labels. If sorted by zip code, the program
creates a temporary sort file (SMSRT?) which sorts the zip codes into the correct
order.

FILES USED - SMCNTL, APVEND, APVALX, APCLSX
FILES UPDATED - SMSRT?
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Rolodex Vendor Card Print (APP720)

Function

This program allows the user to print vendor rolodex cards from the
information stored in the vendor file.

The user has the option to:

e Select the order to print - vendor, alpha or vendor class.
o Select the beginning and ending order choice.

e Select to print alpha (if print order other than alpha).

e Select number of cards to print for each vendor.

e Select to print active, inactive or all vendors.

e Print an alignment check.

Rolodex card information includes the following: vendor number, name,
address, phone number, contact #1 and #2 and vendor class code. For
information on the size of the forms, please see the forms section in the
installation manual.

To print an alignment (or test page) in graphical mode, select Print Options
>Alignment from the menu bar. In character mode, enter A at the selection
prompt and press return.

User Inputs

The following inputs are involved in printing the Rolodex vendor cards:
1. Order

Select the order the cards are to print (ref. 4).
2. Beginning Order Choice

Enter the beginning order choice to print (ref. 5). Press F2 to search or the #
icon.

3. Ending Order Choice

Enter the ending order choice to print (ref. 6). Press F2 to search or the # icon.

4. Alpha Sort

If the order choice was vendor or vendor class order, enter N or Y to indicate
whether to sort vendors alphabetically within the print order. If the order
choice in input #1 was alpha, this input is skipped. CR defaults to N.

5. # of Cards

Enter the number of cards to print for each customer (1 to 99). CR defaults to 1.

6. Status

Enter whether to print Active, Inactive or CR-all vendors. CR defaults to ALL.
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Technical Notes

Printing proceeds by reading through the chosen file - vendor (APVEND),
alpha (APVALX) or vendor class (APCLSX). The vendor file is then checked
for the information needed to print Rolodex cards. If the order choice was not
alphabetical and vendors are to be sorted alphabetically within the order
choice, then the program creates a temporary sort file (SMSRT?) which sorts the
vendors into the correct order.

FILES USED - SMCNTL, APVEND, APVALX, APCLSX
FILES UPDATED - SMSRT
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| Select Print Order

L Rolodex Yendor Card Print [APP720) [_[O] x|
Help

81-Demo Company Rolodex Uendor Card Print nPrP7zH
Order U Uendor Beginning First

Ending Last

— Properties
Alpha Sort H

# of Cards 1

Status All
— Template — Printer

Hone Print to file
Alignment

CR-Run Report, F1-Template, F2-Printer, F3-Change Answers, F4-Exit |.
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Purchase History Report (APR760)

Function

This program allows the user to obtain a Purchase History Report for all
vendors.

The user has the option to:

Select the order to print - vendor, alpha or vendor class.
Select the beginning and ending order choice.

Select the document group(s) to print.

Select the comparison and cutoff.

Report information includes the following: vendor number, vendor name, date
opened, last purchase date. The year-to-date and prior year information
include purchases, payments and discounts. Report totals are also included for
year-to-date and prior year and the total number of vendors listed.

User Inputs

The following inputs are involved in printing the Purchase History Report:
1. Order

Select the order the report is to print (ref. 4).
2. Beginning Order Choice

Select the beginning order choice to print (ref. 5).

3. Ending Order Choice

Select the ending order choice to print (ref. 6)

4. Document Groups

Enter up to ten 2-character document groups side by side to print. CR defaults
to ALL.

5. Cutoff

Enter whether there is No cutoff or to exclude vendors Above or Below cutoff.
CR defaults to N and skips to input #8.

6. Figures

If N was entered in input #5, this input is skipped. Enter whether to use the
Month-to-date, Year-to-date or Prior year for the cutoff. CR defaults to M.

7. Amount

If N was entered in input #5, this input is skipped. Enter the (MTD, YTD or
PYR as chosen in input #6) amount below or above (as chosen in input #5)
which vendors will not print. For example, if B was selected for cutoff and M
was selected for figures, enter the MTD purchases below which vendors will

7-24 Copyright © 1984-2005 Infor, Inc.



Accounts Payable—7.50

not print; i.e., if 100 is entered, no vendors with a MTD purchase figure of
below 100 will print on the report.

Technical Notes

Printing proceeds by reading through the chosen file - vendor (APVEND),
alpha (APVALX) or vendor class (APCLSX). The vendor file is then checked
for the vendors with purchase history that meet all criteria entered.

FILES USED - SMCNTL, APVEND, APVALX, APCLSX
FILES UPDATED - NONE

i Purchase History Report [APR7E0) M= E3

Template  Print Options

(oI iendor Order Beginning | 4] ¢ | First
Ending I ﬂﬂl

Properies
Document Groups ﬂd Al

Cutaff | - Mo Cutoff 'I

Figures  [u- MTD for Cutoff =]
Arnount 0

ok |
Template Printer

Mane Genicom Line Printer Cancel |

| Select Print Order

™\ Purchase History Report (APR760) HEE
Help

B1-FACTS 7.5 Development Purchase History Report APR76 8
Order ! Uendor Beginning First

Ending Last

— Properties
Document Groups All

Cutoff No Cutoff
Figures |1 MTD

Amount

— Template — Printer
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Payment History Report (APR770)

Function

This program allows the user to obtain a Payment History Report for all
vendors.

The user has the option to:

e Select the order to print - vendor, alpha or vendor class.

o Select the beginning and ending order choice.

e Select ending period and up to five periods prior to the ending period to
print.

e Determine a cutoff.

Report information includes the following: vendor number, vendor name,
payments made for each period included on the report, report totals and total
number of vendors listed. If the selected order to print is by class, then class
totals are also included.

User Inputs

The following inputs are involved in printing the Payment History Report:
1. Order
Select the order the report is to print (ref. 4).
2. Beginning Order Choice
Select the beginning order choice to print (ref. 5).
3. Ending Order Choice
Select the ending order choice to print (ref. 6).
4. Ending Period

Enter the ending period to print (PPYY). CR defaults to CURRENT. F2
defaults to LAST.

5. Number Of Periods

Enter the number of periods to print which includes the ending period (1-6).
CR defaults to 1.

6. Cutoff

Enter the total minimum payment to print for each vendor (+/- 99999999.99).
CR defaults to NONE.

Technical Notes

Printing proceeds by reading through the chosen file - vendor (APVEND),
alpha (APVALX) or vendor class (APCLSX). The payment history file
(APHIST) is then checked for the vendors that meet all criteria entered.
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FILES USED - SMCNTL, APVEND, APVALX, APCLSX, APHIST
FILES UPDATED - NONE

;2 Payment History Report [(APR770) M= E3
Template  Print Options

(oI, ~/endor Order Beainning | 4] # | First
Ending I Mﬂl Last
Properties

Ending Period  [091897 4| M| current Period 09/1997 Ending 091301997

#of Periods 4 |

Cutoff QI None

: ok |
Template Printer
Mone Genicom Line Printer Cancel I

| Frintin wendar, Alpha, or vendor Class Crder? (G

L# Payment History Report (APR770]) [_ (O] x|
Help
81-Demo Company Payment History Report APR77H
Order U Uendor Beginning First

Ending Last
— Properties

Ending Period 09/2002 Current Period 9972002 Ending ©9/38/2082

# of Periods 1

Cutoff Hone
— Template — Printer
Hone Print to file

CR-Run Report, F1-Template, F2-Printer, F3-Change Answers, FU4-Exit .
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1099 Print (APP730)

Function

This program allows the user to print non-employee compensation statements
(1099’s).

The user has the option to:

e Select the beginning and ending vendor to print.
e Select document group(s) to print.
e Enter Federal ID number.

Print information includes the following: company name, address and federal
ID number, vendor name, address, and 1099 balance. The amount comes from
the purchase history in the vendor file and the field used is 1099 balance.

The forms used are the standard 1099 forms put out by the IRS.

To print an alignment (or test page) in graphical mode, select Print Options
2Alignment from the menu bar. In character mode, enter A at the selection
prompt and press return.

User Inputs

The following inputs are involved in printing 1099 forms:
1. Beginning Vendor

Enter the beginning vendor number to print. CR defaults to FIRST.
2. Ending Vendor

Enter the ending vendor number to print. CR defaults to LAST.

3. Document Group

Enter up to ten 2-character document groups side by side to print. CR defaults
to ALL.

4. Federal ID

Enter the Federal Tax ID number (up to 10 characters).
5. Print When Less Than $600

Indicate whether to print 1099’s for vendors with a 1099 balance of less than
$600.00.

Technical Notes

Printing proceeds by reading through the vendor file (APVEND) and checking
for the information needed to print 1099'’s.

FILES USED - SMCNTL, APVEND
FILES UPDATED - NONE
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_-\ 01-FACTS 7.4 Maintenance, 1099 Print [APP730)]

[ vioo |l
R

&l

_-\ 1099 Print [APP730]
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Vendor Balancing Register (APR780)

Function

| NOTE: This register should be run by the System Administrator. |

This program allows the user to print a register of all vendors whose balance is
not equal to the total amount of their open documents. The optional update
will reset the vendor’s balance and the company AP balance.

This program is used only in the unlikely event (error condition, power failure)
of vendors becoming out of balance. If the report is updated, the printout
should be kept for future tracing of the AP balance. If an out of balance
condition is corrected by this register, a manual General Ledger journal entry
may be required.

Report information includes the following: the vendor number, name, new
balance (the calculated sum of open documents), current balance and the
difference. The report also includes the number of vendors.

User Inputs

The following inputs are involved in printing the Vendor Balancing Register:
1. Print Register

Select OK or enter Y to print register. Select CANCEL or enter N if you don’t
wish to print at this time.

2. Check register. OK to update?

Upon completion of printing the user should check the register to be sure it
printed satisfactorily. Select OK or enter Y to begin the update. Select
CANCAL or enter N to exit the program without updating.

Technical Notes

Printing proceeds by reading through the vendor file (APVEND) and checking
the vendor balance against the total amount of the corresponding open
documents in the open documents file (APOPEN). Any out-of-balance vendors
are printed along with the old and new company AP balance. The update
portion of the program resets the vendors” balances and the company AP
balance, writes a record to the register history control file and updates the
register trace number and the Vendor Balancing Register number.

FILES USED - APOPEN
FILES UPDATED - SMCNTL, APVEND, SMSRT?
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;2 Yendor Balancing Register [APR7E0)
Template  Print Options

s 3

This Program wWiill Print & Register of All Qut-OfBalance Yendars. The
Optional Update Will Reset Each Wendaor Balance Equal to the Total of
the Open Documents for that Yendor. 1tYWyill Also Reset the AP Balance
Enual to the Total of All Wendor Balances.

Template Printer

Mane Genicom Line Printer Cancel |

™, Yendor Balancing Register (APR780)
Help

81-FACTS 7.5 Development  Uendor Balancing Register

This Program Will Print a Register of All Out-0f-Balance Vendors. The
Optional Update Will Reset Each Uendor Balance Equal to the Total of
the Open Documents for that Vendor. It Will Also Reset the AP Balance
Equal to the Total of All Uendor Balances.

— Template — Printer

APR7848
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How to run the Vendor Balancing Register

1.  Access this program by choosing Account Payable->Reports & Print->Vendor Balancing
Register.

2. Select the OK button to print the report of all vendors whose balance is not equal to the total
amount of their open documents.

3. After printing the Vendor Balancing Register, verify the printout. If you need to reset the vendor
balance equal to the total open document balance for each vendor and set the AP balance equal
to the total of all vendor balances, select OK or enter YES to continue. Select Cancel or enter N to
exit the program without updating.
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AP Code List (APR790)

Function

This program allows the user to print a listing of each of the following
Accounts Payable codes:

e Vendor class
e Terms code
e GL posting table

Each code above is entered into its own F/M program and is used in the
vendor file.

Report information includes each code and the information stored with the
code. The total number of codes listed is also included.

User Inputs

The following inputs are involved in printing the AP Code List:
1. Select Number

Enter whether to print 1-vendor class, 2-terms code or 3-GL posting table
information.

2. Beginning Order Choice

Select the beginning order choice to print of the field selected. CR defaults to
FIRST.

3. Ending Order Choice

Select the ending order choice to print of the field selected. CR defaults to
LAST.

Technical Notes

Processing proceeds by reading through the control file for the codes that meet
all criteria entered.

FILES USED - SMCNTL, GLMSTR
FILES UPDATED - NONE
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L;% AP Code List [(APR790) M= 3
Template  Print Options

SR 1 - Vendor Class - |Beginning I Llﬂl First
Ending | M| #4] Last

ok |
Template Printer

Kone Genicorn Line Printer Cancel |

| Print in Wendar Class, Terms Code, ar GL Posting Takle? {15253}

|
"\ AP Code List (APR790) BEE
Help
B1-FACTS 7.5 Development AP Code List APR79d
Selection Beginning First
Ending Last
]
— Template — Printer
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CHAPTER 8

End of Period

The End-of-Period Menu contains programs that should be run at the end of
each accounts payable period to close it correctly.

The Period Check Register provides a listing grouped by each bank of all
regular, manual, noninvoice and void checks issued this period. The Period
Expense Distribution provides a list of all GL expense distributions from the
Document Entry & Adjustments Register for the period. The Period
Disbursement Distribution provides a list of all GL Disbursement Distributions
from the Check Register for the period. All of the registers listed contain
optional updates that should be run to clear the files to start a new period. The
Register History Report provides a list of all register updates which affected the
AP balance during the period. The Document Removal Register provides a
report of all documents paid to zero during the period and removes them from
the open documents file. The Vendor Ledgercard Removal program removes
ledgercard information by vendor number, alphabetically, or by vendor class.

The End-of-Period Update will close the current Accounts Payable period by
deleting temporary vendors with zero balances, rolling period-to-date figures
to zero and incrementing the current period by one. If it is the end of the year,
year-to-date figures are rolled to prior year.
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™ FACTS 7.5 Distribution Softwars - Accounts Pavable (APS000)

FACTS a~Tom

DISTRIBUTION 50FTWARE

CLAITEC) FACTS 7.5 Development - Company 01 020020056 - 1:39 prm

Accounts Payable End of Period Tasks:

Feriod Check Re r

Feriod Expense Distribution
Feriod Dishursament Dist
Fayment & Hold
Selection

Register History Repoit |
Document Removal Register
Wehdor Ledgercard Remaval

End-of-Feriod Update |

Ceeumant Entry Chasks Ingquiries

Reparts & Prints End of Period File Maintenances

‘ﬁj Aceess Code M

™\ Company 01, FACTS 7.5 Development !HE

Help

#1-FACTS 7.5 Developme APS8 B0
Selection

ENTER SELECTION #, ACCESS CODE, 'OFF', ARROWS, F4-PREVIOUS HENU
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Period Check Register (APR810)

Function

This program allows the user to obtain a listing, grouped by banks, of all
regular, manual, noninvoice and void checks for a period. Records on this
report are created during the update portion of the Check Register program if
the Use period check register flag in the company AP static control record is
setto Y.

The register should be printed at the end of the period as part of the monthly-
closing procedures. To prevent file overflow, the records should be removed
once a month after the register is run.

Report information includes the following: bank number and name, check
number, vendor number and name, check date, register number, discount
amount, check amount and type. (Types include void, noninvoice and blank
indicates a regular printed check.) Also included are totals for each bank, a
report total and the total number of checks listed for each bank.

User Inputs

The following inputs are involved in printing the Period Check Register:
1. Period
Enter the period to print (PPYY). CR defaults to the current AP period.
2. Beginning Bank
Enter the number of the beginning bank to print. CR defaults to FIRST.
3. Ending Bank
Enter the number of the ending bank to print. CR defaults to LAST.
4. Check register. Do you wish to remove records just printed?

Select OK or enter Y to remove records printed On the Period Check Register
select CANCEL or enter N to skip the update.

Technical Notes

Printing proceeds by reading through the period check register file (APCHKP).
Any records that meet the entered criteria will be printed in check order by
bank.

FILES USED - SMCNTL
FILES UPDATED - APCHKP
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Li? Period Check Reqister [(APRE10]

Y
[ s
Y

L2 Period Check Register [APRB10]
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How to run the Period Check Register

1.

2.

Access this program by choosing Account Payable--> End of Period-->Period Check Register.

In the Period field, enter the period for this check register print. Press F1 to default to the current

AP period. Select the M to display the previous period. The current period displays in the upper
left corner of the screen.

In the Beginning Bank field, enter the number of the beginning bank to print. Press F1 to default
to FIRST. Select the # to press F2 search for banks. Select the 4 to display the previous banks.

In the Ending Bank field, enter the number of the ending bank for the print range. Press F1 to
default to FIRST. Select the # to press F2 search for banks. Select the M to display the previous
banks.

Select the OK button to start the check register or the Cancel button to stop this process.
When the system displays the message: Check register. Do you wish to remove records just

printed?, select OK or enter YES to remove the records and update the system. Select Cancel or
enter N to skip the update.
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Period Expense Distribution (APR820)

Function

This program allows the user to obtain a list of all expense distributions from
the Document Entry & Adjustments Register for the period. Records on this
report are created during the update portion of the Document Entry &
Adjustments register if the Use period expense report flag in the company AP
static control record is set to Y.

The Period Expense Distribution should be printed as part of the end-of-period
procedures. To prevent file overflow, the records should be removed once a
month after the register is run.

Report information includes the following:

e Summary: The GL number, description, debit amount and credit
amount. Report totals are included along with the total number of
accounts listed.

e Detail: Summary plus vendor number and name, document number
and register number.

User Inputs

The following inputs are involved in printing the Period Expense Distribution:
1. Period
Enter the period to print (PPYY). CR defaults to the current AP period.
2. Beginning G/L #
Enter the beginning general ledger number to print. CR defaults to FIRST.
3. Ending G/L #
Enter the ending general ledger number to print. CR defaults to LAST.

4. Branch

Enter the branch to print. The entry must be a valid branch. CR defaults to
ALL.

5. Department

Enter the GL department to print. The entry must be a valid GL department.
CR defaults to ALL.

6. Scope

Enter whether to print Summary or Detail information. CR defaults to S.

7. Check report. OK to remove records just printed?

Select OK or enter Y to remove records and update the system. Select
CANCEL or enter N to skip the update.
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Technical Notes

Printing proceeds by reading through the period expense distribution file
(APDISE). The vendor file and general ledger account file (ending balances)
are referenced for names and descriptions. Any records that meet the entered
criteria will be printed in general ledger number order.

FILES USED - GLMSTR, APVEND, SMCNTL
FILES UPDATED - APDISE

;2 Expense Distribution [APR820)
Template  Print Options

CP=09/1957 SEF
Period || | current Period
Beginning GIL# [000-000 MM First
Ending GfL# [000-000 | Bl | | Last
Branch W Mﬂd Atlanta Branch

Department 1 4| Wholesale

Scope |5-Summary T

Template Frinter

Mane Genicom Line Printer Cancel

Enter Periad ta Print, F1-Current Period

Ok

® Expense Distribution [(APR820) [_ (O] =]
Help
81-Demo Company Expense Distribution nPR82d

CP=89/2082 SEP

Period Current Period
Beginning G/L# First
Ending G/L# Last
Branch Atlanta Branch
Department Wholesale

Scope

— Template — Printer
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Period Disbursement Distribution (APR830)

Function

This program allows the user to obtain a list of all General Ledger
Disbursement Distribution from Check Registers for the period. Records on
this register are created during the update portion of the Check Register if the
Use period disbursement report flag in the company AP static control record is
setto Y.

It is suggested this report be printed as part of the end-of-period procedures.
To prevent file overflow, the records should be removed once a month after the
register is run.

Report information includes the following:

e Summary: The GL number, description, debit amount and credit
amount. Report totals are included along with the total number of
accounts listed.

e Detail: Summary plus vendor number and name, check number and
register number.

User Inputs

The following inputs are involved in printing the Period Disbursement
Distribution:

1. Period
Enter the period to print (PPYY). CR defaults to the current AP period.
2. Beginning G/L #
Enter the beginning general ledger number to print. CR defaults to FIRST.
3. Ending G/L #
Enter the ending general ledger number to print. CR defaults to LAST.
4. Branch

Enter the branch to print. The entry must be a valid branch. CR defaults to
ALL.

5. Department

Enter the GL department to print. The entry must be a valid GL department.
CR defaults to ALL.

6. Scope

Enter whether to print Summary or Detail information. CR defaults to S.

7. Check report. OK to remove records just printed?

Select OK or enter Y to remove records and update the system. Select
CANCEL or enter N to skip the update.
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Technical Notes

Printing proceeds by reading through the period disbursement distribution file
(APDISD). The vendor and general ledger account files are referenced for
names and descriptions. Any records that meet the entered criteria will be
printed in general ledger number order.

FILES USED - APVEND, GLMSTR, SMCNTL

FILES UPDATED - APDISD

;2 Disbursement Distribution [APRS30)
Template Print Options

CP=0911997 SEP

Period  |ElREr SEP
Beginning GiL# [ 14] ] First
Endingoil# | | #4] Last
Branch W Mﬂd Atlanta Branch
Department ’_1 | &y wholesale
Scope |5- Summary | T

Template Frinter
Mane Genicom Line Printer cancel

Enter Periad ta Print {(CR=Current)

L Disbursement Distribution (APR830]

Help

81-Demo Company Disbursement Distribution nPRE2G
CP=89/2002 SEP|

Period SEP

Beginning G/L# First
Ending G/L# Last
Branch Atlanta Branch
Department Wholesale

Scope Summary

— Template — Printer
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Register History Report (APR840)

Function

This program allows the user to print a report of all registers affecting the
Accounts Payable balance. This provides a trace of what transpired to obtain
the current AP balance. The optional update will remove the printed records
preceding the first trace number for the next period without affecting any
balances.

Registers that appear on this report include the Document Entry & Adjustments
Register, the Check Register and the Vendor Balancing Register.

It is suggested that the report be printed as part of the end-of-period
procedures. To prevent file overflow, the records should be removed once a
month after the register is run.

Report information includes the following: AP trace number, register date,
period, register number, register type, beginning AP balance, dollar amount,
discount amount, adjustment amount and ending AP balance. The recap lists
for each period the total dollar amount, discounts, adjustments and change in
AP balance. The total number of traces (registers) listed is also included.

User Inputs

The following inputs are involved in printing the Register History Report:
1. Print Report

Enter Y or N to indicate whether to print the report. CR defaults toY.

2. Check report. OK to remove records preceding first trace# for next period?

Select OK or enter Y to remove records and update the system. Select
CANCEL or enter N to skip the update.

Technical Notes

Printing proceeds by reading through the register history records of the control
file SMCNTL). Information will print in order of effect by register trace
number. The optional update removes printed records preceding the first trace
number for the next period.

FILES UPDATED - SMCNTL
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;¥ Register History Report [APR840)

Template  Print Options

CP=08/1997 SEF
This program prints a repaont of registers that affect the AP halance and

provides a trace of activities that produce the current balance. This optional
update also removes the printed records preceding the first trace number for

the next period without affecting any balances. Ifyou would like to run this
register press Ok,

Template Frinter =

Mone Genicom Line Printer Cancel

L Register History Report (APRB340]

Help

81-Demo Company Register History Report APR84H
CP=09/2002 SEP
This program prints a report of registers that affect the AP balance and
provides a trace of activities that produce the current balance. This optional
update also removes the printed records preceding the first trace number for

the next period without affecting any balances. If you would like to run this
register press OH.

— Template — Printer
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Document Removal Register (APR850)

Function

This program allows the user to print a report of all documents paid down to
zero and optionally remove those records from the open documents file. The
update also maintains the paid document history file.

It is suggested the report be printed and updated as part of the end-of-period
procedures. To prevent file overflow, the records should be removed once a
month after the register is run.

Records removed by this program will no longer appear on the Open Payables
or Aged Payables Reports. The information regarding paid off documents is
available for screen display in the Vendor Inquiry program.

Report information includes the following for each vendor: the vendor number
and name, document number, entry period and date, amount, document
register date and number, payment amount, discount taken and current
document balance (0). An asterisk indicates that the total of the transactions for
that document does not equal the document amount. The total number of
documents listed with a balance of zero is also included.

User Inputs

The following inputs are involved in printing a Document Removal Register:
1. Branch

Enter the branch number. The entry must be a valid branch. CR defaults to the
branch assigned to the terminal. F3 defaults to ALL.

2. Print Register

Enter Y or N to indicate whether to print the register. CR defaults to'Y.

3. Check register. OK to remove these records?

Select OK or enter Y to remove records and update the system. Select
CANCEL or enter N to skip the update.

Technical Notes

Printing proceeds by reading through the open documents file (APOPEN).
Documents with balances not equal to zero and next period's documents are
skipped. The update portion removes records from the invoice transactions file
(APTRAN) and the open documents file. Records are written to the paid
document file (APPAST).

FILES USED - APVEND, APCKMI, APCKMV, APCKRG
FILES UPDATED - SMCNTL, APOPEN, APTRAN, APPAST
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;¥ Document Removal Aegister [(APRB50)

[ @

L® Document Removal Register [APRB50)
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How to run the Document Removal Register

1.

8-14

Access this program by choosing Account Payable--> End of Period--> Document Removal
Register.

In the Branch field, enter the branch for the document removal. Press Enter (CR) defaults to the

branch assigned to the terminal. Select the 2 icon to process all branches for the register. Select
the # to search for branches.

Select the OK button to print the register.

After printing the Document Removal Register, verify the printout. If you need to correct the
register data, select Cancel or enter N to exit the program. After you make corrections, you can
rerun the Document Removal Register. If everything is correct, select OK or enter YES to
continue.

The program displays the message Check Register. Remove these Records?” Choose OK or press
Enter to remove the documents that appear on the register printout. Choose Cancel or press F4 to
abort the update and leave the documents in the system. At the “Update Not Run” message,
choose OK.
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Vendor Ledgercard Removal (APU810)

Function

This program allows the user to remove vendor ledgercards from the system. It
is suggested to print the Vendor Ledgercards before running this program. The
program can be run by vendor number, alpha, or vendor class based on the
transaction cutoff date. It is suggested to run this update as a part of the end-
of-period procedures.

User Inputs

The following inputs are involved in running the Vendor Ledgercard Removal:
1. Order

Select the order the ledgercards are to be removed (ref. 4).

2. Beginning Order Choice

Select the beginning order choice (ref. 5).
3. Ending Order Choice

Select the ending order choice (ref. 6).

4. Cutoff Date

Enter the last transaction cutoff date. Records will be removed through this
date. CR defaults to the ending date of the last general ledger period closed.

5. Keep

Enter the minimum number of ledger cards to keep on file per vendor
regardless of the entered cutoff date (1-99). CR defaults to NO MINIMUM.

Technical Notes

Updating proceeds by reading through the chosen file - vendor (APVEND),
alpha (APVALX) or vendor class (APCLSX). The vendor ledgercard file
(APLEDG) is then checked for records which meet all criteria entered.

FILES USED - SMCNTL, APVEND, APVALX, APCLSX
FILES UPDATED - APLEDG
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How to remove vendor ledgercards

1. Access this program by choosing Account Payable--> End of Period-->Vendor Ledgercard
Removal.

2. Inthe Order field, select the order to use when removing the ledgercards. You can select V for
vendor code, A for Alpha, or C for vendor class order. Press F4 to exit the program.

3. Inthe Beginning input, enter the number of the beginning order choice to remove.
4.  In the Ending input, enter the number of the ending order choice for the removal range.

5. In the Cutoff Date input, enter the last transaction cutoff date. Records will be removed through
this date. Press Enter (CR) to default to the ending date of the last general ledger period closed.

6. Inthe Keep input, enter the minimum number of ledger cards to keep on file per vendor
regardless of the entered cutoff date (1-99). Press Enter (CR) to default to NO MINIMUM.

7. When the system displays the message: End of Inputs. Enter Yes to Continue, F4 to backup,
enter Yes to remove the records and update the system, press F4 to backup and change the input
values, or press F4 twice to exit the program.

8. If you enter Yes, the system displays the criteria you entered in the upper portion of the screen
and processing information in the lower portion of the screen. When the program is complete
the system displays a message telling you how many records were removed and then exits the
program.
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End-Of-Period Update (APU890)

Function

This program allows the user to close the current accounts payable period. The
End-of-Period Update should be run at the end of each Accounts Payable
period.

This update allows the user to:

e Close out the current period in accounts payable.

e Remove all temporary vendors with a zero balance.

¢ Remove documents from the past history file if the balance is zero and
the document is older that the number of periods set in the static control
records for storing past documents.

o (lear the month-to-date vendor information.

o If this is the end of the year, it will roll year-to-date information to prior
year.

Prior to running this update, the user should make sure that the final PO
Invoice Receipt Register, Document Entry & Adjustments Register, and Check
Register have been run. The Period Check Register, Period Expense
Distribution, Disbursement Distribution, Register History Report and
Document Removal Register should also be run. At end of year, the 1099 Print
should be run.

User Inputs

The following inputs are involved in running the End-of-Period Update:
1. Close-Out Period

Enter Y or N to indicate whether or not to close the current accounts payable
period. CR defaultsto Y.

2. Have the above end-of-period programs been run?

Enter N or YES to indicate if the above reports have been run. This input is just
a last check to make sure the user has run all the necessary reports before
closing the period. CR defaults to N and the program is terminated.

If the last AP period was closed less than 20 days before the system date, a
message is displayed indicating the number of days since the last close. If the
last AP period was closed more than 20 days before the system date, input #3 is
skipped.

3. Are you sure you want to close out this period?

Enter N or YES to indicate whether to close the period. CR defaults to N and
the program is terminated.
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Technical Notes

Updating proceeds by reading through the vendor file (APVEND) and
removing temporary vendors with a zero balance. Then month-to-date vendor
balances are set to zero. Next, the paid documents file (APPAST) is cleared of
paid-off documents which will be stored more than the number of periods
which paid documents should be stored (determisned in the AP static control
F/M). Finally, the current accounts payable period is incremented by one.

FILES USED - APOPEN, APDOCM, APCKRG, APCKMYV, POINVC

FILES UPDATED - SMCNTL, APVEND, APPAST, APVALX, APCLSX,
APNOTE, APHIST, SMCHKR, APLEDG

T\ End-of-Period Update {APUBID} — o] x|
Help
B1-FACTS 7.5 Development AP END OF PERIOD UPDATE APUBOA@

CP=82/85 FEB
THIS PROGRAM WILL CLOSE THE CURRENT AP PERIODD.
TEMPDRARY UENDORS WHO ARE IWACTIUE WILL BE DELETED.
PERIDD-TO-DATE PURCHASE FIGURES WILL BE SET TO ZERD.
PAYMENT HISTORY WILL BE ROLLED.

CLOSE OUT PERIOD .

CLOSE OUT CURRENT ACCOUNTS PAYABLE PERIOD? (Y/H), FA-END () (1] [(Ena ) [ok]
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How to run the End-of-Period Update

1.  Access this program by choosing Accounts Payable-->End of Period-->End
of Period Update.

2. Inthe Close-out period input, indicate whether or not to close the current
Accounts Payable period. The program defaults to Y.

3. At the Have the above End-of-Period programs been run? prompt, enter N
or YES to indicate if the above reports have been run. This input is just a
last check to make sure the user has run all the necessary reports before
closing the period. The program defaults to N and the program is
terminated unless you enter Yes.

If the last AP period was closed less than 20 days before the system date, a
message is displayed indicating the number of days since the last close. If
the last AP period was closed more than 20 days before the system date,
the following input is skipped.

4. At the Are you sure you want to close out this period? prompt, enter YES
to remove the records and update the system. Enter N to skip the update.

5. If you enter Yes, the system displays the criteria you entered in the upper
portion of the screen and processing information in the lower portion of
the screen. When the program is complete the system displays a message
telling you how many records were updated and then exits the program.
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DISTRIBUTION SOLUTIONS

CHAPTER ¢

File Maintenances

File maintenance programs allow users to enter, change and delete data. These
programs are used to enter the initial data required to set up the system (refer
to the Installation Manual).

The user can add, change and delete the records in a file. This is called
maintaining the file. Some file maintenance programs may be used often where
others are used less frequently. There is an Infrequent File Maintenances menu
explained in the next chapter.

All files, once set up, are maintained and updated by the system. Most file
maintenances in the Accounts Payable system do not need to be maintained by
the user and it is unlikely that they will be used.

™, FACTS 7.5 Distribution Software - Accounts Payable {APS000)

FACTS G ~Toe

DISTRIBUTION 50FTWARE

GILWITEC) FACTS 7.8 Developrment - Company 01 M2N2N5 - 1-40 pn

ha |

Accounts P hi File Maintenances Tasks:
Yedor FiM

Fayment Histary Fiid
E] TranaferChangs Yendor Godes
=5 Infrequent File Maintenances. .

Payment & Hold

- Chacks Inquirias
Selection 9

Dosumant Entry

L‘,&
7

Reports & Pints End of Periad File Maintenances

@ Arcecs Code E
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™\ Company 01, FACTS 7.5 Development !EE

Help

01-FACTS 7.5 Developme AP59808
Selection |

ENTER SELECTION #, ACCESS CODE, 'OFF', ARROWS, F4-PREVIOUS MEHU
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Vendor F/M (APF910)

Function

This program allows the user to create and maintain records in the vendor file.
Each record contains a vendor number and general information relevant to the
vendor. This file is referenced by most programs in the AP system as well as by
the inventory system.

Vendor numbers may be automatically assigned by the system. You cannot
delete vendors with open documents or open purchase orders.

You can also create Faxlink records based on information stored in Vendor
records. The program will ask you to do this when you save the document for
the first time.

When you save new vendor records, the system allows you to create a Faxlink record and
warehouse/vendor review cycle record directly from this program.

To create a faxlink record, select OK when the system asks if you want to create a faxlink records.
Select OK, and the system displays the Quick Fax Record Entry screen. Complete the information on
the screen and press Enter to add the record.

After you have created the Faxlink record or selected Cancel on the Faxlink message, the system asks
if you want to create a warehouse/vendor review cycle record for the new vendor.

To create warehouse/vendor review cycle record, select OK when the system asks if you want to
create a warehouse/vendor review cycle record. The system automatically displays the
Warehouse/Review Cycle F/M program with the new vendor information. The first warehouse on
file displays as the default. You can complete the warehouse/vendor review cycle record information
and save the record to return to the Vendor F/M (APF910) program, or you can change other vendors'
records and/ or create new warehouse/vendor review cycle records for other vendors.

User Inputs

The following inputs are involved in creating vendor file records:
* Vendor number

Enter the vendor number (up to 10 characters). F1 assigns the next available
vendor number from the AP nonstatic control record. The word NEXT is
displayed until all inputs have been entered and the actual number is displayed
before the record is added to the file. F2 allows a search (ref. 7).

Main Screen

2. Vendor name

Enter the vendor’s name (up to 30 characters).

3. Address1

Enter line 1 of the vendor’s address (up to 30 characters). If only one line is
needed, use the first.
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9-4

4. Address 2

Enter line 2 of the vendor’s address (up to 30 characters).

5. City

Enter the city name (up to 15 characters).

6. State

Enter the state name using the 2-character designation provided by the post
office.

7. Zip code

Enter the zip code (up to 10 characters).
8. Address 3

Enter line 3 of the vendor’s address (up to 30 characters). CR defaults to the
city, state and zip entered in the previous inputs #5-7. Address 3 may be used
for international addresses. Address 3 will be used for all printouts instead of
the city, state and zip fields.

9. Alpha (alphabetic sort key)

Enter the alphabetic sort key to be used to sort vendors alphabetically for
printouts, displays and alpha searches (up to 10 characters). In most cases, the
first ten characters of the vendor’s name are sufficient to achieve alphabetical

lookup. CR defaults to the first ten characters of the vendor’s name as entered
in input #2.

10. Contact #1

Enter the name of the person you work with at the vendor’s office (up to 25
characters). If only one contact is needed, use the first.

11. Phone #1

Enter the vendor’s phone number including area code, dashes and extension, if
needed (up to 17 characters). If only one phone number is needed, use the first.

12. Email

Enter the email address for the person entered as contact #1 above.

13. Contact #2

Enter the name of another person you work with at the vendor’s office (up to 25
characters).

14. Phone #2

Enter the vendor’s second phone number including area code, dashes and
extension, if needed (up to 17 characters).

15. Email

Enter the email address for the person entered as contact #1 above.

Accounts Payable—7.50
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16. Web Site

Enter the company’s Internet address on the World Wide Web. You can select
the WWW button to access the company’s Internet on the World Wide Web.

Purchase History

To access the purchase history screen, enter a valid vendor number. The screen displays the vendors
general information. Press P to display the purchase history.

The following fields should be used as a file maintenance only once to enter original information.
Thereafter, it is updated by the system and changes made by the user may compromise data.
Entering initial information into these fields is optional.

The update portions of the Document Entry & Adjustments Register and the Check Register
programs update purchase history information.

2. Date Opened

Enter the date the account was opened with this vendor (ref. 2). CR defaults to
the date this vendor was entered into the vendor file.

3. Date Last Invoice

Enter the date of the most recent invoice from this vendor (ref. 2).

4. Date Last Payment

Enter the date of the most recent payment made to this vendor (ref. 2).

5. Date Highest Balance

Enter the date the highest amount of money was owed to this vendor (ref. 2).

* Current Balance
7. Highest Balance

Enter the amount of the highest balance for this vendor (+/- 99999999.99). CR
initially defaults to 0.

8. 1099 Balance

Enter the amount of the 1099 balance for this vendor (+/- 99999999.99). CR
initially defaults to 0.

9. Month-To-Date Invoices, Payments, Disc. Taken, Disc. Allowable

Enter the total amount of month-to-date invoices (+/- 99999999.99). CR
initially defaults to 0.

10. Year-To-Date Invoices, Payments, Disc. Taken, Disc. Allowable

Enter the total amount of year-to-date invoices (+/- 99999999.99). CR initially
defaults to 0.

11. Prior Year Invoices, Payments, Disc. Taken, Disc. Allowable

Enter the total amount of prior year invoices (+/- 99999999.99). CR initially
defaults to 0.
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Financials
2. Check Name

Enter the payee’s name that should print on the AP checks (up to 30 characters).

CR defaults to the vendor’s name.

3. Address1

Enter the first address line to print on the AP checks (i.e., remit-to address) (up
to 30 characters). CR defaults to address 1 of the vendor.

4. Address 2

Enter the second address line to print on the AP checks (i.e., remit-to address)
(up to 30 characters). CR defaults to address 2 of the vendor.

5. Address 3

Enter the city, state and zip to print on the AP checks (i.e., remit-to address) (up
to 30 characters). CR defaults to address 3 of the vendor.

6. Tax Exempt #

Enter your company’s tax exempt number applicable for this vendor (up to 10
characters). Tax exempt numbers may vary by state. This number prints on
any purchase order for this vendor so that you are not charged tax.

7. 1099 ID

Enter the vendor’s 1099 ID number (up to 12 characters). This is used to print
on the 1099 forms for sales more than $400. This number is most often used for
contract labor situations.

8. Terms Code

Enter the terms code for this vendor (up to 2 characters). The entry must be a
valid terms code. F2 allows a search (ref. 7).

9. GL Table

Enter the GL posting table to which this vendor belongs (up to 3 characters).
The entry must be a valid AP general ledger posting table. F2 allows a search
(ref. 7).

Miscellaneous

2. Our Customer #

Enter your customer number from this vendor (up to 10 characters). It should
be the number this vendor has assigned to you for their records.

3. Vendor Class

Enter the vendor class (up to 3 characters). The entry must be a valid vendor
class. F2 allows a search (ref. 7).

4. Doc Group (document group)

Enter the normal document group for this vendor (up to 2 characters).
Document groups are optional and this input may be skipped.

Accounts Payable—7.50
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5. Ship-From

Enter the normal (default) ship-from number for purchase orders for this
vendor (up to 5 characters). CR defaults to SAME meaning this ship-from
name and address is the same as the vendor’s name and address. If the number
is not SAME, the screen will display the number. After the vendor record is
entered, the ship-from number and address should be entered in the Ship-From
F/M program in purchase orders.

6. Default Freight

Enter the default freight code for this vendor. This freight code is used as the
default for warehouse-ship purchase orders created in PO Entry and PO
Receipt Entry programs. You can select from: B-Bill Later, C-Collect, P-
Prepaid, A-Prepay/Add.

7. Perm/Temp (Permanent/Temporary)

Enter whether the vendor is Permanent or Temporary. Temporary vendors
who have a zero balance are removed during the End-of-Period Update. The
temporary vendor numbers may be reused. CR initially defaults to P.

8. Temporary Item Lead Time
Enter the default lead time for temporary items. This field represents the
default lead time for this vendor for temporary items for use in determining

when to release a request on a blanket sales order. This value can be
overridden during blanket sales order entry. CR initially defaults to 0.

When all inputs have been entered, enter Y or N to indicate whether to add the record and assign
purchase history defaults. CR defaults to Y.

9. Message

Enter a message if desired (up to 30 characters). This message only appears on
the screen during document entry programs.

10. Active

Enter Y or N to indicate whether the vendor is active. If N is entered, no

processing is allowed for this vendor (i.e., no checks may be processed and no
documents may be entered). CR initially defaults to Y.

11. On Hold

Enter N or Y to indicate whether to place the vendor on hold. If Y is entered,
no checks may be written to this vendor. CR initially defaults to N.

12. Use Ledgercards

Enter N or Y to indicate whether to store ledgercards for this vendor. CR
initially defaults to N.

13. Store Past POs

Enter N or Y to indicate whether to store past purchase orders for this vendor.
CR initially defaults to N.
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Vendor F/M Costing Screen
2. Default Cost Class Prompt

Enter the default cost class. Press F1 for None, F2 to search, or F4 to backup. If
your company does not use costs classes for cost contracts, enter None in this
field.

3. Cost Hierarchy Prompt

Enter the cost hierarchy. You can select from: S=Standard PO cost, I=Contracts
for specific items, C=Contracts for items in a cost class, or A=Contracts for all
items. Press Enter (CR) to default to I+C+A+S. Press F1 for None or F4 to
backup.

4. Use Lowest Cost

Select the Use Lowest Cost checkbox to indicate you want to ignore the cost
hierarchy and use the lowest cost the system can find.

Vendor F/M User-Defined Screen

Many users have a few pieces of information about customers, vendors, and items that are unique to
their business that they would like to enter into FACTS for reference purposes. The User-Defined
screen displays user-defined fields in the major file maintenances and makes them available in FACTS
Inquiry programs for information only. There are 5 user-defined fields available to any user that has
access to Vendor F/M. You will be able to configure these fields within the following constraints: If
the user has administrator privileges for User-defined Fields setting on the Security tab of User Code
F/M (SMF410): Each field can be designated by a type--text, numeric, validated list, and date, as well
as a label that can be edited in the F/M to create custom labels for each field. This allows the user to
have a meaningful label other than "User Defined 1" and so on.

Technical Notes

FILES USED - APOPEN, APHIST, APDOCM, APPAST, EC810D, ICWHVD,
ICVNDX, POSUGG, POVNDX, POVNIT

FILES UPDATED - SMCNTL, APVEND, APVALX, APCLSX, APNOTE,
APLEDG
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MHotes

\01 -7.4 Development, Yendor F/M [APFI310]) [ [E1]x]
Help
vendor | V10— |74 | Georsia Shipping Eauin. Co. W]
Main | Burchase History | Einancials | Miscellaneaus costing | User-Defined

Mame [Georgia Shipping Eguip. Co.
Address 1 |33?E Washington Ave. 5.E.

Address 2 |
City [Atlanta State  [GA Zip code  [30302
Address 3 |Atlanta, GA, 30302

Alpha IGEORGIA SH

Contact Information

; Contact1  [Michael Brooks Phone [404-334-9833
5 E-mail |
] Contact2  [Slenn Homshy Phone |
E-mail |
Wweb Site | |
| o Save | % Deete | [ Mew | W Ext |
|Emer address line 3, F1-Reset
™\ Vendor F/M [APF910) Mi[=] E3
Help
81-7.4 Development Uendor F/H nPFo1d
*_. Uendor U166 General Industrial HFG
2. Hame General Industrial HFG
3. Address 1 2618 Dunwoody, P1.

L.
5.
6.
7.
8.
9.

18.

13.

16.

Address 2 Suite 133-134

City Atlanta

State GA

Z2ip Code 38338

Address 3 Atlanta, GA. 38338

Alpha GEHERAL IH

— Contact Information

Contact 1 Roger Smith 11. Phone L484-393-9444
12. E-mail

Contact 2 Gloria Faye 14. Phone (L0432303-0457
15. E-mail

Weh Site

Main, Purchase History, Fipancials, HMiscellaneous, Costing, User-Defined
Enter Line #, D-Delete, F18-Henu, F4-Backup |..
Arrows: Up-Prev Rec, Dn-Hext, Pgup-First, Pgdn-Last
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\ 01-7.4 Development. Yendor F/M [APF310)
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Copyright © 1984-2005 Infor, Inc.



Accounts Payable—7.50 File Maintenances

\ 01-7.4 Development. Yendor F/M [APFI10)

e

Geargia Shipping Equip. Ca.

3376E Washington Ave. 5 E.

Atlanta, GA. 30302
)

_'\ Yendor F/M [APFI10)
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\ 01-7.4 Development. Yendor F/M [APFI10)
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™\ Vendor F/M [APFS10)
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-\ 01-7_4 Development, Yendor F/M [APF310])

T\ Vendor F/M [APFS10)

Copyright © 1984-2005 Infor, Inc. 9-13



File Maintenances Accounts Payable—7.50

\ 01-7.4 Development. Yendor F/M [APFI10)

N

_'\‘Vendm F/M [APFI10)
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Payment History F/M (APF930)

Function

This program allows the user to create and maintain vendor payment history
which includes payments made to each vendor for the next period, current
period and 26 previous periods.

This program should be used as a file maintenance only once to enter original
information. Thereafter, it is updated by the system and changes made by the
user may compromise data. Entering initial information into this file is
optional.

The update portion of the Check Register program updates the information in
the payment history file.

User Inputs

The following inputs are involved in creating a payment history record:
* Vendor number

Enter the vendor number. If a payment history record for this vendor is on file,
it will be displayed (ref. 10).

Most Current Period Payments and Previous Payments

Enter the payment amounts for the next period, current period and prior 26
periods (+/-99999999.99). The 14 most current periods are located on the Most
Current Period tab. Another 14 periods are located on the Previous Periods tab.
CR initially defaults to 0. F2 sets the current and remaining inputs to 0.

Technical Notes

Payment history information is stored in the payment history file (APHIST).
FILES USED - SMCNTL, APVEND, APVALX
FILES UPDATED - APHIST
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;2 Payment History F/M [APFI30)

Wendor J General Industrial MFG MHMM
Most Current Periods l Frewious Periods
Feriod FPayment Feriod Pawiment

mPigiagzoct [ PPO4oa7 Apr | 738003
CPoOanasTsep | 0 353849 PPO3MG8T Mar | 908546
LP 081987 Sep | 3123373 PPO21897Feb | 718418
PPOBM897Aug | 1165525 PPD1/1997 Jan | 892056

PPO7M997Jul | 11736.54 PP12(1896Dec | 842750
PPOBNO97 Jun | 1026925 PP111896Nov [ 978130
PPOSMGS7 May | 822272 PR1DMGEE Ot | 878039

Save |X_ Delete |D e | N Ext |

Enter Payment for Mext Period 10/1997 Oct

;2 Payment History F/M [APFI30)

Wendor J General Industrial MFG MHMM
Most Current Periods Fremious Periods
Feriod FPayment Feriod Pawiment

PPOOMO96Sep | = 984708 PPO2M996Feb |  6650.35
PPOSMGS6 AU | 809255 PROTMG86Jan | 1080822
PPO7M998Jul [ 727250 PP121895Dec |  7860.02
PPOBMO96Jun | 924833 PP11/1895Nov | 568563
PPOSM896May | 060144 PP10M9950ct | 7668515
PPO4ogEApr [ 830372 PPO9M8958ep | 710876
PPO3MOGEMar | 8368872 OPO7MO95Jul | B57SEO0

B Save |X_ Delete |D e | N Ext |

9-16 Copyright © 1984-2005 Infor, Inc.



Accounts Payable—7.50

™\ Payment History F/M (APF930)

Help

B1-FACTS 7.5 Development

Payment History F/H

APF93d

*_ Uendor General Industrial HFG
Period Payment Period Payment

1. PP 8872003 Aug 8. PP 8172003 Jan

2. PP 8772083 Jul 9. PP 1272882 Dec

3. PP 86/2883 Jun 18. PP 1172882 Hovu

4. PP 8572003 Hay 11. PP 18/2082 Oct

5. PP B4/2083 Apr 12. PP 09/2882 Sep

6. PP 83/20883 Har 13. PP 8872882 Aug

7. PP 8272003 Feb 14. OP 8772082 Jul

ost Current Periods,

™, Payment History F/M (APF930) BEE
Help
81-FACTS 7.5 Development Payment History F/H nPFo3g
*. Uendor General Industrial HFG

Period Payment Period Payment

1. PP 8872083 Aug 8. PP 0172083 Jan

2. PP 877208083 Jul 9. PP 1272882 Dec

3. PP 86720803 Jun 18. PP 117208062 Hou

4. PP 8572883 Hay 11. PP 18752882 Oct

5. PP 04/20803 Apr 12. PP 89/2002 Sep

6. PP B3/20883 Har 13. PP 88728082 Aug

7. PP 827208083 Feb 14. OP 8772882 Jul

ost Current Periods,
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Transfer/Change Vendor Codes (APU910)

Function

This program allows the user of the FACTS system to change specific
information in the vendor file for a range of vendors.

The user has the option to change the following fields:

1. Vendor class 7. Default cost

2. Terms code class

3. GL posting table 8. Cost hierarchy
4. Document group 9. Use lowest cost
5. Ledgercard flag flag

6. Past PO flag

To change a field the user may:

e Select the order to change - vendor, alpha, or vendor class.
e Select the beginning and ending order choice to change.

e Select the change FROM field.

o Select the change TO field.

The fields above are all part of the information stored on each vendor in the
vendor file. This program is especially useful to make changes to many
vendors without having to manually change each vendor individually through
the Vendor F/M program.

An example of the use of this program is if the user started to give a 2% terms
discounts replacing the 1% discounts. All fields being changed must be valid
fields. For example, if changing terms codes, all codes being changed must be
valid terms codes. Changes made in this program do not affect transaction files
or other modules.

User Inputs

The following inputs are involved in changing vendor information:
1. Select number

Enter the number of the field to be changed (1-6).
2. Order

Select the order the field is to update (ref. 4).

3. Beginning order choice

Enter the beginning order choice (ref. 5).

4. Ending order choice

Enter the ending order choice (ref. 6).
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5. Change from

The answer to the first input (Select #) is the field being changed (e.g., if vendor
class was selected, enter the vendor class that is being changed). F3 defaults to
ALL.

6. Change to
The answer to the second input (Select #) is the field being changed to (e.g., if
vendor class was selected, enter the vendor class to change to). F3 defaults to

the user selection. If F3 is chosen, the program stops at every vendor whose
vendor class is to be changed and requires input of the new vendor class.

Technical Notes

Processing proceeds by reading through the selected file - vendor (APVEND),
alpha (APVALX), or vendor class (APCLSX). The vendor file (APVEND) is
then checked for information that meets all criteria entered.

FILES USED SMCNTL, APVALX
FILES UPDATED - APVEND, APCLSX

L Transfer/Change Vendor Codes [APU910)
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DISTRIBUTION SOLUTIONS

Infrequent F/IM

File maintenance programs allow the user to enter, change and delete data.
These programs are used to enter the initial data required to set up the system
(refer to the Installation Manual).

The user can add, change and delete the records in a file. This is called
maintaining the file. Some file maintenance programs may be used often where
others are used less frequently. There is an Infrequent File Maintenances menu
for the latter programs; most of these are used only one time during the initial set
up of the system. However, the information in the infrequent file maintenances
may be updated by the system. An example would be the Nonstatic Control
F/M which keeps track of the accounts payable period and all the register trace
numbers.

All files, once set up, are maintained and updated by the system. Most file
maintenances in the accounts payable system do not need to be maintained by
the user and it is unlikely that they will be used.

™, FACTS 7.5 Distribution Software - Accounts Payable {APS000)

CILWITEC) FACTS 7.5 Development - Company 01 N2N2MN4A - 140 pin

-

Accounts Payahle Infrequent File Maintenances Tasks:
Yeador & Frhd
Tems Code Fikd

% GL Posting Takle Fit

% Register History Fimd
Check Print Gontral Fit
Static Control F/k

Dooumant Entry PEVS"“:IZ;‘?‘D:"M Chads Inquiries :ZEETJ';S;':&?__';;?

A
i
Repaorts & Pints End of Feriod File Maintenances

@ Access Code M
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™\ Company 01, FACTS 7.5 Development !EE

Help

B1-FACTS 7.5 Developne APs910
Selection |

ENTER SELECTION #, ACCESS CODE, 'OFF', ARROWS, F4-PREUIOUS MEHU
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Vendor Class F/M (APF950)

Function

This program allows the user to create and maintain vendor class records which
are used to categorize the different types of vendors.

Users may establish their own set of valid vendor classes. Each vendor will be
placed into a vendor class. These classes are used on some printouts in order to
group vendors. For example, the user may want to group all inventory vendors,
utility vendors, office supply vendors, etc. Assign any alphanumeric code to
indicate each class (i.e., 001, 002, 003 or INV, UTL, OFF). If the user chooses not
to use vendor classes, one class should be created and all vendors must be
assigned to that class.

At least one vendor class must be entered here prior to entering vendors into the
vendor file.

User Inputs

The following inputs are involved in creating a vendor class record:
1. Vendor class
Enter the vendor class code (up to 3 characters). F2 allows a search (ref. 7).
2. Vendor class description

Enter the description of the vendor class (up to 30 characters).

3. GL table

Enter the default GL posting table for this class. This is only a default and is used
in the Vendor F/M program. If the vendor class is UTL and the GL posting table
is 100, then when entering UTL as the vendor class in the Vendor F/M program,
the GL posting table will default to 100 with the user having the option to
override the GL posting table. F2 allows a search (ref. 7).

Technical Notes

FILES UPDATED - SMCNTL
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;2 Yendor Class F/M [(APF950)

;2 Win with ProvideX
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Terms Code F/M (APF955)

Function

This program allows the user to create and maintain terms code records.

Users may establish their own set of valid terms codes to be assigned to each
vendor. The information given about each terms code will be used in
determining due dates and discount due dates during AP Document Entry. The
user should assign terms code designations that are easy to remember, for
example, 30-net 30 days, 01- 1% 10 net 30, etc.

An M-manual terms code should be set up. During the Document Entry
program the M terms code indicates to the system that the due date, discount
due date and allowable discount are entered by the user and not calculated by
the system. The M terms code should be assigned to vendors with variable terms
codes.

The following table illustrates how some of the more common terms codes
would be entered:

Code 10 20 99
Description 1% 10 Net 30 2% 10 Net 30 Cash
Date/Num/Spec N N N
# of Payments 1 1 1
Discount % 1.00% 2 0.00
First Net Due 30 10 0
Discount Due 10 0 0
Cutoff Day Current Month 10

Cutoff Day Next Month 25

Subsequent Due
Sub. Dscnt Due
Specific Date Due
Spec. Dsent Due

Valid terms codes must be entered here prior to entering vendors into the vendor
file.
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User Inputs

The following inputs are involved in creating a terms code record:
*. Terms Code

Enter a terms code (up to 2 characters). F2 allows a search (ref. 7).

2. Terms Description

Enter the description of this terms code (up to 15 characters).
*. Date/Num/Spec (Date/Number Of Days/Specific)

Enter D if payment is always due on a certain day of the month, e.g., the 10th.
Enter N if payment is always due in a certain number of days, e.g., in 30 days.
Enter S if payment is due on a specific date, e.g., 7/8/97. CR initially defaults to
D.

4. # of Payments

Enter the number of payments expected (1-12). CR initially defaults to 1.
Example, if terms are Net 30, 60, 90 then three payments will be made. If S was
selected for input #3, then the number of payments must be 1.

5. Discount %

Enter the allowable discount percent (0 to 99.99). For example, if it is a one
percent discount enter 1.00. CR initially defaults to 0.

6. First Due Date

If D or N was selected in input #3, enter either the day of the month or the
number of days until due (0-999). If S was chosen in input #3, this input is
skipped. CR initially defaults to 0.

7. First Discount Due Date

If S was selected in input #3, this input is skipped. Enter the day of the month or
number of days that payment is due to be eligible to receive a discount (0-999).
CR initially defaults to 0.

8. Cutoff Day Current Month

If S was selected in input #3, this input is skipped. Enter the day (invoice date)
before which the due date will still be in the current month. If this is set to zero,
the invoice will never be due in the current month. If this is set to 5, the due date
will only be in the current month if the invoice date is the 1st - 4th of the month.
For example, if the terms are 2% 10th Net 30th and anything invoiced after the
4th is due the next (following) month, the cutoff would be set to 5. If invoiced on
September 4th the discount due date is September 10th and the net due date is
September 30th. If invoiced on September 5th the discount due date is October
10th and the net due date is October 30th.

9. Cutoff Day Next Month

If S was selected in input #3, this input is skipped. Enter the day (invoice date)
before which the due date will be in the next month. If this is set to 25, the due
date will only be in the next month if the invoice date is between the cutoff for

10-6 Copyright © 1984-2005 Infor, Inc.



Accounts Payable—7.50 Infrequent F/M

the current month and the 25th of the month. For example, if the terms are 2%
10th Net 30th and anything invoiced after the 25th is due in two months, the
cutoff would be set to 25. If invoiced on September 24th the discount due date is
October 10th and the net due date is October 30th. If invoiced on September 25th
the discount due date is November 10th and the net due date is November 30th.

10. Subsequent Due Date

If S was selected for input #3 or the number of payments selected in input #4 is 1,
then this input is skipped. If N was entered in input #3, enter the number of
days until due (0-999). If D was entered in input #3, enter the date of each month
when payment is due (0-31). This field is used only for terms codes with
multiple payment due dates. CR initially defaults to 0.

11. Subsequent Discount Due Date

If S was selected for input #3 or the number of payments selected in input #4 is 1,
then this input is skipped. If N was entered in input #3, enter the number of
days until discount due date (0-999). If D was entered in input #3, enter the date
on which payment is due to be eligible for a discount each month.

12. Specific Date Due

Enter the specific date on which payment is due if S was chosen in input #3 (ref.
2).

13. Specific Discount Date

Enter the specific due date on or before which payment must be made to receive
a discount if S was chosen in input #3 (ref. 2).

Technical Notes

FILES UPDATED - SMCNTL
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Description Save
DiateMumiSpec J *  Delete
# of Payments a Discount % 1.00
[ Mew
First Due Exit
Met 10 Dizcount a
Cutaff Day
Current Month Mext Month
Subsequent Due
Met 32 Discaunt 0
Specific Date
Due Dizcaunt
Enter Terms Description
{;% Win with ProvideX [_ (O]
Help
81-Demo Company Terms Code F/H APF955
#_. Terms Code 81 1% 10 Het 28
2. Description 1% 18 Het 3@

*. Date/Hum/Spec H
4. # of Payments 5

5. Discount % 1.00
— First Due
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7. Discount 5}
— Cutoff Day

8. Current Month a
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11. Discount 5}
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12. Due
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Line to Change {(F2-Cont), D-Delete, F4-Backup ..

Arrows: Up-Prev Rec, Down-Mext Rec, Pqup-First Rec, Pgdn-Last Rec
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GL Posting Table F/M (APF960)

Function

This program allows the user to create and maintain GL posting tables. GL
posting tables are used to expedite input of GL expense account numbers during
AP Document Entry.

Users may establish their own set of valid GL posting tables to be assigned to
each vendor. For example, all invoices from freight companies may be expensed
to the same GL account number. The user should assign one GL posting table to
all freight vendors. Posting tables may be alphabetic or numeric and should be
easily recognized. During Document Entry, the user must input the vendor
number. The GL posting table code assigned to that vendor is displayed and
may be overridden on the invoice. The GL account numbers stored with the GL
posting tables become the default value for the expense account number entered
in Document Entry. Document Entry also allows a search to display all GL
numbers set up in a posting table.

In Document Entry, the user may expense an invoice to up to 999 expense
accounts. The GL posting table allows the user to set up to five default expense
accounts to make entry of AP documents easier.

The GL posting table also contains the Accounts Payable GL number to post and
the Discounts GL number to post when a discount is taken.

Example: Southern bell is a vendor set up in the vendor file and for GL posting
purposes is considered a telephone vendor. Therefore, the user sets up a GL
posting table TEL-telephone. When posting most phone bills from Southern Bell,
the user normally expenses to the telephone GL expense account. However,
occasionally the user advertises in the yellow pages and when those bills are
entered, they are expensed to the advertising GL expense account. The user sets
up the GL posting table as follows:

GL Table  TEL
Description Telephone

G/L# Description

Expense 1 735-00-00 Telephone

2 710-00-00 Advertising

3

4

5
Accounts Payable 310-00-00 Accounts Payable
Discounts 490-00-00 Discounts Taken

In Document Entry, if the GL posting table is TEL for the invoice being entered,
the system automatically defaults to 735-00-00 for the first GL number to be
expensed. The user also may perform a search to display all of the GL expense
numbers set up in the TEL GL posting table. In this example, 735-00-00
telephone and 710-00-00 advertising are displayed.

Therefore, when a regular telephone bill is entered, the user may allow the
system to default to 735-00-00 telephone. However, when an occasional
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advertising bill is entered, the user may search to see the other possible expense
GL numbers to use.

If the Post by branch flag is set to Y in the AP static control record, the Document
Entry program automatically inserts the branch in the proper position in the GL
number when displaying the expense numbers of the GL posting table.

Within each GL posting table there is also an account number for accounts
payable. This number is posted when entering an accounts payable document or
writing a check and paying it off. The discounts number is posted when a
discount is taken, i.e., when the payment is made and the check is written.
Discounts are not posted upon initial entry of the document, but when the
discount is entered when payment is made (i.e., when the discount is taken).

If the user enters two bills for Southern Bell - a telephone bill for $350 and an
advertising bill for $150, the summary Document Entry Register GL distribution
using the GL posting table listed above would be as follows:

Debit Credit
310-00-00 Accounts payable -500.00
730-00-00 Telephone 350.00
710-00-00 Advertising 150.00

If the user pays the two bills and takes a 2% discount on the advertising bill, the
summary Check Register GL distribution using the GL posting table listed above
would be as follows:

Debit Credit

*100-00-00 Cash in Bank -497.00
310-00-00 Accounts Payable 500.00

490-00-00 Discounts Taken -3.00

* The cash G/L number comes from the Bank G/L number set up in the Bank
F/M in the banking and check system in system management.

If the Post by Branch flag is set to Y in the AP static control record, the Document
Entry & Adjustments Register and Check Register automatically insert the
branch (assigned to each document) in the AP and discounts GL numbers when
posting to GL.

When setting up the GL Posting Tables, because they are user-defined, there is no
limit to the number set up. Any of the expense numbers may be entered as
defaults in the AP Document Entry. The AP and Discount G/L numbers are
mandatory numbers and may not be overridden during entry of current payment
selection or check writing.
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If a loan is to be entered and the balance posts to Notes Payable rather than an
accounts payable account, when setting up GL posting tables, one may be set up
as follows:

GL Table LN

Loans

G/L # Description

* Expense 1
* 2
* 3
* 4
* 5
Accounts Payable 320-00-00 Notes Payable
Discounts 490-00-00 Discounts Taken

If a GL posting table is set up with no expense accounts, the user has no default
expense numbers in Document Entry.

The Document Entry program, Document Entry & Adjustments Register and
Check Register programs use information stored in these records.

User Inputs

The following inputs are involved in creating a GL posting table:
* GL Table

Enter the GL posting table (up to 3 characters). The user may wish to begin
numbering GL posting table with 001 and continue with 002, 003, etc. We
suggest reserving GL posting table 000 for temporary vendors or any vendor for
whom the expense account number may change with each invoice. Posting table
000 would have no expense account numbers entered. Posting table 000 may
also be used by the user who does not wish to take advantage of GL posting
tables and wishes to type all expense account numbers with each invoice entered.
F2 allows a search (ref. 7).

2. Description

Enter the description of the GL posting table (up to 30 characters).
3. Expense 1

Enter the general ledger expense account number used by this GL posting table.
The entry must be a valid general ledger number. CR defaults to no expense
number initially. F2 allows a search (ref. 7).

4. Expense 2

It may be the case that invoices are divided and expensed to several different
account numbers. The user may enter up to five expense account numbers to be
used as default values during Document Entry. For example, office supplies may
be expensed to several departments. The office supply GL posting table would
list up to five expense account numbers for office supplies. Enter the second GL
expense number if one is needed. CR initially defaults to no expense number. F2
allows a search (ref. 7).
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5. Expense 3

Enter the third GL expense number if needed. CR initially defaults to no expense
number. F2 allows a search (ref. 7).

6. Expense 4

Enter the fourth GL expense number if needed. CR initially defaults to no
expense number. F2 allows a search (ref. 7).

7. Expense 5

Enter the fifth GL expense number if needed. CR initially defaults to no expense
number. F2 allows a search (ref. 7).

8. Accounts Payable GL Number

Enter the accounts payable general ledger account number to be used as the off-
setting entry against the expense accounts. The entry must be a valid general
ledger number. F2 allows a search (ref. 7).

9. Discounts GL Number

Enter the discounts taken GL account number. The entry must be a valid general
ledger number. F2 allows a search (ref. 7).

Technical Notes

FILES USED - GLMSTR, GLALPX
FILES UPDATED - SMCNTL

L2 GL Posting Table FAM [&PF3E0)

GLTable | o001 i 4] 4] » o]

Description IOfﬁce
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5 000-000 ¢4 |

Accounts Payable | 310-01-0 ¢4 |
Discounts | 480-01-1 ¢ |

e
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o

10-12 Copyright © 1984-2005 Infor, Inc.



Accounts Payable—7.50

™\ GL Posting Table F/M (APF960)

Help
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*. GL Table

2. Description
3. Expense 1
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8. Accounts Payable
9. Discounts
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Discounts Taken
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Register History F/M (APF965)

Function

This program allows the user to trace through all registers of the current period
to see how the Accounts Payable balance is affected by each register.

When initially setting up the AP system, no records need to be entered here.

For every register run and updated that affects the Accounts Payable balance, a
record is created by the system. Information includes the following:

e AP register trace number - As each register is updated the system assigns a trace
number.

e Register types - Check, Entry, and Vendor balancing.

e Date - The date the register is updated.

e Period - The period the register is updated.

e Register # - The number which is assigned to each register when it is run.

e Beginning AP balance - The AP balance before the register is updated.

e Dollar amount - The actual dollar amount of the register which affects the AP balance.

e Discount amount - The discount amount (if applicable) on the register.

e Adjustment amount - The adjustment amount (if applicable) on the register.

¢ Ending AP balance - The AP balance after the register is updated. This balance
becomes the beginning balance on the next AP register trace number.

User Inputs

The following inputs are involved in creating a register history record:
*. AP Register Trace Number

Enter the AP register history trace number (1-9999).
2. Register Type

Enter whether the register type is C-check, E-entry or V-vendor balancing. CR
initially defaults to C.

3. Date

Enter the register date (ref. 2).
4. Period

Enter the register period (PPYY).
5. Register Number

Enter the register number (1-9999).

6. Beginning AP Balance

Enter the AP balance before the register was updated (+/- 99999999.99). CR
initially defaults to 0.
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7. Dollar Amount

Enter the dollar amount of the register to affect the AP balance (+/-99999999.99). CR initially
defaults to 0.

8. Discount Amount

Enter the discount amount of the register to affect the AP balance (+/-99999999.99). CR
initially defaults to 0.

9. Adjustment Amount

Enter the adjustment amount of the register to affect the AP balance (+/-99999999.99). CR
initially defaults to 0.

10. Ending AP Balance

Enter the AP balance after the register has been updated (+/- 99999999.99). CR initially
defaults to 0.

Technical Notes

FILES UPDATED - SMCNTL

Copyright © 1984-2005 Infor, Inc 10-15



Infrequent F/M

;¥ Begister History F/M [APF965])
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Check Print Control F/M (APF975)

Function

This program allows the user to create and maintain check parameters that
determine the print positions of information on AP checks.

The check parameter records enable the user to control, within broad limitations,
the print positions of AP check information without requiring program changes.
One record is stored for each bank to allow different checks for each bank. If the
standard AP check is to be used, the user should allow each input to default to its
preset value. This will produce a check that matches the standard FACTS check.

The Check Print program verifies that check parameters are on file for the
selected bank. Therefore, this record must be set up prior to printing checks.

Laser Check Driver Print Parameters

The laser driver, HPCHECK, prints to laser printers in 12 pitch. Using the correct settings in FACTS
and the correct forms, this driver accommodates printing laser checks in FACTS. Contact TransForm
Technologies directly to order checks or to request samples at (800) 226-2564 or email Chris Bilello at
cbilello@transformtech.net or Dottie Ward at dward@transformtech.net.

To use the HPCHECK laser driver, associate a link file for the laser printer with the HPCHECK printer.
You can set it up as an additional printer in FACTS if other users make use of the laser printer for
normal printing tasks. Use the settings below in Check Print Control F/M for Accounts Payable and
Payroll laser check forms.

Note that these settings are only for the laser check forms (Accounts Payable and Payroll) provided by
Transform Technologies. Laser check forms provided by any other forms vendor may not comply with
the set up parameters given below.

Accounts Payable Check HPCHECK Laser Driver Parameters

Vouchers tab Checks tab

# Lines Per Voucher 41 # Lines Per Check 19
# Invoices Per Voucher | 32 Maximum Columns - Script 55
Void Stub Overrun Y Check Column - Check Number 51
Checks

Plain Paper Vouchers N Check Column - Date 62
Voucher Column - 44 Check Column - Script 11
Vendor

Voucher Column - 62 Check Column - Amount 80
Name

Voucher Column - Date | 45 Check Column - Name/ Address 13
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Vouchers tab (continued)

Voucher Column - 70
Check Number

Voucher Column - Page | 86
Number

Voucher Column - 0
Invoice Date

Voucher Column - 11
Invoice Number

Voucher Column - 25
Invoice Amount

Voucher Column - 39
Discount

Voucher Column - 53
Payment

Voucher Column - 66
Memo

User Inputs

The following inputs are involved in creating a check parameter record:

Vouchers Screen
*. Bank

Enter the bank code for these parameters. The entry must be a valid bank code.
F2 allows a search (ref. 7).

2. # Lines Per Voucher

Enter the maximum number of horizontal lines (10-99) on the voucher (or stub)

portion of the check. CR defaults to 21 initially. Zero defaults to no stub and
indicates no stub is used.

3. # Invoices Per Voucher

Enter the maximum number of invoices to print on the voucher portion of the
check (1-9 less than lines per voucher chosen in input #2). If 0 was entered in
input #2, 0 is the only valid input. CR initially defaults to 12.
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4. Void Stub Overrun Checks

Enter Y or N to indicate whether to void the checks when the voucher is filled
with invoices and print continued and continue on another voucher. CR initially
defaults to Y.

5. Plain Paper Vouchers

Enter Y, N or O to indicate whether to print vouchers on plain paper after checks
are printed. Entering an O means to print the vouchers on overruns only. CR
initially defaults to N.

6. Voucher Column - Vendor

Enter the column number where the vendor number will print on the voucher (0-
125). CRinitially defaults to 39.

7. Voucher Column - Name

Enter the column number where the vendor name will print on the voucher (0-
106). CR initially defaults to 53.

8. Voucher Column - Date

Enter the column number where the date will print on the voucher (0-123). CR
initially defaults to 40.

9. Voucher Column - Check Number

Enter the column number where the check number will print on the voucher (0-
125). CRinitially defaults to 59.

10. Voucher Column - Page Number

Enter the column number where the page number will print on the voucher (0-
129). CR initially defaults to 75.

11. Voucher Column - Invoice Date

Enter the column number where the invoice date will print on the voucher (0-
123). CR initially defaults to 2.

12. Voucher Column - Invoice Number

Enter the column number where the invoice number will print on the voucher (0-
125). CRinitially defaults to 115
13. Voucher Column - Invoice Amount

Enter the column number where the gross amount of the invoice will print on the
voucher (0-120). CR initially defaults to 22.

14. Voucher Column - Discount

Enter the column number where the invoice discount amount will print on the
voucher (0-120). CR initially defaults to 34.

15. Voucher Column - Payment

Enter the column number where the payment amount will print on the voucher
(0-120). CR initially defaults to 46.
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16. Voucher Column - Memo

Enter the column number where the memo entered during Document Entry will
print on the voucher (0-106). CR initially defaults to 58.

Checks Screen
2. # Lines Per Check

Enter the maximum number of horizontal lines per check (19-99). CR initially
defaults to 21.

3. Maximum Columns - Script

Enter the maximum number of columns to be used when spelling out the check
amount in words. Count one column for each letter and space (0-130). CR
initially defaults to 55.

4. Check Column - Check Number

Enter the column number where the check number will print on the check (0-
125). CR initially defaults to 45.

5. Check Column - Date

Enter the column number where the check date will print on the check (0-123).
CR initially defaults to 55.

6. Check Column - Script

Enter the column number where the check amount spelled out in words will
print on the check (0-131 depending on the maximum number of columns in the
script). CR initially defaults to 11.

7. Check Column - Amount

Enter the column number where the check amount in numbers will print on the
check (0-120). CR initially defaults to 68.

8. Check Column - Name/Address

Enter the column number where the vendor's name and address will print on the
check (0-106). CR initially defaults to 13.

Technical Notes

FILES UPDATED - SMCNTL
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;2 Check Print Control F/M [APF375)

Bank . | Bank of Greater Duluth

Wouchers I
# Lines Peroucher wl  Void Stub Overrun Checks
# of Invoices PerYoucher 12 Plain PaperYouchers

Youcher Calumns

Wendor 39 Inw #

MName r__gg Inw At

Date W Discount
Check# r__?if Pawment
Page # r__Fg termo
Inw Date |—2

[ (O] %]

LIRINALY

ol+] o] ol

[E Save | ¥ Delete | [0 Mew | N Ext

Enter # of Lines Per Voucher Stub (10-99, 0=Mo Check Stub)

{;% Win with ProvideX [_ (O]
Help

81-Demo Company Check Print Control F/H APF975
#_. Bank 61 Bank of Greater Duluth

2. # Lines Per Uoucher 21

3. # of Invoices Per Voucher 12
4. Upid Stub Overrun Checks ¥
5. Plain Paper Uouchers ¥ Print

— Uoucher Columns —
6. Uendor 39 12. Inv # 11

7. Hame L3 13. Inv Amt 22
8. Date 4o 14. Discount 46
9. Check # 5o 15. Payment 34
18. Page # 75 16. Hemo 58

11. Inv Date 2

Vouchers, Checks
Line to Change {(F2-Cont), D-Delete, F4-Backup ..

Arrows: Up-Prev Rec, Down-Mext Rec, Pqup-First Rec, Pgdn-Last Rec
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Static Control F/M (APF980)

Function

This program allows the user to create and maintain the company AP Static
Control record. The AP Static Control record is critical to the proper functioning
of the AP system. The record contains information which the AP system
references in performing various functions.

CAUTION: It is strongly advised that a password be used for this program.
Changes should be made only with extreme caution and under the supervision
of your dealer.

User Inputs

The following inputs are involved in creating the company AP static control record:

Financial Screen
1. Bank

Enter the bank code of the standard AP bank. This bank becomes the default
value throughout the AP system where a bank code is required. The entry must
be a valid bank code. CR initially defaults to the first bank on file. F2 allows a
search (ref. 7).

2. Use Check Reconciliation

Enter Y or N to indicate whether the check reconciliation programs will be used
for AP Checks in the Banking and Check System in System Management. If N is
entered, Check Reconciliation will not be available for AP checks (Reconcile
Checks, Check Listing and Check Reconciliation F/M programs are not available
for AP checks). CR initially defaults to Y.

3. GL Distribution

The Accounts Payable system may post to general ledger automatically. The
Document Entry and Check Registers may print a general ledger distribution and
make a journal posting to GL during the update. Enter 0,1, 2, or 3 to indicate
how AP is tied in with general ledger. CR initially defaults to 0.

4. GL Expense Journal

If 0 or 1 was entered in input #5, this input is skipped. Enter the general ledger
journal number to post to for the expense posting of the Document Entry &
Adjustments Register. The entry must be a valid journal number. F2 allows a
search (ref. 7).

5. GL Disbursements Journal

If 0 or 1 was entered in input #5, this input is skipped. Enter the general ledger
journal number to post to for the disbursement posting of the Check Register.
The entry must be a valid journal number. F2 allows a search (ref. 7).
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6. Post By Branch

Enter N or Y to indicate whether to insert the branch in the G/L# when posting
to general ledger. If set to Y, when entering documents in the Document Entry
program, the branch assigned to the document is inserted in the GL account
numbers displayed from the GL posting table. When posting to GL in the
Document Entry and Check Registers, the branch assigned to the document is
inserted in the Accounts Payable and Discounts GL account numbers.

Note that the Post by Branch setting only applies to non-expense portions of the
AP Document. The GL number for the expense side of an AP Document can be
for any branch, regardless of whether “Post by Branch” is selected (set to Y) on
AP Static Control F/M.

7. Use Period Check Register

Enter Y or N to indicate whether the Period Check Register will be used. If N is
entered, the Period Check register will not be available. CR initially defaults to Y.
8. Use Period Expense Report

Enter Y or N to indicate whether the Period Expense Distribution will be used. If

N is entered, the Period Expense Distribution will not be available. CR initially
defaultsto Y.

9. Use Period Disbursement Report
Enter Y or N to indicate whether the Period Disbursement Distribution will be

used. If N is entered, the Period Disbursement Distribution will not be available.
CR initially defaults to Y.

General Screen
1. Number Of Periods Paid Documents Stored
Enter the maximum number of periods to store information regarding paid off

documents for report and inquiry purposes (0-99). CR initially defaults to 3; 0
indicates that paid documents are not stored.

2. Number Of Days Auto Increment

The Cash Requirement Reports in accounts payable and purchase orders print
amounts due in each of several columns. The user has the ability to determine
the number of days in each column. The number of days (1-99) entered here will
become the default value for the input on the Cash Requirement Reports. This is

also used as the default lead time in the Payment Selection by Date program. CR
initially defaults to 7.

3. 1099 EOY Period

Enter the end-of-year period for 1099 purposes (i.e., the fiscal period for
December). CR initially defaults to the last period of the fiscal year.

0 - no GL distribution is printed or posted.
1 - the GL distribution is printed (printing is in detail format) but not posted to GL.
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2 - the GL distribution is printed (printing is in detail format) and posted to GL in summary

(posting includes the total amount posted to each account number).

3 - the GL distribution is printed (printing is in detail format) and posted to GL in detail
(posting includes each item contributing to the amount for each account number).

4. YTD Roll Period

Enter the fiscal period when year-to-date purchase history figures in the vendor
file should be rolled to the prior year. CR initially defaults to the last period of
the fiscal year.

5. Use Payment History

Enter Y or N to indicate whether monthly payment history will be used. If N is
entered, the Payment History Report will not be available. CR initially defaults
toY.

6. Use Vendor Ledgercards

Enter Y or N to indicate whether to use vendor ledgercards. If N is entered,
ledgercards will not be available. CR initially defaults to Y.

7. Use Job Cost

Enter Y or N to indicate whether Job Cost is to be used and tied into Accounts
Payable. CR initially defaults to N.

8. Aging - First Cutoff

Enter the first aging cutoff (number of days) to be used to determine the second

column on the Aged Payables Report. CR initially defaults to 30. The first
column is CURRENT.

9. Aging - Second Cutoff

Enter the second aging cutoff (number of days) to be used to determine the third
column on the Aged Payables Report. CR initially defaults to 60.

10. Aging - Third Cutoff

Enter the third aging cutoff (number of days) to be used to determine the fourth

column on the Aged Payables Report. CR defaults to 90 initially. The fifth
column is OVER 90 if 90 is entered.

Technical Notes
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L2 A/P Static Control F/7M [APF930)

L Win with ProvideX
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Nonstatic Control F/M (APF990)

Function

This program allows the user to create and maintain the company AP Nonstatic
Control record. The AP Nonstatic Control record is critical to the proper
functioning of the AP system. The record contains information which the AP
system references in performing various functions.

CAUTION: It is strongly advised that a password be used for this program.
Changes should be made only with extreme caution and under the supervision
of your dealer.

User Inputs

The following inputs are involved in creating the nonstatic control record:
*1. Current AP Balance

This field should initially be set to 0. It will be updated by the system when
documents are entered, checks are written or the Vendor Balancing Register is
run. CRinitially defaults to 0.

2. Current AP Period

Enter the current accounts payable period (PPYY). CR initially defaults to the
current GL period and must be in the current or next GL period. After initial
entry, this field will be updated by the End-of-Period Update program.

3. Date of Last End-of-Period Update
Enter the date of the last End-of-Period Update in accounts payable (ref. 2). After

the initial entry, this field will be updated by the End-of-Period Update program.
CR initially defaults to 010100.

4. Last Recurring Post Date
Enter the date of the last recurring payables posting (ref. 2). After initial entry,

this field will be updated by the Post Recurring Payables Update program. F1
defaults to NA (not applicable). CR initially defaults to NA.

Inputs #5-10 are used by the system to keep track of register numbers and are maintained by the
system.

*5-10. Register Numbers

These numbers keep track of the last register number used. As a register is
updated, the last number used is incremented by one. Upon installation, these
fields should be set to 0. These fields will automatically be updated through
normal processing. CR initially defaults to 0.

11. Last Vendor Number Used

Enter the last vendor number used when the system automatically assigns
vendor numbers in the Vendor F/M. If F1-NEXT is used to enter the vendor
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number in the Vendor F/M, the first vendor number will be 1. CR initially
defaults to blank.
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* indicates that changing the field after initial installation may have serious repercussions. Please refer
to your dealer before any changes are made.

Technical Notes

FILES UPDATED - SMCNTL
IS B3

Save
¥ Delete
FT
Last U et |

Date of EQOP Update (0853119397
Recurring Post Date  |10001/1 997 jgﬂ

;2 Monstatic Control F/M [APF390)

Current AP
Balance
Period

Renister Trace #
Document Entry Reo#
Check Register #

Ba72
1419
0355

Wendor Balancing Reg# aozo
Document Removal Reg# onag
Document Change Reg# 01349

Wendor# Used

WTW

Enter Current Accounts Payahle Balance

L Win with ProvideX _ O]
Help
81-Demo Company Honstatic Control F/H nPrF9od
Current AP
1. Balance 34858 .95
2. Period 8971997 SEP
Last
3. Date of EOP Update 08/31/1997
4. Recurring Post Date 18781/1997
5. Register Trace # 6572
6. Document Entry Reqgit 1519
7. Check Register # 8355

8. Uendor Balancing Reg# 0828
9. Document Removal Regit B9@58
18. Document Change Regl# 8139
11. Uendor # Used 8

Line to Change {F2-Cont), D-Delete, F4-End ..
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Rebuild AP Sort Files (APU990)

Function

This program allows the user to rebuild sort files which may not be up to date
with the rest of the system.

Sort files are used throughout the FACTS system to enable the user to report or
retrieve information in an order other than the order in which the main file is
stored in. For example, the records of the customer file are stored in customer
number order. To access this file in alphabetical order requires a sort file which
is stored by an alpha look up by customer number. The corresponding record in
the main file may then be accessed for the needed information.

The Rebuild AP Sort Files program should only be run under the supervision of
your dealer.

User Inputs

The following inputs are involved in rebuilding AP sort files:
1. APVALX

Enter N or Y to indicate whether to rebuild APVALX. This file is the AP vendor
by alpha sort file to the AP vendor file (APVEND). The file is used in the various
AP reports which can be printed alphabetically. CR defaults to N.

2. APCLSX

Enter N or Y to indicate whether to rebuild APCLSX. This file is the AP vendor
by vendor class sort file to the AP vendor file (APVEND). The file is used in the
various AP reports which can be printed by vendor class. CR defaults to N.

3. APDOCX

Enter N or Y to indicate whether to rebuild APDOCX. This file is the AP
document sort to the document entry & adjustments file (APDOCM). This file is
used in the AP Document Entry & Adjustments Register. CR defaults to N.

4. APCONX

Enter N or Y to indicate whether to rebuild APCONX. This file is the vendor by
vendor contact sort file to the AP vendor file (APVEND). This file is used during
the contact search in the Vendor Search Program. CR defaults to N

Technical Notes

FILES USED - SMCNTL, APDOCM, APVEND
FILES UPDATED - APDOCX, APVALX, APCLSX, APCONX
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™\ Rebuild AP Sort Files (APU990) BEE
Help

81-FACTS 7.5 Development REBUILD AP SORT FILES APU99E
APUALY |
NPCLEX

APCONX

THIS PROGRNH IS MOT TO BE RUH WITHOUT SYSTEH MAMNCER'S SUPERVISIOH?
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1. Alignment- An alignment check is often desired to ensure that forms paper is correctly aligned
in the printer. Enter Y or N to indicate whether to print an alignment. CR defaults to N and no
alignment check is printed. If Y is entered, the alignment check prints immediately and the program

returns to this input.

2. Date - Dates will be displayed according to the format set in the Company Control Record. For
viewing purposes, all dates will be displayed with a two digit year. For editing purposes, all dates
will allow the entry and display of a four digit year. An entry date can be viewed in its entirety by
using the left and right arrow keys or by using the HOME and END keys to scroll through the date

field. The system will allow the full date or a partial date to be entered.

Special dates that were previously displayed and stored as 01/01/00 and 12/31/99 will no longer be
handled in the same manner. Tag names such as NONE, ASAP, FIRST, LAST, etc. will now be used in
place of “generic” dates. These tag names will also be accepted as the valid input dates in some data

entry prompts.

If you are upgrading from FACT 6.05 (or earlier) to FACTS 6.06 (or later), the dates stored in your
system are converted for you behind the scenes. Dates that display as **/**/** indicate that data is
present for the field but the system does not know how to interpret the date. Contact your affiliate for

support.

The Rule of 50: FACTS programs uses a “rule of 50” logic to expedite date processing. If the two
digit year is greater than or equal to 50, the system will assume the date to be in the 1900s; if the two
digit year is less than 50, the system will assume the date to be in the 2000s.

During data entry, if the system is unable to interpret the date entered, the date mask will be
displayed in the prompt. If the system is able to interpret the date entered, the date will be displayed
in the prompt. Dates prior to 01/01/1800 or after 12/31/2199 are not allowed during date entry.

FACTS programs contain 8-character and 10-character date fields. The date editing/entry display
varies slightly depending on whether it is an 8-character or 10-character field. When editing a date,
using the right arrow or the END key, will advance the cursor to the end of the date field and using
the left arrow or the HOME key, will advance the cursor to the beginning of the date field.

8-Character Date Field

10-Character Date Field

When entering a date in the 1900s (as
defined by the 50-rule), the date will be
displayed as follows:

ORDERED 01/02/96<

ORDERED 01/02/96 <

Use the right arrow key or the END key
to display the full 4-digit year:

ORDERED /02/1996<

ORDERED 01,/02/1996<
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A plus sign at the end of the date field

indicates that the year is not in the
default century. ORDERED 01/02/96+ ORDERED 01/02/2096<

3.

Order - In various reports, payment selection and transfer/change codes, the order choice may

be selected. The options are by V-vendor number, A-alpha sort or C-vendor class. For example, the
user may want to print in vendor class order. CR defaults to V.

4.
(C) was selected above, the user selects the beginning vendor class to process. CR defaults to FIRST
(the first vendor class on file).

5.

Beginning Order Choice - Enter the beginning order choice to be selected, e.g., if vendor class

Ending Order Choice - Enter the ending order choice to be selected, e.g., if vendor class (C) was

selected above, the user selects the ending vendor class to process. CR defaults to LAST (the last
vendor class on file).

6.

Prompt-Selection Input - This refers to the flashing cursor usually found in the lower right hand

corner of a screen. This prompt allows the user to perform a number of functions:

A-2

# - Changes a line-item. Line-items may be changed or deleted by entering the corresponding
line number. During this change routine, F1 allows the currently displayed value to remain the
same.

L - Lists line-items. A limited number of line-items appear on the screen at any one time. The
list function allows line-items to be redisplayed. The user selects the beginning line number to
list.

A - Adds aline-item. Line-items may be added as needed.

D - Deletes the document/adjustment. The document/adjustment may be deleted at any time.
The screen is cleared and the program returns to the vendor number input to await further
entries.

F2 - Changes header. Header information in the upper portion of the screen may be changed as
necessary. During this change routine, F1 allows the currently displayed value to remain the
same.
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F3 - Accesses the ending routine. F3 ends entry of the document which clears the screen of the
information just entered and returns to the vendor number input to await further entries.

7.  Searches - Search features allow you to search for various fields (example: salesperson/ territory)
when little or no information is known about them. The search displays in a separate screen. The
user may enter a search key, continue to view the search fields, select the line number of one of the
fields displayed, or return to the program input.

8. Vendor Search - Vendor information can be searched alphabetically, as well as by contact name
and vendor number. To switch between search orders, press F2 and select one of the options from the
popup window that appears.

Press F1 to restrict a search by class, keyword or the first several characters of the vendor number.
(These restrictions appear in the program as Class, Keyword, Vendor # Starts With.)

LINE #+W TO DISPLAY WAREHOUSE QUANTITIES

F2-CHANGE SEARCH ORDER: ALPHA. IWTERCHANGE, ITEM MUMBER, CLASS

ENITER BEG ALFHA. F1-3ET RESTRICTIONS, F3-ALT SHCH, F4-BKUP ....................
ARBOMS = UP=PREEUIOUS. DOMMN=MERT. LEFT=FGUF. RIGHT=PGIM

Search shortcuts. As shown in the graphic above, search order and restrictions are represented by
bold, underlined letters. If you combine these letters at the entry prompt with first several characters
of the item you are searching for, followed by F1 or F2, you can reduce the number of steps it takes to
switch search orders or set restrictions. In a vendor search, for example, you can find vendors with
contacts named Ellis by entering CK.Ellis at the entry prompt and then press F1 or F2. Following are
more examples of search shortcuts.

If you want to... Then...
Switch to an Item Number search Enter N plus F2
Switch to an Item Number search and begin your search at Enter N.I310 plus F2

entries starting with 1310

Switch to an Alpha search order and set a keyword restriction | Enter AK.ladder plus F1 or F2
of ladder

9. Sync - Sync is a method of connecting information entered in Sales Orders with information
displayed in customer, item and vendor inquiries. Itis a very useful tool if you are using any form of
windowing because you can quickly switch from Sales Orders to the inquiries that have been
connected.
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NOTE: Sync is used in inquiries to Sales Order Entry is based on user code. This means that if
you logged into FACTS in one window under one name and signed into another window under
another name, it will appear as if the Sync function is not working.

Sync can be initiated or disabled by pressing F1 from the following screens:
e SO Customer Inquiry SOI610
e AP Vendor Inquiry API610
¢ AR Customer Inquiry ARI610

¢ ICItem Inquiry ICI610

While in Sync mode, the inquiry program will examine a file called SMUSED approximately
every three seconds. This file contains the last customer number, item number and vendor
number input in Sales Order Entry. If this number is different than the one currently being
displayed in the inquiry, the inquiry will change its display to show information on this new
customer, item or vendor.
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Branch - Branch number is used throughout the FACTS system. Branches may be referred to as
stores or profit centers, divisions within an organization. The system will default various branch
prompts to the branch set up in System Management Terminal F/M for each user. The posting
tables for each module may be set up so that the branch number is automatically inserted into the
General Ledger Account number when the system creates its journal entries. Inquiries and reports
may be run by branch.

Department - GL departments are used to track revenues and expenses by division. The GL
department is imbedded in the G/L number for posting purposes. General Ledger financial reports
may be printed by department.

Document Groups - Optionally, vendors may be assigned a document group. The most common use
of the document group is to flag vendors receiving 1099’s with a specific group number for printing
1099’s. Various AP reports allow the user to print the report for selected document groups.

G/L # (General Ledger account number) - G/L numbers are set up through the GL Account F/M
program. GL account numbers are user-defined and are used throughout the FACTS system for
posting purposes to GL.

Journal Number - Journal numbers are used for separating journal entries in GL by type of entry
(example: sales, payroll, receivables, etc.). Each module determines the journal number to post the
transactions of that module to in general ledger.

Ledgercards - Vendor ledgercards provide a detail history of every transaction for a vendor (i.e., any
invoices entered, checks written). Each vendor in the vendor file has a choice of whether to store
ledgercards. Ledgercards include information for each transaction such as the date, transaction type
and debit or credit amount. Ledgercard information is available for display through the Vendor
Inquiry and may be printed through the Vendor Ledgercards print. Ledgercards may be removed
through the Vendor Ledgercard Removal program.

Manual Checks - The AP Manual Check entry program allows the user to enter and record manual
checks that have been written against a payable that is currently in the open payables file.

Noninvoice Checks - The AP Noninvoice Check entry program allows the user to pay a document
that is not in the open payables file. This entry program allows for the document to be entered,
expensed and the payment recorded in one process. Recording COD payments are the most
common use of this program.

Temporary Item Lead Time - Lead time is the number of days from the date a purchase order is
placed for an item until the date the item is received. Lead time data for stocked items is maintained
by the system; the temporary lead time prompt provides the capability of manually providing lead
time information for temporary items used in Blanket Sales Order entry.

Permanent/Temporary Vendors - The system allows flagging each vendor as permanent or
temporary so that the AP Vendor file can be routinely purged of unnecessary records. At the end of
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B-2

the period, if the vendor has a zero balance and has been flagged Temporary, the vendor will be
removed from the system.

Recurring Documents - Documents that are paid repetitively such as rent or loan payments can be
set up once in the Recurring Document system specifying the amount of the payable, the dates to
post the associated invoice and a predetermined cutoff date.

Sequence Number - Sequence number is the numbering scheme (from 01 to 99) used on recurring
AP documents. The use of sequence numbers allows multiple recurring payable documents to be
entered for each vendor.

Terms Code - Terms codes are created and maintained through Account Payable Terms Code F/M
and Accounts Receivable Terms Code F/M. Terms codes are used in calculating invoice due dates,

and discount information.

Vendor Class - Vendor classes are used as a way of categorizing groups of vendors. A GL table is
associated with each class. This GL table will be used as a default entry when using Vendor F/M.
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PROGRAM NAME

APR110
APRI112
APR120
APR210
APR220
APR310
APR310
APR310
APR312
APR710
APR720
APR730
APR740
APR750
APR750
APRT755
APP710
APP720
APR760
APR770
APP730
APRS10
APRS820
APRS30
APR840
APRS850

Document Entry & Adjustment Register
Document Entry Register G/L Distribution

Recurring Document Listing
Payment Selection List
Hold List

Sample Accounts Payable Check Printout

Accounts Payable Check Register
Noninvoice Check Register

Accounts Payable Check Register G/L Distribution

Cash Requirements Report

Open Payables Report

Aged Payables Report

Inactive Vendor Listing

Vendor Listing - General Information
Vendor Listing - History Information
Vendor Ledgercards

Vendor Label Print

Rolodex Vendor Card Print

Purchase History Report

Payment History Report

1099 Print

Period Check Register

Period Expense Distribution

Period Disbursement Distribution
Register History Report

Document Removal Register
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Document Entry Register
DATE: 09/28/02
USER: SSI ToX

PERIOD 09/02 SEP

DEMO COMPANY
DOCUMENT ENTRY & ADJ REGISTER #1512

Sample Reports

APR110 PAGE: 1
TIME: 8:53 AM

BRANCH 01

GL e DATE---—-——————— GROSS ALLOWABLE ----GL DISTRIBUTION------
VENDOR NAME DOCUMENT BR TBL PO# ENTRY DUE DISCOUNT AMOUNT DISCOUNT G/L# AMOUNT

Document Entries
V103 OFFICE PRODUCTS IN 13589 01 001 004985 09/28/02 10/28/02 10/08/02 126.11 1.26 620-01-1 120.11
540-01-1 6.00
V111l ATLANTA GAS COMPAN 321981 01 002 000065 09/28/02 10/08/02 10/08/02 259.93 .00 790-01-1 247.55
540-01-1 12.38
V118 GEORGIA INSURANCE 321981 01 004 015651 09/28/02 10/28/02 10/28/02 208.83 .00 780-01-1 198.89
540-01-1 9.94
V122 PREMIUM INSURANCE 321918 01 004 000654 09/27/02 10/27/02 09/27/02 744.99 .00 750-01-1 709.51
540-01-1 35.48

DOCUMENT TOTAL 1339.86 1.26

BEGINNING AP BALANCE
ENTRYc TOTAL
ADJUSTMENT TOTAL
ENDING AP BALANCE

DOCUMENTS: 4

44696.38
1339.86

.00

46036.24

END OF REGISTER

Copyright © 1984-2005 Infor, inc.



Accounts Payable—7.50

Document Entry Register GL Distribution

DATE: 09/28/02
USER: SSI ToX

GL PERIOD 09/02 SEP

DEMO COMPANY

AP ENTRY REGISTER GL DISTRIBUTION #1512

Sample Reports

APR110 PAGE: 1
TIME: 8:53 AM

G/L# DESCRIPTION VENDOR NAME DOCUMENT DEBIT CREDIT NET
310-01-0 ACCOUNTS PAYABLE V103 OFFICE PRODUCTS INTERNATIO 13589 126.11
V11l ATLANTA GAS COMPANY 321981 259.93
V118 GEORGIA INSURANCE SERVICES 321981 208.83
V122 PREMIUM INSURANCE COMPANY 321918 744.99
ACCOUNT TOTAL 00 1339.86 (1339.86)
540-01-1 SALES TAX V103 OFFICE PRODUCTS INTERNATIO 13589 6.00
V111l ATLANTA GAS COMPANY 321981 12.38
V118 GEORGIA INSURANCE SERVICES 321981 9.94
V122 PREMIUM INSURANCE COMPANY 321918 35.48
ACCOUNT TOTAL 63.80 .00 63.80
620-01-1 OFFICE EXPENSE V103 OFFICE PRODUCTS INTERNATIO 13589 120.11
ACCOUNT TOTAL 120.11 .00 120.11
750-01-1 INSURANCE EXPENSE V122 PREMIUM INSURANCE COMPANY 321918 709.51
ACCOUNT TOTAL 709.51 .00 709.51
780-01-1 LEGAL & PROFESSIONAL V118 GEORGIA INSURANCE SERVICES 321981 198.89
ACCOUNT TOTAL 198.89 .00 198.89
790-01-1 UTILITIES V111l ATLANTA GAS COMPANY 321981 247.55
ACCOUNT TOTAL 247.55 00 247.55
REPORT TOTAL 1339.86 1339.86 00

ACCOUNTS: 6

Copyright © 1984-2005 Infor, Inc

END OF GL DISTRIBUTION
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Accounts Payable—7.50 Sample Reports

Recurring Document Listing
DATE: 09/28/02 DEMO COMPANY APR120 PAGE: 1
USER: SSI ToX RECURRING DOCUMENT LISTING TIME: 8:58 AM

VENDOR FIRST TO LAST
ALL DOCUMENTS, DATE 09/20/02-09/28/02
CURRENT PERIOD 09/02

DOC GL POST ----DOCUMENT AMOUNT---- CUT ---TO DATE----
SQ GRP TBL TC BRANCH PO# DAY MONTHS STANDARD THIS PD OFF # AMOUNT MEMO STATUS
Vendor V103 OFFICE PRODUCTS INTERNATIONAL
01 02 001 30 01 325624 10 010203040506070809101112 314.42 314.42 N 2 1257.66 COMPUTER MAINTENANCE U
02 02 001 30 02 623452 10 010203040506070809101112 155.96 155.96 N 2 623.84 COMPUTER MAINTENANCE U
Vendor V118 GEORGIA INSURANCE SERVICES
01 02 004 30 01 345634 10 010203040506070809101112 395.89 395.89 N 2 791.78 INSURANCE PREMIUMS U
02 02 004 30 02 672354 10 010203040506070809101112 197.98 197.98 N 2 395.96 INSURANCE PREMIUMS U
SQ=SEQUENCE NUMBER, TC=TERMS CODE, CUTOFF BASIS: A=AMOUNT, D=DATE, N=NUMBER OF PAYMENTS
STATUS: U=UNEXPIRED, P=POST THIS PERIOD, C=COMPLETED THIS PERIOD, E=EXPIRED, *=UNABLE TO POST
DOCUMENTS: 4 END OF REPORT

C-4 Copyright © 1984-2005 Infor, inc.



Accounts Payable—7.50

Payment Selection List
DATE: 09/28/02
USER: SSI ToX

ALPHA FIRST TO LAST

DEMO COMPANY
PAYMENT SELECTION LIST

Sample Reports

APR210 PAGE: 1
TIME: 8:59 AM

BRANCH 01
DOC -—————=———- DATE---————=——— ———— CURRENT DOCUMENT--- —---——-- PAYMENT--------
VENDOR NAME DOCUMENT GRP  ENTRY DUE  DISCOUNT AMOUNT DISCOUNT AMOUNT DISCOUNT
V100 GENERAL INDUSTRIAL MFG 1345 01 09/10/02 09/30/02 09/10/02 88.88 1.77 88.88 00*
VENDOR TOTAL gg_gg _______TBB
V110 GEORGIA SHIPPING EQUIP. CO. 1325 01 08/29/02 09/28/02 08/29/02 1908.68 .00 1908.68 00*
VENDOR TOTAL  1908.68 .00
V101 INDUSTRIAL SUPPLY DISTRIBUTORS 1335 01 09/03/02 10/03/02 09/13/02 1301.79 11.52 1301.79 00*
VENDOR TOTAL  1301.79 .00
V107 LIGHTNING COURIER SERVICE 14825 02 09/24/02 10/04/02 09/24/02 8.55 .00 8.55 00*
4512368753 02 09/14/02 09/24/02 09/24/02 34.78 .00 34.78 00*
VENDOR TOTAL ;;_;; _______TBB
V114 LINDA'S FLOWER SHOP 1254589365 02 09/21/02 10/20/02 10/10/02 219.64 .00 219.64 00*
VENDOR TOTAL ____51;_;; _______TBB
V115 NATIONAL CONVEYORS, INC. 1357 01 09/17/02 09/30/02 09/10/02 181.39 3.33 181.39 00*
VENDOR TOTAL ____151_;; _______TBB
V122 PREMIUM INSURANCE COMPANY 98198198 02 08/31/02 09/30/02 08/31/02 197.98 .00 197.98 00*
VENDOR TOTAL ____1;;_;5 _______TBB
V102 S.E. INDUSTRIAL PROD. & EQUIP. 1340 01 09/04/02 10/04/02 09/04/02 2948.59 .00 2948.59 00*
VENDOR TOTAL ___5;55_;; _______TBB
V116 WORLD MATERIALS HANDLING CO. 1351 01 09/13/02 09/30/02 09/10/02 238.42 4.77 238.42 00*
VENDOR TOTAL ____555_55 _______TBB
REPORT TOTAL ___$I§§_§5 _______féé
DOCUMENTS: 10 END OF REPORT

Copyright © 1984-2005 Infor, Inc



Accounts Payable—7.50

Hold List

DATE: 09/28/02

DEMO COMPANY

Sample Reports

APR220 PAGE: 1

USER: SSI ToX HOLD LIST TIME: 9:01 AM
ALPHA FIRST TO LAST
BRANCH 01
DOC ——————————— DATE---————————
VENDOR NAME DOCUMENT GRP ENTRY DUE DISCOUNT AMOUNT DISCOUNT HOLD MEMO
V110 GEORGIA SHIPPING EQUIP. CO. 1350 01 09/12/02 10/12/02 09/12/02 230.40 .00 DISPUTE RE: DAMAGE
VENDOR TOTAL 230.40 .00
V119 INDUSTRIAL CHEMICALS INC. 1343 01 09/07/02 10/30/02 10/10/02 1342.54 25.85 APPARENT OVERCHARGE
VENDOR TOTAL 1342.54 25.85
V102 S.E. INDUSTRIAL PROD. & EQUIP. 1356 01 09/17/02 10/17/02 09/17/02 269.34 .00 ALLOWANCE FOR DEFECT
VENDOR TOTAL 269.34 .00
REPORT TOTAL 1842.28 25.85

DOCUMENTS: 3

C-6

END OF REPORT
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Accounts Payable—7.50 Sample Reports

Sample Check Printout

V122 PREMIUM INSURANCE COMPANY
09/28/02 003100 1
08/31/02 98198198 197.98 .00 197.98
197.98 .00 197.98

003100 09/28/02

ONE HUNDRED NINETY SEVEN AND 98/100 DOLLARS *xAxx]197.98

PREMIUM INSURANCE COMPANY
9272 CROGAN STREET

ATLANTA, GA 30309

Copyright © 1984-2005 Infor, Inc C-7



Accounts Payable—7.50

AP Check Register
DATE: 09/28/02
USER: SSI ToX

REGISTER DATE: 09/28/02

DEMO COMPANY

AP CHECK REGISTER #0353

BANK 01 FIRST NATIONAL BANK OF ATLANTA

PERIOD 09/02 SEP

Sample Reports

APR310 PAGE: 1
TIME: 9:05 AM

----DATE--- DISCOUNT
CHECK  DATE AMOUNT VENDOR NAME DOCUMENT ENTRY DUE PAYMENT TAKEN MEMO
REGULAR CHECKS
003071 09/28/02 1301.79 V101l INDUSTRIAL SUPPLY DIS 1335 09/03 10/03 1301.79 .00
003072 09/28/02 2948.59 V102 S.E. INDUSTRIAL PROD. 1340 09/04 10/04 2948.59 .00
003074 09/28/02 1908.68 V110 GEORGIA SHIPPING EQUI 1325 08/29 09/28 1908.68 .00
003075 09/28/02 219.64 V114 LINDA'S FLOWER SHOP 1254589365 09/21 10/20 219.64 .00 WEDDING ARR. FOR MR. THRY
003077 09/28/02 238.42 V116 WORLD MATERIALS HANDL 1351 09/13 09/30 238.42 .00
003078 09/28/02 .00 VOIDED - REPRINT CHECK
003100 09/28/02 197.98 V122 PREMIUM INSURANCE COM 98198198 08/31 09/30 197.98 .00
REGULAR CHECKS __5155_95
MANUAL & VOID CHECKS
003066 09/21/02 -1251.91 V108 GEORGIA NEWSPAPER 681681 08/24 09/23 -600.13 .00
3457124114 08/25 09/24 -651.78 .00
041851 09/28/02 72.08 V100 GENERAL INDUSTRIAL MF 1364 09/17 10/30 72.08 1.47
MANUAL & VOIDS _I§§§§_§§
REGISTER TOTAL __;I;I_II
CHECK REGISTER RECAP:
BEGINNING AP BALANCE 44696.38
-PAYMENTS 4141.11
-DISCOUNTS 1.47
ENDING AP BALANCE __ZBEESTQB
REGULAR, MANUAL, AND VOID CHECKS: 13

Copyright © 1984-2005 Infor, inc.



Accounts Payable—7.50

AP Noninvoice Check Register

DATE: 09/28/02
USER: SSI ToX

AP NONINVOICE CHECK REGISTER #0353

DEMO COMPANY

Sample Reports

APR310 PAGE: 2
TIME: 9:05 AM

AMOUNT DISCOUNT
CHECK DATE AMOUNT VENDOR NAME DOCUMENT DATE PAID TAKEN G/L# MEMO
041849 09/27/02 12.18 V107 LIGHTNING COURIER SERV 456813 09/27/02 12.18 .00 730-01-1 SERVICE CHARGE
041852 09/28/02 297.35 V113 ATLANTA CRANE & HOISTS 12512411 09/28/02 297.35 .00 175-01-0
REGISTER TOTAL 309.53

NONINVOICE CHECKS: 2

Copyright © 1984-2005 Infor, Inc

END OF REGISTER



Accounts Payable—7.50 Sample Reports

AP Check Register GL Distribution

DATE: 09/28/02 DEMO COMPANY APR310 PAGE: 1
USER: SSI ToX AP CHECK REGISTER GL DISTRIBUTION #0353 TIME: 9:05 AM

GL PERIOD 09/02 SEP

G/L# DESCRIPTION VENDOR NAME CHECK DOCUMENT DEBIT CREDIT NET
100-01-0 CASH V100 GENERAL INDUSTRIAL MF 003070 1345 88.88
041851 1364 72.08
V101 INDUSTRIAL SUPPLY DIS 003071 1335 1301.79
V102 S.E. INDUSTRIAL PROD. 003046 1299 1833.81
003072 1340 2948.59
V107 LIGHTNING COURIER SER 003073 14825 8.55
003073 4512368753 34.78
041849 456813 12.18
041850 1145525896 26.05
V108 GEORGIA NEWSPAPER 003066 681681 600.13
003066 3457124114 651.78
V110 GEORGIA SHIPPING EQUI 003074 1325 1908.68
V113 ATLANTA CRANE & HOIST 041852 12512411 297.35
V114 LINDA'S FLOWER SHOP 003075 1254589365 219.64
V115 NATIONAL CONVEYORS, I 003076 1357 181.39
V116 WORLD MATERIALS HANDL 003077 1351 238.42
V122 PREMIUM INSURANCE COM 003100 98198198 197.98
ACCOUNT TOTAL 3085.72 7536.36 (4450.64)
175-01-0 INVENTORY V113 ATLANTA CRANE & HOIST 041852 12512411 297.35
ACCOUNT TOTAL 297.35 .00 297.35
310-01-0 ACCOUNTS PAYABLE V100 GENERAL INDUSTRIAL MF 003070 1345 88.88
041851 1364 73.55
V101 INDUSTRIAL SUPPLY DIS 003071 1335 1301.79
V102 S.E. INDUSTRIAL PROD. 003046 1299 1833.81
003072 1340 2948.59
V107 LIGHTNING COURIER SER 003073 14825 8.55
003073 4512368753 34.78
041850 1145525896 26.05
V108 GEORGIA NEWSPAPER 003066 681681 600.13
003066 3457124114 651.78
V110 GEORGIA SHIPPING EQUI 003074 1325 1908.68
V114 LINDA'S FLOWER SHOP 003075 1254589365 219.64
V115 NATIONAL CONVEYORS, I 003076 1357 181.39
V116 WORLD MATERIALS HANDL 003077 1351 238.42
V122 PREMIUM INSURANCE COM 003100 98198198 197.98
ACCOUNT TOTAL 7228.30 3085.72 4142.58

C-10 Copyright © 1984-2005 Infor, inc.



Accounts Payable—7.50 Sample Reports

AP Check Register GL Distribution (cont'd)

490-01-1 DISCOUNTS TAKEN V100 GENERAL INDUSTRIAL MF 041851 1364 1.47

Accoowr ToTAL .00 147 (1.4
730-01-1 POSTAL EXPENSE V107 LIGHTNING COURIER SER 041849 456813 12.18

AccouNT TOTAL 128 .00 12.18
DATE: 09/28/02 DEMO COMPANY APR310 PAGE: 2
USER: SSI ToX AP CHECK REGISTER GL DISTRIBUTION #0353 TIME: 9:05 AM
G/L# DESCRIPTION VENDOR NAME CHECK DOCUMENT DEBIT CREDIT NET

REPORT TOTAL  10623.55  10623.55 .00
ACCOUNTS: 5 END OF GL DISTRIBUTION

Copyright © 1984-2005 Infor, Inc C-n



Accounts Payable—7.50

Cash Requirements Report

DATE:
USER:

09/28/02
SSI ToX

ALPHA FIRST TO LAST
HOLDS INCLUDED

DEMO COMPANY

CASH REQUIREMENTS REPORT

Sample Reports

APR710 PAGE: 1
TIME: 9:09 AM

BRANCH 01; BASED ON DUE DATE
——————————————————————————————————— DATES-——————————— e
VENDOR NAME BALANCE THRU 09/28 09/29-10/05 10/06-10/12 10/13-10/19 10/20-10/26 10/27-11/02
V117 D'ANCONIA COPPER AND ELECTRIC 982.33 .00 .00 .00 982.33 00 00
V109 FIRST BANK OF THE SOUTH 160.77 .00 .00 .00 160.77 .00 .00
V100 GENERAL INDUSTRIAL MFG 1193.43 .00 88.88 .00 .00 .00 1104.55
V118 GEORGIA INSURANCE SERVICES 1050.00 .00 .00 .00 .00 1050.00 .00
V108 GEORGIA NEWSPAPER 373.37 .00 .00 .00 347.12 26.25 00
V110 GEORGIA SHIPPING EQUIP. CO. 4319.57 1908.68 .00 2065.54 345.35 .00 .00
V112 GRANDE HOTEL 959.21 .00 .00 .00 420.43 538.78 .00
V101 INDUSTRIAL SUPPLY DISTRIBUTORS 1819.06 .00 1301.79 .00 517.27 .00 .00
V119 INDUSTRIAL CHEMICALS INC. 3732.98 .00 .00 .00 .00 .00 3732.98
V107 LIGHTNING COURIER SERVICE 43.33 34.78 8.55 .00 .00 .00 00
V114 LINDA'S FLOWER SHOP 219.64 .00 .00 .00 .00 219.64 .00
V115 NATIONAL CONVEYORS, INC. 362.78 .00 181.39 .00 .00 .00 181.39
V103 OFFICE PRODUCTS INTERNATIONAL 297.92 .00 .00 .00 127.82 170.10 .00
V122 PREMIUM INSURANCE COMPANY 279.09 .00 197.98 81.11 .00 00 00
V104 REARDEN METALS, INC. 171.43 .00 .00 68.11 103.32 00 00
V102 S.E. INDUSTRIAL PROD. & EQUIP. 3217.93 .00 2948.59 .00 269.34 00 00
V106 SANITATION SERVICES, INC. 332.27 .00 .00 .00 332.27 .00 .00
V121 SOUTHERN ELECTRIC COMPANY 2288.63 .00 .00 .00 .00 2288.63 .00
V105 WAREHOUSE EQUIPMENT UNLIMITED 3272.47 .00 .00 3272.47 .00 00 00
V116 WORLD MATERIALS HANDLING CO. 2724.92 .00 238.42 .00 .00 00 2486.50
REPORT TOTAL 27801.13 1943.46 4965.60 5487.23 3606.02 4293.40 7505.42

VENDORS: 20

END OF REPORT

Copyright © 1984-2005 Infor, inc.



Accounts Payable—7.50

Open Payables Report

DATE: 09/28/02
USER: SSI ToX

DEMO COMPANY

OPEN PAYABLES REPORT

APR720 PAGE: 3
TIME: 9:11 AM

DOC ----- ENTRY---- ——————-— ORIGINAL---—-—-—--- TRANSACTION CURRENT

VENDOR NAME DOCUMENT GRP PD DATE AMOUNT DISCOUNT TOTAL BALANCE
V102 S.E. INDUSTRIAL PROD. & EQUIP. 1340 01 09/02 09/04/02 2948.59 .00 .00 2948.59
1356 01 09/02 09/17/02 269.34 .00 .00 269.34

VENDOR TOTAL 3217.93

V106 SANITATION SERVICES, INC. 4516218732 03 09/02 09/14/02 332.27 .00 .00 332.27
5246256235 03 08/02 08/10/02 737.22 .00 737.22 .00

7456323563 03 08/02 08/11/02 1104.72 .00 1104.72 .00

VENDOR TOTAL 332.27

V121 SOUTHERN ELECTRIC COMPANY 13461346 03 08/02 08/10/02 182.56 .00 182.56 .00
98465654 03 09/02 09/25/02 2288.63 .00 .00 2288.63

5253856969 03 08/02 08/11/02 182.56 .00 182.56 .00

VENDOR TOTAL 2288.63

REPORT TOTAL 21803.74

OPEN DOCUMENTS: 57

Copyright © 1984-2005 Infor, Inc

END OF REPORT

Sample Reports



Accounts Payable—7.50

Aged Payables Report

DATE: 09/28/02
USER: SSI ToX

ALPHA FIRST TO V108

DEMO COMPANY

AGED PAYABLES REPORT

Sample Reports

APR730 PAGE: 1
TIME: 9:13 AM

AGING DATE 09/28/02
INCLUDING NEXT PERIOD
BRANCH 01
LAST e AGING-————————————mmm
VENDOR NAME PAYMENT BALANCE CURRENT 1-30 31-60 61-90 OVER 90
V117 D'ANCONIA COPPER AND 09/07/02 982.33 982.33 .00 .00 00 00
V109 FIRST BANK OF THE SOU 09/07/02 160.77 160.77 .00 .00 00 00
V100 GENERAL INDUSTRIAL MF 09/07/02 1193.43 1193.43 .00 .00 00 00
V118 GEORGIA INSURANCE SER 09/07/02 1050.00 1050.00 .00 .00 00 00
V108 GEORGIA NEWSPAPER 09/21/02 373.37 373.37 .00 .00 00 00
V110 GEORGIA SHIPPING EQUI 09/21/02 4319.57 4319.57 .00 .00 00 00
V112 GRANDE HOTEL 09/14/02 959.21 959.21 .00 .00 00 00
V101 INDUSTRIAL SUPPLY DIS 09/21/02 1819.06 1819.06 .00 .00 00 00
V119 INDUSTRIAL CHEMICALS 08/24/02 3732.98 3732.98 .00 .00 00 00
V107 LIGHTNING COURIER SER 09/21/02 43.33 8.55 34.78 .00 00 00
V114 LINDA'S FLOWER SHOP 09/14/02 219.64 219.64 .00 .00 00 00
V115 NATIONAL CONVEYORS, I 09/07/02 362.78 362.78 .00 .00 00 00
V103 OFFICE PRODUCTS INTER 09/07/02 297.92 297.92 .00 .00 00 00
V122 PREMIUM INSURANCE COM 09/14/02 279.09 279.09 .00 .00 00 00
V104 REARDEN METALS, INC. 09/07/02 171.43 171.43 .00 .00 00 00
V102 S.E. INDUSTRIAL PROD. 09/21/02 3217.93 3217.93 .00 .00 00 00
V106 SANITATION SERVICES, 09/07/02 332.27 332.27 .00 .00 00 00
V121 SOUTHERN ELECTRIC COM 09/07/02 2288.63 2288.63 .00 .00 00 00
REPORT TOTAL 21803.74 21768.96 34.78 .00 00 00

VENDORS: 18

END OF REPORT

Copyright © 1984-2005 Infor, inc.



Accounts Payable—7.50

Inactive Vendor Listing

DATE: 09/28/02
USER: SSI ToX

ALPHA FIRST TO LAST

DEMO COMPANY
INACTIVE VENDOR LISTING

A
T

Sample Reports

PR740 PAGE: 1
IME: 9:14 AM

YTD PURCHASES LESS THAN $ 5000.00
DOC DATE LAST LAST -—-HIGHEST BALANCE-- CURRENT ——-——-—-—-—-— PURCHASES--——-—--—
VENDOR NAME CLASS GRP OPENED PURCHASE PAYMENT DATE AMOUNT BALANCE YTD PYR
V109 FIRST BANK OF THE SOUTH C&T 02 04/15/02 09/14/02 09/07/02 08/04/02 490.83 221.21 3745.48 4322.72
V107 LIGHTNING COURIER SERVICE MIS 02 12/20/02 09/24/02 09/21/02 08/17/02 887.54 69.38 4340.17 5006.75
V114 LINDA'S FLOWER SHOP MIS 02 03/24/02 09/21/02 09/14/02 09/21/02 406.69 406.69 879.59 543.45
V122 PREMIUM INSURANCE COMPANY INS 02 12/05/02 09/25/02 09/14/02 09/07/02 533.88 491.88 2273.65 2936.41
V104 REARDEN METALS, INC. MIS 02 01/12/02 09/14/02 09/07/02 08/04/02 295.36 206.27 2325.26 2771.41
VENDORS: 5 END OF REPORT

Copyright © 1984-2005 Infor, Inc



Accounts Payable—7.50

Vendor Listing - General

DATE:
USER:

VENDOR

09/28/02
SSI ToX

NAME

DEMO COMPANY

VENDOR LISTING - GENERAL INFO

ALPHA

CLASS

TERMS

DOC
GRP

GL
TBL

HOLD P/T

OUR

Sample Reports

APR750 PAGE: 3
TIME: 9:17 AM

TAX

CUSTOMER # EXEMPT #

V103

V122

V104

V102

V106

V121

OFFICE PRODUCTS INTERNATIONAL
45121 NORTH DECATUR AVE.
ATLANTA, GA 30339
404-874-9334 /

MORGAN KING

PREMIUM INSURANCE COMPANY
9272 CROGAN STREET
ATLANTA, GA 30309
404-223-9214 /
ROBERT FLETCHER

SYLVIA ROBINSON

REARDEN METALS, INC.
34 NORTH BUFORD STREET
ATLANTA, GA 30309
404-991-8358 /
HANK REARDEN

GREG PAGANSON

S.E. INDUSTRIAL PROD. & EQUIP.

11908 N.E. EXPRESSWAY
ATLANTA, GA 30321
404-321-0944 /
JERRY CLARK

VICTOR

SANITATION SERVICES, INC.
9292 HURRICANE SHOALS
LAWRENCEVILLE, GA 30240
404-963-5333 /
JIMMY LARSON

SOUTHERN ELECTRIC COMPANY
219 CLAYTON STREET
LAWRENCEVILLE, GA 30248
404-968-9776 /
MARIAN HOWARD

DOC=DOCUMENT, P/T=PERMANENT OR TEMPORARY

VENDORS :

20

OFFICE PRO

PREMIUM IN

REARDEN ME

S.E. INDUS

SANITATION

SOUTHERN E

OFF

INS

INV

UTL

UTL

30

30

30

30

30

30

02

02

02

01

03

03

001

NO

NO

NO

NO

NO

NO

P

D9400-1

S900339

3409

D3433

L89032

458909

11944876

END OF REPORT
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Accounts Payable—7.50

Vendor Listing - History Information

DATE: 09/28/02
USER: SSI ToX

ALPHA FIRST TO LAST

DEMO COMPANY
VENDOR LISTING - HISTORY INFO

APR750 PAGE: 1

TIME:

9:18 AM

DATE LAST LAST ---HIGHEST BALANCE---
VENDOR NAME BALANCE OPENED INVOICE PAYMENT DATE AMOUNT HOLD
V113 ATLANTA CRANE & HOISTS .00 07/28/02 08/30/02 09/07/02 08/30/02 4243.29 NO
V111l ATLANTA GAS COMPANY 287.88 10/01/02 09/14/02 09/21/02 09/14/02 1390.92 NO
V117 D'ANCONIA COPPER AND ELECT 982.33 02/02/02 09/14/02 09/07/02 08/04/02 994.62 NO
V109 FIRST BANK OF THE SOUTH 221.21 04/15/02 09/14/02 09/07/02 08/04/02 490.83 NO
V100 GENERAL INDUSTRIAL MFG 2583.74 11/30/02 09/17/02 09/07/02 01/11/02 22114.72 NO
V118 GEORGIA INSURANCE SERVICES 2090.00 08/18/02 09/21/02 09/07/02 09/21/02 2090.00 NO
V108 GEORGIA NEWSPAPER 592.93 02/19/02 09/25/02 09/21/02 09/14/02 2428.87 NO
V110 GEORGIA SHIPPING EQUIP. CO 5205.92 11/30/02 09/19/02 09/21/02 08/16/02 33022.50 NO
V112 GRANDE HOTEL 959.21 03/25/02 09/21/02 09/14/02 09/14/02 5671.99 NO
V101 INDUSTRIAL SUPPLY DISTRIBU 2307.30 12/05/02 09/17/02 09/21/02 08/01/02 30302.03 NO
V119 INDUSTRIAL CHEMICALS INC. 3732.98 04/23/02 09/21/02 08/24/02 09/21/02 3732.98 NO
V107 LIGHTNING COURIER SERVICE 69.38 12/20/02 09/24/02 09/21/02 08/17/02 887.54 NO
V114 LINDA'S FLOWER SHOP 406.69 03/24/02 09/21/02 09/14/02 09/21/02 406.69 NO
V115 NATIONAL CONVEYORS, INC. 866.95 09/28/02 09/17/02 09/07/02 08/31/02 6044.81 NO
V103 OFFICE PRODUCTS INTERNATIO 764.39 09/14/02 09/25/02 09/07/02 08/10/02 940.75 NO
V122 PREMIUM INSURANCE COMPANY 491.88 12/05/02 09/25/02 09/14/02 09/07/02 533.88 NO
V104 REARDEN METALS, INC. 206.27 01/12/02 09/14/02 09/07/02 08/04/02 295.36 NO
V102 S.E. INDUSTRIAL PROD. & EQ 3217.93 07/18/02 09/17/02 09/21/02 01/11/02 21204.17 NO
V106 SANITATION SERVICES, INC. 553.46 07/06/02 09/14/02 09/07/02 08/10/02 2210.55 NO
V121 SOUTHERN ELECTRIC COMPANY 3093.15 07/06/02 09/25/02 09/07/02 09/25/02 3093.15 NO
V105 WAREHOUSE EQUIPMENT UNLIMI 9873.77 03/28/02 09/21/02 09/21/02 08/24/02 34345.07 NO
V120 WAREHOUSE INTERIORS, INC. 2727.24 05/13/02 09/14/02 09/21/02 01/11/02 29220.44 NO
V116 WORLD MATERIALS HANDLING C 3461.77 12/29/02 09/20/02 09/07/02 08/02/02 44258.19 NO
VENDORS: 23 END OF REPORT

Copyright © 1984-2005 Infor, Inc
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Accounts Payable—7.50

Vendor Ledgercards

DATE: 09/28/02

DEMO COMPANY

APR755 PAGE: 1

USER: SSI ToX VENDOR LEDGERCARDS TIME: 9:20 AM
ALPHA FIRST TO V103
DATE FIRST TO LAST
VENDOR NAME DATE TRANSACTION DEBIT CREDIT DOCUMENT REG#
V100 GENERAL INDUSTRIAL MFG BEGIN BALANCE 2688.17
09/07/02 CHECK REGISTER -2688.17 1315 0347
09/07/02 DOC ENTRY REG 1212.75 1339 1507
09/14/02 DOC ENTRY REG 88.88 1345 1509
09/14/02 DOC ENTRY REG 177.56 1355 1509
09/21/02 DOC ENTRY REG 1031.20 1361 1510
09/25/02 DOC ENTRY REG 73.55 1364 1511
09/25/02 DOC ENTRY REG -.20 1361 1511
ENDING BALANCE 2583.74
V101 INDUSTRIAL SUPPLY DISTRIBUTORS BEGIN BALANCE 2020.11
09/07/02 CHECK REGISTER -292.04 6025611863 0347
09/07/02 DOC ENTRY REG 1301.79 1335 1506
09/07/02 DOC ENTRY REG 222.00 1338 1507
09/07/02 DOC ENTRY REG -100.00 2865187182 1507
09/14/02 DOC ENTRY REG 61.22 1349 15009
09/14/02 CHECK REGISTER -137.60 2865187182 0350
09/21/02 CHECK REGISTER -61.22 1349 0351
09/21/02 DOC ENTRY REG 517.27 1359 1510
09/27/02 VENDOR BALANCE -1271.78 0020
09/25/02 DOC ENTRY REG 47.55 1365 1511
ENDING BALANCE 2307.30
V103 OFFICE PRODUCTS INTERNATIONAL BEGIN BALANCE 940.75
09/07/02 CHECK REGISTER -628.83 90081001 0346
09/07/02 CHECK REGISTER -311.92 90081002 0347
09/14/02 DOC ENTRY REG 127.82 1010553494 1508
09/14/02 DOC ENTRY REG 78.15 1561878921 1508
09/14/02 DOC ENTRY REG 303.52 4512453269 1508
09/25/02 DOC ENTRY REG 170.10 489849 1511
09/25/02 DOC ENTRY REG 84.80 4984651 1511
ENDING BALANCE 764.39

VENDORS: 3

END OF REPORT

Sample Reports
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Accounts Payable—7.50

Vendor Label Print

GENERAL INDUSTRIAL MFG
9610 DUNWOODY PL

SUITE 133-134

ATLANTA, GA. 30338

REARDEN METALS, INC.
34 NORTH BUFORD STREET
ATLANTA, GA 30309

GEORGIA NEWSPAPER
P.O. BOX 88550
ATLANTA, GA 30337

GRANDE HOTEL
71 HWY 29 SOUTH
LILBURN, GA 30321

WORLD MATERIALS HANDLING CO.
2000 NORTH AVE
ATLANTA, GA 30309

WAREHOUSE INTERIORS, INC.
9537 BROOK INDUSTRIAL BLVD.
DALLAS, TX 75037

Copyright © 1984-2005 Infor, Inc

INDUSTRIAL SUPPLY DISTRIBUTORS
19874 MOUNTAIN INDUSTRIAL PARK
ATLANTA, GA 30335

WAREHOUSE EQUIPMENT UNLIMITED
11598 GENERAL AVE.
DALLAS, TX 75022

FIRST BANK OF THE SOUTH
P.O. BOX 4998
ATLANTA, GA 30301

ATLANTA CRANE & HOISTS
147 s. DEKALB DRIVE
DORAVILLE, GA 30341

D'ANCONIA COPPER AND ELECTRIC
7125 CROGAN STREET
STONE MOUNTAIN, GA 30278

SOUTHERN ELECTRIC COMPANY
219 CLAYTON STREET
LAWRENCEVILLE, GA 30248

S.E. INDUSTRIAL PROD. & EQUIP.
11908 N.E. EXPRESSWAY
ATLANTA, GA 30321

SANITATION SERVICES, INC.
9292 HURRICANE SHOALS
LAWRENCEVILLE, GA 30240

GEORGIA SHIPPING EQUIP. CO.
3376 WASHINGTON AVE. S.E.
ATLANTA, GA. 30302

LINDA'S FLOWER SHOP
701 KILLIAN WAY
LILBURN, GA 30247

GEORGIA INSURANCE SERVICES
11321 STATE CAPITOL BLVD.
ATLANTA, GA 30301

PREMIUM INSURANCE COMPANY
9272 CROGAN STREET
ATLANTA, GA 30309

Sample Reports

OFFICE PRODUCTS INTERNATIONAL
45121 NORTH DECATUR AVE.
ATLANTA, GA 30339

LIGHTNING COURIER SERVICE
99 EAGLE LANDING DRIVE
MARIETTA, GA 30067

ATLANTA GAS COMPANY
P.O. BOX 31921
ATLANTA, GA 30321

NATIONAL CONVEYORS, INC.
3121 INDUSTRIAL PARK DRIVE
ATLANTA, GA 30312

INDUSTRIAL CHEMICALS INC.
12093 EAST MCEWEN
DALLAS, TX 75289



Accounts Payable—7.50

Rolodex Vendor Card Print

ATLANTA CRANE & HOISTS

404-949-2100
147 S. DEKALB DRIVE
DORAVILLE, GA 30341

FRANK CARTER

class:

D'ANCONIA COPPER AND ELECTRI

404-631-9921
7125 CROGAN STREET
STONE MOUNTAIN, GA 30278

FRANSICO D'ANCONIA
OSCAR WASHINGTON
class:

GENERAL INDUSTRIAL MFG

404-393-9444
9610 DUNWOODY PL
SUITE 133-134
ATLANTA, GA 30338

ROGER SMITH

GLORIA FAYE
class:

C-20

V113

INV

V117

V100

INV

ATLANTA GAS COMPANY V111
404-931-5556

P.O. BOX 31921

ATLANTA, GA 30321

JOAN BOZEMAN

class: UTL

FIRST BANK OF THE SOUTH V109
404-231-9921

P.O. BOX 4998

ATLANTA, GA 30301

RALPH MCMILLAN

class: C&T

GEORGIA INSURANCE SERVICES V118
404-261-1111

11321 STATE CAPITOL BLVD.

ATLANTA, GA 30301

RICHARD DICKSON

class: INS

Sample Reports
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Accounts Payable—7.50 Sample Reports

Purchase History Report

DATE: 09/28/02 DEMO COMPANY APR760 PAGE: 1
USER: SSI ToX PURCHASE HISTORY REPORT TIME: 9:24 AM

VENDOR FIRST TO LAST

DATE LAST LAST  ——————————- YEAR TO DATE--——————=———— ———————————— PRIOR YEAR---——————————
VENDOR NAME OPENED PURCHASE PAYMENT PURCHASES PAYMENTS DISCOUNTS PURCHASES PAYMENTS DISCOUNTS
V100 GENERAL INDUSTRIAL MF 11/30/02 09/17/02 09/07/02 78659.36 93187.49 5002.85 104206.00 102909.15 1296.85
V101 INDUSTRIAL SUPPLY DIS 12/05/02 09/17/02 09/21/02 80751.94 94791.58 10525.68 125688.00 123663.29 2024.71
V102 S.E. INDUSTRIAL PROD. 07/18/02 09/17/02 09/21/02 55380.80 67913.89 .00 76200.00 74450.36 .00
V103 OFFICE PRODUCTS INTER 09/14/02 09/25/02 09/07/02 7375.80 6555.26 56.15 14079.79 13803.72 276.07
V104 REARDEN METALS, INC. 01/12/02 09/14/02 09/07/02 2325.26 2065.87 53.12 2771.41 2771.41 .00
V105 WAREHOUSE EQUIPMENT U 03/28/02 09/21/02 09/21/02 163018.09 164282.62 .00 209726.00 208583.71 .00
V106 SANITATION SERVICES, 07/06/02 09/14/02 09/07/02 9532.34 8846.17 132.71 13465.94 13332.61 133.33
V107 LIGHTNING COURIER SER 12/20/02 09/24/02 09/21/02 4340.17 4308.50 .00 5006.75 5006.75 .00
V108 GEORGIA NEWSPAPER 02/19/02 09/25/02 09/21/02 8497.95 7729.02 176.00 11980.30 11861.68 118.62
V109 FIRST BANK OF THE SOU 04/15/02 09/14/02 09/07/02 3745.48 3435.92 88.35 4322.72 4237.96 84.76
V110 GEORGIA SHIPPING EQUI 11/30/02 09/19/02 09/21/02 105271.19 115100.47 .00 138219.00 137149.88 .00
V111l ATLANTA GAS COMPANY 10/01/02 09/14/02 09/21/02 6690.74 6363.39 39.47 7513.03 7365.72 147.31
V112 GRANDE HOTEL 03/25/02 09/21/02 09/14/02 22187.30 21070.06 158.03 26050.77 25792.84 257.93
V113 ATLANTA CRANE & HOIST 07/28/02 08/30/02 09/07/02 14811.90 15767.71 .00 19861.00 18038.86 .00
V114 LINDA'S FLOWER SHOP 03/24/02 09/21/02 09/14/02 879.59 516.55 6.67 543.45 538.07 5.38
V115 NATIONAL CONVEYORS, I 09/28/02 09/17/02 09/07/02 17905.23 17762.96 3698.14 24581.00 23521.78 1059.22
V116 WORLD MATERIALS HANDL 12/29/02 09/20/02 09/07/02 140757.76 160949.45 19058.99 185321.00 183516.06 1804.94
V117 D'ANCONIA COPPER AND 02/02/02 09/14/02 09/07/02 8004 .34 6962.33 59.68 11185.25 11185.25 .00
V118 GEORGIA INSURANCE SER 08/18/02 09/21/02 09/07/02 6282.48 4156.85 35.63 7518.51 7371.09 147.42
V119 INDUSTRIAL CHEMICALS 04/23/02 09/21/02 08/24/02 11679.70 8929.78 -889.77 14233.00 12989.53 1243.47
V120 WAREHOUSE INTERIORS, 05/13/02 09/14/02 09/21/02 103244.31 117424.49 12313.02 146211.00 143905.07 2305.93
V121 SOUTHERN ELECTRIC COM 07/06/02 09/25/02 09/07/02 5325.66 2199.65 32.86 3273.29 3273.29 .00
V122 PREMIUM INSURANCE COM 12/05/02 09/25/02 09/14/02 2273.65 1781.77 .00 2936.41 2907.34 29.07
REPORT TOTAL 858941.04 932101.78 50547.58 1154893.62 1138175.42 10935.01

VENDORS: 23 END OF REPORT
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Accounts Payable—7.50 Sample Reports

Payment History Report

DATE: 09/28/02 DEMO COMPANY APR770 PAGE: 1
USER: SSI ToX PAYMENT HISTORY REPORT TIME: 9:25 AM

VENDOR FIRST TO LAST

VENDOR NAME 04/02 05/02 06/02 07/02 08/02 09/02 TOTAL
V100 GENERAL INDUSTRIAL MFG 9222.72 10269.25 11736.54 11655.25 31233.73 2634.41 76751.90
V101 INDUSTRIAL SUPPLY DISTRIBUTORS 11870.74 9468.24 10320.11 8747.65 20601.22 15490.25 76498.21
V102 S.E. INDUSTRIAL PROD. & EQUIP. 5105.58 8207.85 8680.00 8784.55 11106.58 15109.46 56994.02
V103 OFFICE PRODUCTS INTERNATIONAL 1140.23 886.14 934.36 927.63 .00 940.75 4829.11
V104 REARDEN METALS, INC. 220.73 196.44 334.36 192.83 200.03 95.33 1239.72
V105 WAREHOUSE EQUIPMENT UNLIMITED 17098.18 21883.30 21766.02 21454.72 17627.68 28236.97 128066.87
V106 SANITATION SERVICES, INC. 1200.89 1130.13 1163.25 1201.01 .00 2210.55 6905.83
V107 LIGHTNING COURIER SERVICE 571.22 585.22 478.58 505.13 634.06 539.67 3313.88
V108 GEORGIA NEWSPAPER 854.52 1719.99 917.11 881.37 .00 1862.19 6235.18
V109 FIRST BANK OF THE SOUTH 208.73 481.65 181.61 228.45 327.22 163.61 1591.27
V110 GEORGIA SHIPPING EQUIP. CO. 10962.22 13591.36 13668.88 12898.57 18658.24 22144.31 91923.58
V111l ATLANTA GAS COMPANY 799.00 491.80 666.04 746.40 877.12 1538.87 5119.23
V112 GRANDE HOTEL 1189.32 5529.32 2593.94 3844.95 15.87 5251.56 18424.96
V113 ATLANTA CRANE & HOISTS 1787.61 1798.54 1808.48 1877.83 703.59 4243.29 12219.34
V114 LINDA'S FLOWER SHOP 60.08 58.55 60.60 36.15 71.03 112.04 398.45
V115 NATIONAL CONVEYORS, INC. 1986.41 1996.35 1683.24 1755.51 548.11 6012.37 13981.99
V116 WORLD MATERIALS HANDLING CO. 15560.47 15863.65 16530.61 16502.35 54720.23 10270.49 129447.80
V117 D'ANCONIA COPPER AND ELECTRIC 1071.20 1296.53 844.30 891.05 664.13 330.49 5097.70
V118 GEORGIA INSURANCE SERVICES 686.50 687.50 63.98 751.00 .00 593.87 2782.85
V119 INDUSTRIAL CHEMICALS INC. 1725.97 1818.42 1767.73 1725.05 1166.20 .00 8203.37
V120 WAREHOUSE INTERIORS, INC. 12908.48 12393.59 13476.05 12955.77 21473.64 21512.22 94719.75
V121 SOUTHERN ELECTRIC COMPANY 271.24 252.37 295.39 330.78 .00 556.48 1706.26
V122 PREMIUM INSURANCE COMPANY 280.50 281.50 9.98 291.54 237.50 118.75 1219.77

REPORT TOTAL 96782.54 110887.69 109981.16 109185.54 180866.18 139967.93 747671.04
VENDORS: 23 END OF REPORT
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Accounts Payable—7.50 Sample Reports

Sample 1099 Print

DEMO COMPANY
69 SOUTH PEACHTREE STREET
ATLANTA, GA 30030

- 3422-09-8887

GENERAL INDUSTRIAL MFG 93187.49
9610 DUNWOODY PL

SUITE 133-134

ATLANTA, GA 30338

DEMO COMPANY
69 SOUTH PEACHTREE STREET
ATLANTA, GA 30030

- 984432-095

S.E. INDUSTRIAL PROD. & EQUIP. 67913.89

11908 N.E. EXPRESSWAY

ATLANTA, GA 30321

TOTAL: 436185.21
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Accounts Payable—7.50 Sample Reports

Period Check Register

DATE: 09/28/02 DEMO COMPANY APR810 PAGE: 1
USER: SSI ToX PERIOD CHECK REGISTER 09/02 TIME: 9:28 AM

BANK FIRST TO 01

----CHECK---- DISCOUNT CHECK
CHECK VENDOR NAME DATE REG# AMOUNT AMOUNT TYPE
Bank 01 FIRST NATIONAL BANK OF ATLANTA
003025 V114 LINDA'S FLOWER SHOP 08/17/02 0346 .00 -10.05 *VOID*
003046 V102 S.E. INDUSTRIAL PROD. & EQUIP. 09/07/02 0346 .00 1833.81
003047 V103 OFFICE PRODUCTS INTERNATIONAL 09/07/02 0346 .00 628.83
003048 V105 WAREHOUSE EQUIPMENT UNLIMITED 09/07/02 0346 .00 5567.57
003049 V106 SANITATION SERVICES, INC. 09/07/02 0346 .00 1841.94
003050 V113 ATLANTA CRANE & HOISTS 09/07/02 0346 .00 693.21
003051 V114 LINDA'S FLOWER SHOP 09/07/02 0346 .00 21.47
003052 V118 GEORGIA INSURANCE SERVICES 09/07/02 0346 .00 395.89
003053 V121 SOUTHERN ELECTRIC COMPANY 09/07/02 0346 .00 365.12
003054 VOIDED - UNUSED CHECK 09/14/02 0349 .00 .00 *VOID*
003055 VOIDED - UNUSED CHECK 09/14/02 0349 .00 .00 *VOID*
003056 V107 LIGHTNING COURIER SERVICE 09/14/02 0349 .00 85.22
003057 V110 GEORGIA SHIPPING EQUIP. CO. 09/14/02 0349 .00 1866.51
003058 V111l ATLANTA GAS COMPANY 09/14/02 0349 .00 222.22
003059 V112 GRANDE HOTEL 09/14/02 0349 .00 4373.67
003060 V114 LINDA'S FLOWER SHOP 09/14/02 0349 .00 12.33
003061 VOIDED - UNUSED CHECK 09/21/02 0351 .00 .00 *VOID*
003062 V101 INDUSTRIAL SUPPLY DISTRIBUTORS 09/21/02 0351 .61 60.61
003063 V102 S.E. INDUSTRIAL PROD. & EQUIP. 09/21/02 0351 .00 3178.06
003064 V105 WAREHOUSE EQUIPMENT UNLIMITED 09/21/02 0351 .00 5488.96
003065 V107 LIGHTNING COURIER SERVICE 09/21/02 0351 .00 56.83
003066 V108 GEORGIA NEWSPAPER 09/21/02 0351 .00 1251.91
003067 V110 GEORGIA SHIPPING EQUIP. CO. 09/21/02 0351 .00 1922.37
003068 V111l ATLANTA GAS COMPANY 09/21/02 0351 .00 768.02
003069 V120 WAREHOUSE INTERIORS, INC. 09/21/02 0351 1.83 184.45
649849 V114 LINDA'S FLOWER SHOP 09/07/02 0346 .00 25.13 NONINVOICE
798799 V107 LIGHTNING COURIER SERVICE 09/07/02 0346 .00 14.87 MANUAL
BANK TOTAL 2.44 30848.95
REPORT TOTAL 2.44 30848.95
CHECKS: 27 END OF REPORT
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Accounts Payable—7.50

Period Expense Distribution

DATE: 09/28/02
USER: SSI ToX

PERIOD 09/02 SEP

G/L# FIRST TO LAST
BRANCH 01 ATLANTA BRANCH
DEPARTMENT 1 WHOLESALE

DEMO COMPANY
PERIOD EXPENSE DISTRIBUTION

APR820 PAGE: 1

T

IME: 9:29 AM

G/L# DESCRIPTION DEBIT CREDIT NET
520-01-1 PURCHASES - MISCELLANEOUS 280.28 .00 280.28
540-01-1 SALES TAX 358.05 .00 358.05
590-01-1 TRAVEL 400.41 .00 400.41
620-01-1 OFFICE EXPENSE 50.63 .00 50.63
625-01-1 AUTO & TRUCK EXPENSE 153.11 .00 153.11
630-01-1 MISCELLANEOUS EXPENSE 351.44 .00 351.44
640-01-1 FREIGHT 547.40 .00 547.40
710-01-1 ADVERTISING 846.57 .00 846.57
720-01-1 DUES & SUBSCRIPTIONS 25.00 .00 25.00
730-01-1 POSTAL EXPENSE 162.00 .00 162.00
735-01-1 TELEPHONE 298.72 .00 298.72
740-01-1 TAXES & LICENSES 3179.65 .00 3179.65
750-01-1 INSURANCE EXPENSE 121.67 .00 121.67
780-01-1 LEGAL & PROFESSIONAL 935.55 .00 935.55
790-01-1 UTILITIES 1084.20 .00 1084.20

REPORT TOTAL 8794.68 .00 8794.68
ACCOUNTS: 15 END OF REPORT
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Accounts Payable—7.50 Sample Reports

Period Disbursement Distribution

DATE: 09/28/02 DEMO COMPANY APR830 PAGE: 1
USER: SSI ToX PERIOD DISBURSEMENT DISTRIBUTION TIME: 9:29 AM

PERIOD 09/02 SEP
G/L# FIRST TO LAST

BRANCH 01 ATLANTA BRANCH

G/L# DESCRIPTION DEBIT CREDIT NET
100-01-0 CASH 10.05 30859.00 (30848.95)
310-01-0 ACCOUNTS PAYABLE 30836.31 10.05 30826.26
490-01-1 DISCOUNTS TAKEN .00 2.44 (2.44)
630-01-1 MISCELLANEOUS EXPENSE 50.32 .00 50.32

REPORT TOTAL 30896.68 30871.49 25.19
ACCOUNTS: 4 END OF REPORT
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Accounts Payable—7.50

Register History Report

DATE: 09/28/02 DEMO COMPANY APR840 PAGE: 1
USER: SSI ToX REGISTER HISTORY REPORT TIME: 9:30 AM
AP BEGINNING DOLLAR ENDING
TRACE# DATE PD REG# TYPE AP BALANCE AMOUNT DISCOUNTS ADJUSTMENTS AP BALANCE
6547 09/07/02 09/02 1505 DOCUMENT ENTRY 145592.75 668.47 .00 .00 146261.22
6548 09/07/02 09/02 0346 CHECK REGISTER 146261.22 -11352.66 .00 .00 134908.56
6549 09/07/02 09/02 0347 CHECK REGISTER 134908.56 -98536.20 193.19 .00 36179.17
6550 09/07/02 09/02 0348 CHECK REGISTER 36179.17 .00 .00 .00 36179.17
6551 09/14/02 09/02 1506 DOCUMENT ENTRY 36179.17 8619.90 .00 .00 44799.07
6552 09/14/02 09/02 1507 DOCUMENT ENTRY 44799.07 4357.29 .00 -100.00 49056.36
6553 09/14/02 09/02 1508 DOCUMENT ENTRY 49056.36 4473.65 .00 .00 53530.01
6554 09/14/02 09/02 1509 DOCUMENT ENTRY 53530.01 7894.07 .00 .00 61424.08
6555 09/14/02 09/02 0349 CHECK REGISTER 61424.08 -6559.95 .00 .00 54864.13
6556 09/14/02 09/02 0350 CHECK REGISTER 54864.13 -5908.81 .00 .00 48955.32
6557 09/21/02 09/02 0351 CHECK REGISTER 48955.32 -12911.21 2.44 .00 36041.67
6558 09/21/02 09/02 0352 CHECK REGISTER 36041.67 -4648.78 .00 .00 31392.89
6559 09/21/02 09/02 1510 DOCUMENT ENTRY 31392.89 9722.99 .00 .00 41115.88
6560 09/21/02 09/02 0020 VENDOR BALANCING 41115.88 .00 .00 .00 41115.88
6561 09/25/02 09/02 1511 DOCUMENT ENTRY 41115.88 3580.70 .00 -.20 44696.38
REGISTER HISTORY RECAP: PERIOD —————=—=—=== —————————— ————————— CHANGE

09/02 -100600.54 195.63 -100.20 -100896.37

TRACES: 15 END OF REPORT
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Accounts Payable—7.50

Document Removal Register

DATE: 09/28/02
USER: SSI ToX

DEMO COMPANY
DOCUMENT REMOVAL REGISTER #0059

Sample Reports

APR850 PAGE: 1
TIME: 9:31 AM

BRANCH 01
VENDOR NAME DOCUMENT PERIOD DATE AMOUNT REG# DATE PAYMENT DISCOUNT BALANCE
V101 INDUSTRIAL SUPPLY DISTRIBUTORS 1349 09/02 09/12/02 61.22 0351 09/21 60.61 61 00
V102 S.E. INDUSTRIAL PROD. & EQUIP. 1299 08/02 08/13/02 1833.81 0346 09/07 1833.81 00 00
1319 08/02 08/24/02 3178.06 0351 09/21 3178.06 00 00
V103 OFFICE PRODUCTS INTERNATIONAL 90081001 08/02 08/10/02 628.83 0346 09/07 628.83 00 00
V105 WAREHOUSE EQUIPMENT UNLIMITED 1300 08/02 08/13/02 5567.57 0346 09/07 5567.57 00 00
1322 08/02 08/27/02 5488.96 0351 09/21 5488.96 00 00
V106 SANITATION SERVICES, INC. 5246256235 08/02 08/10/02 737.22 0346 09/07 737.22 00 00
7456323563 08/02 08/11/02 1104.72 0346 09/07 1104.72 .00 00
V107 LIGHTNING COURIER SERVICE 198198198 08/02 08/31/02 100.09 0346 09/07 14.87 .00
0349 09/14 85.22 00 00
6549849849 09/02 09/07/02 56.83 0351 09/21 56.83 00 00
V108 GEORGIA NEWSPAPER 681681 08/02 08/24/02 600.13 0351 09/21 600.13 00 00
3457124114 08/02 08/25/02 651.78 0351 09/21 651.78 00 00
V110 GEORGIA SHIPPING EQUIP. CO. 1306 08/02 08/16/02 1866.51 0349 09/14 1866.51 00 00
1316 08/02 08/22/02 1922.37 0351 09/21 1922.37 00 00
V111l ATLANTA GAS COMPANY 3161986198 09/02 09/07/02 222.22 0349 09/14 222.22 00 00
4253698752 09/02 09/14/02 768.02 0351 09/21 768.02 00 00
V112 GRANDE HOTEL 724572457 08/02 08/17/02 1755.78 0349 09/14 1755.78 .00 00
7823616484 08/02 08/18/02 2633.76 0341 08/03 15.87 .00
0349 09/14 2617.89 00 00
V113 ATLANTA CRANE & HOISTS 1327 08/02 08/30/02 693.21 0346 09/07 693.21 .00 00
V114 LINDA'S FLOWER SHOP 6186 08/02 08/24/02 12.15 0345 08/31 5.48 .00
0346 09/07 6.67 00 00
198198198 08/02 08/31/02 14.80 0346 09/07 14.80 00 00
5437682764 09/02 09/07/02 25.19 0348 09/07 25.19 00 00
9498498498 09/02 09/07/02 12.33 0349 09/14 12.33 00 00
V118 GEORGIA INSURANCE SERVICES 90081001 08/02 08/10/02 395.89 0346 09/07 395.89 00 00
V120 WAREHOUSE INTERIORS, INC. 1352 09/02 09/14/02 186.28 0351 09/21 184.45 1.83 00
V121 SOUTHERN ELECTRIC COMPANY 13461346 08/02 08/10/02 182.56 0346 09/07 182.56 00 00
5253856969 08/02 08/11/02 182.56 0346 09/07 182.56 00 00

DOCUMENTS: 27

C-28

END OF REGISTER
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